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Solid state equipment has operational characteristics differing from
those of electromechanical equipment. “Safety Guidelines for the
Application, Installation and Maintenance of Solid State Controls”
(Publication SGI-1.1) describes some important differences between
solid state equipment and hard–wired electromechanical devices.
Because of this difference, and also because of the wide variety of
uses for solid state equipment, all persons responsible for applying
this equipment must satisfy themselves that each intended
application of this equipment is acceptable.

In no event will the Allen-Bradley Company be responsible or liable
for indirect or consequential damages resulting from the use or
application of this equipment.

The examples and diagrams in this manual are included solely for
illustrative purposes. Because of the many variables and
requirements associated with any particular installation, the
Allen-Bradley Company cannot assume responsibility or liability for
actual use based on the examples and diagrams.

No patent liability is assumed by Allen-Bradley Company with
respect to use of information, circuits, equipment, or software
described in this manual.

Reproduction of the contents of this manual, in whole or in part,
without written permission of the Allen-Bradley Company is
prohibited.

Throughout this manual we use notes to make you aware of safety
considerations.

!
ATTENTION:    Identifies information about practices
or circumstances that can lead to personal injury or
death, property damage, or economic loss.

Attentions help you:

• identify a hazard

• avoid the hazard

• recognize the consequences

Important: Identifies information that is especially important for
successful application and understanding of the product.

MessageBuilder and MessageView are trademarks of Alen-Bradley Company, Inc.
PLC and PLC–5 are registered trademarks of Allen-Bradley Company, Inc.
SLC 5/03, SLC 5/04, Dataliner and AdaptaScan are trademarks of Allen-Bradley Company, Inc.
INTERCHANGE is a trademark of Rockwell Software Inc.
Intel is a registered trademark of Intel Corporation.
MS-DOS and Microsoft Windows are registered trademarks of Microsoft Corporation.

Important User Information
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Welcome to MessageBuilder  Configuration Software. You can use
this software to create control panel applications for MessageView
421 Operator Terminals.

MessageBuilder software allows you to create applications designed
specifically to control processes in your plant. When you load a
MessageBuilder application in a MessageView terminal, the terminal
displays messages that:

• give information about the operation

• ask for input to control the operation.

Your software registration card is located in the envelope with the
software disks. To register your software, mail the card to this
address:

Allen-Bradley
Global Technical Support
6680 Beta Drive
Mayfield Village, Ohio 44143.

Or fax the card to (216) 646-6770.

This manual is a resource to help you design message display
applications that will run in a MessageView 421 terminal. Since
there are many options designed to give a smooth-running operation
under any circumstances, you should become familiar with the
choices to be made.

MessageBuilder Configuration Software runs under Microsoft
Windows. You should know how to use a mouse, choose commands,
and work with windows and dialog boxes. To learn basic windows
techniques, read the User’s Guide that came with your Microsoft
Windows  package.

PLC  and SLC  logic controllers and ASCII Triggering devices are
an important part of the systems that MessageBuilder applications
control. You should understand how controllers work, especially the
program and data files. See the user manuals for the controllers used
in your operation.

Registering Your Copy of
MessageBuilder Software

Intended Audience
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The MessageBuilder Configuration Software package (Catalog No. 
2706-MB1) comes with:

• 4 (3 1/2 inch) installation disks

– 3 MessageBuilder Software disks (including
INTERCHANGE  utility)

– 1 A-B Utilities disk.

• This manual: MessageBuilder Configuration Software manual
(Publication No. 2706-817).

• MessageView 421 Display Terminal user manual (Publication
No. 2706-816).

This manual uses the following conventions:

• Software or MessageBuilder software refers to the
MessageBuilder Configuration Software.

• Terminal refers to a MessageView 421 terminal.

• Windows (with a capital “W”) refers to Microsoft Windows or to
the Window menu in MessageBuilder. MessageBuilder windows
are written with a small “w”.

• Keys on the keyboard appear in boldface small capital letters:

– the Shift key (on the computer) appears as SHIFT  in the text
– the Acknowledge key (on the terminal) appears as ACK.

• A hand with italicized text in the left margin gives helpful hints.

MessageBuilder software often gives a choice of methods for
selecting a command. Use the most convenient one.

• Select a tool on the toolbar.

A toolbar is displayed along the top of the screen specific to what
you are doing. Simply click on the appropriate tool and it is
activated. Appendix B illustrates all tools in all the toolbars.

• Use a key combination.

Certain commands in the File and Edit menus have a key
combination. Use it instead of selecting the command.

• Select a menu command.

Click the menu name and then the command name. Or press the
ALT  key and the underlined letter of the menu name to drop the
menu, then type the underlined letter of the command. Appendix
A describes all commands in all the menus.

For example, to open an application from the initial MessageBuilder
screen, do one of the following:

– click on the Open File tool, or
– press CTRL + O, or
– type ALT + F then type O, to select Open from the File menu,

and the File Open dialog appears.

Software Package

Conventions

☞ The Release.txt and Readmekt.txt
files contain the most recent 
installation information.

Key combinations
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This manual is organized as follows:

Chapter Title Description

Preface
Describes the purpose and contents of the
manual, and its intended audience.

1
Introducing

MessageBuilder Software
Describes MessageBuilder Configuration
Software and some of its features.

2
Installing MessageBuilder

Software

Explains how to install MessageBuilder and
INTERCHANGE software on a personal
computer.

3 MessageBuilder Basics
Explains how to use MessageBuilder
software’s menus, tools and dialogs. Also how
to use the Help system.

4 Planning an Application
Gives guidelines for designing an application,
including safety considerations.

5
Communications

Overview
Gives guidelines for setting up MessageView
terminal communications.

6
Working with Application

Files

Explains how to open and close
MessageBuilder software, and how to open,
close and save application files.

7 Creating Messages

Shows how to create messages and set their
attributes. Also how to embed variables and
graphics in a message, and how function
keys work.

8 Working with Tags
Explains how to use the Tag Editor feature of
MessageBuilder software. Tags specify the
addresses in which variable data are stored.

9 Managing Projects

Tells how to link a project to an application,
and how to copy, rename or delete projects.
Also shows how to work with devices in
projects.

10
Terminal and

Communication Setup

Tells how to set operating and runtime
communication parameters for the
MessageView 421 terminal and a logic
controller.

11
Validating Applications
and Transferring Files

Tells how to validate an application. Explains
several methods that transfer it between a
computer and a terminal or a disk file.

12 Creating Reports Tells how to design a report and print it.

You should have the MessageView Display Terminal User Manual
(Publication No. 2706-816) at hand while creating an application.
Also refer as needed to the manual(s) for the controller the system
will be using.

Information and procedures relating to INTERCHANGE Software
and Microsoft Windows are given in this manual. For further details,
refer to the manuals for these products.

Contents of the Manual

Related Publications
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Local Product Support

Contact your local Allen-Bradley representative for:

• sales and order support

• product technical training

• warranty support

• support service agreements.

Technical Product Assistance

If you have questions about MessageBuilder Configuration software:

• check online Help

• review information on the subject in this manual

• review the release notes: these are separate icons in the
MessageBuilder Group in the Windows Program Manager

• review any technical notes on the subject that you have received
from Allen-Bradley.

If you still have a question, call your local Allen-Bradley
representative.

If you need more help, call:

Allen-Bradley
Global Technical Support
6680 Beta Drive
Mayfield Village, Ohio 44143.

Phone numbers:

• In the USA and Canada, call 1-800-289-2279.

• Outside the USA and Canada, call your local Allen-Bradley
office, or call USA (216) 646-6800.

• Fax number: (216) 646-6770.

Note: If you need to call Allen-Bradley for technical assistance,
please have the serial number of your software available. It may be
found in three places:

• on the software registration card

• on the welcome screen that appears when MessageBuilder starts

• in the main Help menu, choose About MessageBuilder to see the
About MessageBuilder dialog, which has:

– the release date and version number of MessageBuilder
software

– the release date and version number of the Allen-Bradley
Utilities software.

Allen-Bradley Support
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This chapter covers the following topics:

• What is MessageBuilder?

• MessageBuilder software features

• Typical messages in an application

• Typical message contents.

MessageBuilder is a Microsoft Windows software package. An
application designer can use it to create custom applications for
MessageView 421N, 421F and 421D terminals.

MessageBuilder software makes creating an application as easy as
possible, by supplying dialog boxes, toolbars and menus. These
include:

• menus and toolbars keyed to the current situation

• dialogs to set up the computer workstation, the MessageView
terminal and the interface to controllers used in the process.

• dialogs in which applications and projects are created and edited

• the Message Editor Table View, in which messages are created
and edited

• the Message Editor Terminal View, which previews individual
messages

• the Tag Editor, in which tags are created and edited

• validation of the application before it is downloaded to a terminal,
and on command while the application is being created

• printer dialogs for making permanent records of specific or
general aspects of the application

• on-line and context-sensitive help.

What is MessageBuilder?
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MessageBuilder software has a number of features that make
designing an application easier.

Tool or Menu Operation

MessageBuilder software runs under Microsoft Windows. Many
functions can be performed using tools, keystrokes, or menu
commands. Use any or all, whichever you find most convenient.

Selectable Preferences

MessageBuilder lets you set features of the workspace window to
those you prefer. Options such as the Standard Toolbar and the Status
Bar can be toggled on or off, and remain in that state until you
change them. See Page 7–14 for other preferences. When you create
a new application or when you start a new session, MessageBuilder
uses the latest settings.

Status Bar Information

The Status Bar at the bottom of the screen explains what is
happening at the moment. See Page 3–8.

• If you hold the left mouse button down while the cursor is over a
tool, the status bar explains what it does.

• If a process is going on, the status bar reports on how it is doing.

The three spaces at the right end of the status bar give the status of
the keyboard CAPS LOCK, NUM LOCK , and SCROLL LOCK  keys.

Help

The Help tools and commands provide a quick way to find
information about any part of MessageBuilder software. See Page
3–14 for a summary of the Help function. To access Help:

• Click on the Help Question tool and then on an item or command
to get context–sensitive help.

• Press F1 to get specific help on a subject.

• The Help Contents tool displays an index to Help topics.

• Select Contents, Search For Help On, or How To Use Help on the
Help menu, depending on what you need to know.

• Select About MessageBuilder to find the copyright date and
version number of MessageBuilder software if you need to call
Allen-Bradley for assistance.

MessageBuilder Software
Features
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Message Editor Table View

Use this dialog to create and edit messages and their attributes used
in the application program.

The Message Editor Table View contains the menu commands and
tools needed to bring up all other dialogs, the Terminal View and the
Tag Editor.

Message Editor Terminal View

Use this view to view the current message, approximately as it will
appear in the MessageView terminal. An application is designed for
a certain type of terminal. The Terminal View displays the face of
that terminal type.

Tag Editor

Use the Tag Editor to enter, update, print, and import/export
application tags. See Chapter 8. Each variable requires a tag, which
defines how the variable interacts with a controller address.

Enter all the tags at once in the Tag Editor Table View before starting
to create any messages. If a tag needs further editing when it is
assigned to a variable, use the Tag Editor Form View.

Terminal and Communication Setup

Access all operating and runtime communication parameters for the
MessageView 421 terminal from the Terminal Setup dialog. See
Chapter 10. These include:

• Remote I/O and RS-232 runtime communication parameters

• power-up defaults

• time/date display format

• control and status tags

• display settings, handshake timeout and trigger priority

• set up slaving or a slave device

• ASCII triggering.

Application Validation

Use validation to check all elements of the application for correct
input. See Chapter 11. When an application is downloaded to a
terminal, MessageBuilder software validates it automatically. You
can also validate the application at any time using the Validate menu
option. View warnings or errors detected during validation, or send
them to a printer or file.

MessageView 421D

PLC Controller MessageView 421 Terminal

 ✓
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Application Upload/Download Capabilities

Transfer applications between a MessageView 421 terminal and a
computer running either:

• MessageBuilder Configuration software

• MessageView File Transfer Utility.

See the section starting on Page 11–6.

Upload Historical Event Stack

The MessageView terminal maintains a running log of triggered
messages in a Historical Event Stack file. Upload this file from the
terminal to a computer that has either MessageBuilder software or
the File Transfer Utility installed. See the section starting on Page
4–19 for information on the Historical Event Stack, and on Page
11–13 for information on how to upload it to the computer for
analysis.

Reports

Use the report function to create customized reports for an
application. See Chapter 12. Reports may include any or all of the
following:

• application description

• messages

• message attributes

• terminal settings

• tags and their attributes

• function keys

• LED indicators.

Send reports to a printer supported by Microsoft Windows.

In addition to the report function, you may print information on tags
and their attributes via the Tag Editor (see Page 8–13).

Terminal Upgrade

Use the Upgrade Terminal command to upgrade the firmware in your
MessageView terminal(s). See Page 11–18.
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An application contains messages. Messages may contain embedded
data variables, graphical symbols, and when designed for
MessageView 421F terminals, may have function keys enabled. 

This example of a 421N Terminal View has a message that contains:

• a graphic symbol

• an ASCII Variable Display.

This example of a 421F Terminal View has a message that contains:

• a Time Variable

• a Numeric Variable Display

• enabled Function Keys.

Note: One message may occupy more than one line in the Terminal
View if the Line attribute is selected as “All”.

Typical Messages in an
Application
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Time or Date Display

Time Displays indicate the current time (hours, minutes and
seconds) according to the terminal’s Real Time Clock. Specify the
format of the display using the Terminal Setup dialog.

Date Displays indicate the current date (day, month and year)
according to the terminal’s Real Time Clock. Specify the format of
the display using the Terminal Setup dialog.

Set the Real Time Clock using the RTC Download command in the
Application menu.

Display Variables

Numeric Variable Displays shows the current value at a specific
controller address: binary, BCD or signed/unsigned integer. Scaling
(y = mx + b) may be used.

ASCII Variable Displays present status information to the terminal
operator according to the current character array at a specific
controller address.

Entry Variables

Numeric Variable Entries may be used in applications designed for
MessageView 421N and 421F terminals. These variables allow the
terminal operator to enter a numeric value from the terminal keypad.
Scaling (y = mx + b) may be used.

ASCII Variable Entries may be used in applications designed for
MessageView 421D, 421N and 421F terminals if the terminal
firmware can support these variables. These variables allow the
terminal operator to enter ASCII characters from an ASCII Input
device via the RS-232 port, or via the numeric keypad on the
terminal.

Graphics

Graphics consist of a set of 32 ISA symbols illustrating
manufacturing components such as motors and containers.

Typical Message Contents

Time is 16:23 CST.

Date is 06/24/96.

Pressure is 300 PSI.

Temperature Too High.

Enter Flow Rate:

Bar Code Reading:

Valve is open.
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Function Keys

MessageView 421F terminals can use applications that have
Function keys enabled. An enabled function key is assigned to one of
these types:

A Momentary Function Key changes state when pressed and
changes back to the original state when its hold time has expired
after it is released.

A Maintained Function Key changes state when pressed and
remains in the changed state when released. It changes back to the
original state when the Function Key is pressed and released again.

A Latched Function Key changes state when pressed and remains
in that state until the controller unlatches it.

!
ATTENTION:   Function Keys are active only when
they are enabled for a message currently displayed by
the terminal. All other Function Keys are non-active.

Example

Suppose a message has function keys F1, F5, and F9 enabled.
Whenever that message is displayed by the MessageView terminal,
these three keys are activated, but the 13 other Function keys remain
inactive.

When the message is terminated, the three Function keys are
inactivated at once.

Note: A Latched Function key remains in its changed state until the
controller unlatches it, but it is not active after its message is
terminated.



 
Chapter   2

Publication 2706-817

�
������

 �����
��������

��	�����

This chapter covers the following topics:

• System requirements

• Installing MessageBuilder software

• INTERCHANGE Device Configuration Utility

• Troubleshooting the installation procedure.

The minimum hardware requirements for installing and running
MessageBuilder software are:

• a personal computer using Intel  386 or 486 processor or
equivalent

• a minimum 4 MB of memory (8 MB recommended) with
minimum of 10 MB permanent swap under virtual memory

• a hard disk with 12 MB of free space

• a 3.5 inch high-density (1.44 MB) disk drive

• a VGA or better monitor that is supported by Windows

• an RS-232 communications port

• a cable for downloading/uploading applications between the
computer and the RS-232 port of a MessageView 421 terminal.
Order Catalog No. 2706-NC13.

Also highly recommended are:

• a mouse compatible with Windows

• a printer that supports graphics, compatible with Windows.

The minimum software requirements for installing and running
MessageBuilder software are:

• MS-DOS  operating system version 3.31 or later (MS-DOS
version 5.0 or later recommended)

• Microsoft Windows  version 3.1 or later, or Windows for
Workgroups version 3.11 or later.

Note: MessageBuilder software utilizing INTERCHANGE  V6.1
or later, is compatible with Microsoft Windows 95.

System Requirements



2–2 Installing MessageBuilder Software

Publication 2706-817

To install MessageBuilder Configuration Software:

1. Insert MessageBuilder software disk 1 in the appropriate
high-density floppy disk drive.

2. Start Windows (if necessary) by typing win at the DOS command
prompt and pressing ENTER.

3. To start installing MessageBuilder:

• with Windows 3.1x, in the Program Manager window choose Run
from the File menu (ALT + F, R)

• with Windows 95, in the Start menu choose Run (MS key + R)

4. In the command line box, type the drive letter of the drive
containing the MessageBuilder Software disk 1, followed by a
colon and the word setup. For example, type:

a:setup.

Then select OK or press ENTER.

5. You are prompted to begin the MessageBuilder installation.
Select:

• Yes to continue

• No to cancel.

6. The installation software checks your system for AB Utilities
software.

If it detects an older version of AB Utilities software, it warns
you that the previous version will be deleted before the new
version is installed.

If it detects the same or a newer version of AB Utilities software,
it notifies you that there is no need to upgrade it.

7. If installation of AB Utilities is required, you are prompted to
install the AB Utilities Software:

• Insert the AB Utilities disk.
• Enter target drive and directory for installing files.

Recommended drive and directory is C:\AB.

The files are copied to the target directory.

8. Re-insert MessageBuilder software disk 1 to continue installing
the MessageBuilder software.

Installing MessageBuilder
Software
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9. You are prompted to begin the MessageBuilder installation. The
installation software checks your system for MessageBuilder
software.

If it detects a previous version of MessageBuilder software, it
warns you that the previous version will be deleted before the
new version is installed.

If it detects the same version of MessageBuilder software, it gives
you the option of re-installing or deleting the files.

– Re-install writes over existing files
– Delete removes the files; you must then run the installation

again to install the new software.

10. Enter registration information:  name, company name, and
product serial number. The serial number is on your registration
card.

11. Enter target drive and directory for installing files. Recommended
drive and directory is C:\AB.

The files are copied to the target directory.

12. Insert MessageBuilder disk 2 to install the remaining files.

13. You are prompted to install the INTERCHANGE software. Enter
target drive and directory for installing files. 

Recommended drive and directory is C:\RSI\IC.

The files are copied to the target directory.

• If the installation detects a previous version of
INTERCHANGE, the procedure replaces existing components
with new components.  The procedure will not overwrite
configuration files.

• If the installation detects the same version of
INTERCHANGE, you are allowed to reinstall the
components.

14. Insert MessageBuilder Disk 3 to install the remaining
INTERCHANGE files.
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15. The installation prompts you to update the AUTOEXEC.BAT
file. It adds:

– C:\AB\BIN to the path.
– C:\RSI\IC\BIN to the path.
– SHARE.EXE to the file (Windows 3.1x only).
– Environment variable ABIC_CONFIG=C:\RSI\IC\BIN.
– ABICRUN.BAT (starts INTERCHANGE software).

Important:   MessageBuilder Configuration software and
INTERCHANGE Software will not run without these
lines.

Note: If you do not update your AUTOEXEC.BAT file during
MessageBuilder installation, MessageBuilder software writes the
changes to the file AUTOEXEC.EXM for future reference.

16. The INTERCHANGE Device Configuration Utility opens. Use
this utility to select and configure the “DF1 on COM Port”
communication drivers that your computer (workstation) will use
to transfer MessageView applications. See Page 2–8.

17. Review the release note that appears at the end of the installation
procedure.

18. When the installation is complete, you must exit Windows and
reboot your computer.
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Installation Summary

MessageBuilder installation:

• copies MessageBuilder files to the hard disk under the target
drive and directory (C:\AB) or the location specified during
installation

• copies the AB Utilities files to disk under the target drive and
directory (C:\AB) or the location specified during installation

• copies INTERCHANGE files to disk under the target drive and
directory (C:\RSI\IC) or the location specified during installation

• adds SHARE.EXE to AUTOEXEC.BAT file (Windows 3.1x
only)

• adds C:\AB\BIN and C:\RSI\IC\BIN to path

• adds ABIC_CONFIG=C:\RSI\IC\BIN to AUTOEXEC.BAT,
which defines the location of the INTERCHANGE file
CFG_KT.INI

• adds MBWIN.INI and ISP.INI to the Windows directory

• creates a MessageBuilder group in the Program Manager
containing icons for MessageBuilder Software, the MessageView
File Transfer Utility, INTERCHANGE Device Config. Utility,
and the release notes.

Online Release Notes

Online release notes are available for the MessageBuilder
Configuration Software. These files contain the most recent
information on software and new functionality, proper configuration
and work arounds, and the organization of MessageBuilder files.
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Refer to: For:

C:\AB\MBWIN\RELEASE.TXT MessageBuilder Configuration Software

C:\RSI\IC\READMEKT.TXT INTERCHANGE Software

C:\AB\README.TXT AB Utilities Software

The same MessageBuilder and INTERCHANGE software text files
are available through the MessageBuilder Group icon.

The RELEASE.TXT file or icon contains:

• last-minute updates to the manual

• installation notes

• a list of any known problems involving MessageBuilder software

• a list of all files installed in the default directories.

Or if you chose not to use the default directories during
installation, a list of all files installed in the directories you
selected.

The READMEKT.TXT file or icon contains:

• information on software and hardware compatibility with
INTERCHANGE software

• new and changed features in Release 1.00 and later

• a list of all files installed in C:\RSI\IC directory

• a list of problems, and of problems in previous releases that have
been fixed

• application notes.

Installing with Windows 95

The installation procedure is the same when the operating system is
Windows 95.

Note: The version of INTERCHANGE must be 6.1 or later to allow
you to perform application uploads and downloads.

Registering Your Copy of MessageBuilder software

Please take time to complete and send in the registration card you
received with MessageBuilder Configuration Software packet.
Registration entitles you to:

• automatic notification of upgrades and revisions to
MessageBuilder Configuration Software

• technical assistance.



2–7Installing MessageBuilder Software

Publication 2706-817

The INTERCHANGE Device Configuration Utility configures
communication drivers that the computer will use to transfer
applications. It allows you to:

• view active communication drivers

• select and configure a communication driver

• edit a communication driver

• remove a communication driver

• access advanced driver parameters.

This utility automatically updates the file CFG_KT.INI when drivers
are added, configured and removed.

If you intend to transfer applications using an RS-232, DH–485 or
Pass-Through connection you must first configure the appropriate
drivers. MessageView uses only RS-232. However other
Allen-Bradley products such as PanelView 900 might use other
communication drivers.

Access the INTERCHANGE Device Configuration Utility in one of
three ways:

• automatically as the final step in the MessageBuilder installation.

• as a separate icon in the MessageBuilder Group icon

Note: If Interchange was installed via another programming
software, such as AB PanelBuilder, the Interchange icon will be
found in that software’s group.

• through the Workstation Setup command in the MessageBuilder
File menu.

INTERCHANGE Device
Configuration Utility
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To select and configure an INTERCHANGE driver on your
computer: 

1. Double-click the utility icon in the MessageBuilder group icon, or
choose Workstation Setup from the MessageBuilder File menu.

Note: At the end of the MessageBuilder installation procedure,
the INTERCHANGE Device Configuration dialog opens
automatically.

Configured Devices

NAME

DEVICE

PORT

STATUS

Refers to driver name

Refers to selected driver

Refers to unique number assigned to
INTERCHANGE driver

Shows whether driver is enabled or
disabled

2. Select a driver from the Available Drivers: list. The selection
depends on the type of MessageView terminal and the
communication card installed in your computer.

Select: For MessageView Terminal: To:

DF1 on COM Port
2706-M1D1, -M1N1, -M1F1;
2706-M1D, -M1N, -M1F.

Transfer applications between the RS-232 port of a MessageView
terminal and a computer using DF1 (RS-232) communications.

1784-KL on DH+ ➀
Transfer applications between a computer on the DH+ link using a
1784-KL communications card and the Remote I/O port of a
MessageView Terminal on a Remote I/O network.

1784-KT or 1784-KT2
on DH+  ➀

Transfer applications between a computer on the DH+ link using a
1784-KT/B or -KT2 communications card and the Remote I/O port of a
MessageView Terminal on a Remote I/O network.

1784-KTC on
ControlNet ➀

1784-KTX on DH485
➀

Transfer applications between a computer on the DH-485 network
using a 1784-KTX communications card and the DH-485 port of a
MessageView Terminal.

1784-KTX on DH+ ➀
Transfer applications between a computer on the DH+ link using a
1784-KTX communications card and the Remote I/O port of a
MessageView Terminal on a Remote I/O network.

1784-PCMK on DH+
➀

Transfer applications between a computer on the DH+ link using a
1784-PCMK communications card and the Remote I/O port of a
MessageView Terminal on a Remote I/O network.

PIC on COM Port ➀

Transfer applications between a computer on the DH-485 network and
the DH-485 port of a MessageView terminal using a 1747-PIC
interface converter, or between a computer and the RS-232 port of a
MessageView terminal.

➀ Not used by MessageBuilder Software.



2–9Installing MessageBuilder Software

Publication 2706-817

3. Select the Add Device button to add and open the configuration
dialog for the selected driver.

For example, if you select DF1 on COM Port this dialog opens:

Unique number assigned to
INTERCHANGE driver

(This is not the computer’s COM port.)
Default Driver Name
(can be edited)

Disables driver configuration
without removing it from
Configured Drivers list.

COM Port = 1 and Interrupt = 4, or
COM Port = 2 and Interrupt = 3

DF1 parameters must be set to:
Baud:

Parity:

Error Detect:

19200

None

CRC

Typical:

Note: Consult your personal computer’s user manual for COM
Port Interrupt settings.

4. Edit parameters and select OK  when done.

The parameters are specific to the communications card installed
in your computer, or to the type of connection you will be using
to transfer files.

The configured driver appears under the Configured Devices: list
in the Driver Configuration dialog.

Important:  Do not configure more than one driver for the same
communication port.

5. Reboot your computer to load the driver and its configuration.

Important:  You must reboot your computer any time you add or
remove a driver or change configuration parameters of a
driver.

Exiting Windows and re-entering will not load the
driver.
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To configure an existing INTERCHANGE driver:

1. Select the driver from the Configured Devices: list.

2. Select the Edit Device button to open the configuration dialog for
the selected driver.

3. Edit parameters and select OK  when done.

4. Reboot your computer to load the driver and its configuration.

To remove a current driver:

1. Select a driver from the Configured Devices: list.

2. Select the Remove Device button.

3. A dialog asks for confirmation of the removal. Choose OK .

4. Reboot your computer to unload the driver.

To specify advanced parameters for drivers:

1. Select the Advanced button from the INTERCHANGE Device
Configuration dialog.

2. Modify the settings as needed. See below.

3. Select the OK  button to save the settings

Or select the Cancel button to return to the Configuration menu
without changing the parameters.
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Memory Manager Options

Load drivers high when enabled (checked) loads INTERCHANGE
drivers (executables) into high memory. Drivers are not loaded until
you reboot the computer. If this option is disabled, drivers are loaded
into the base 640K memory.

MessageBuilder recommends: Either enabled or disabled.

Memory Manager Selection allows you to specify the memory
manager in use on your system. Select one of the radio buttons.

MessageBuilder recommends: EMM386.

Driver Self-Test

When enabled this option requires KT devices to run self-diagnostics
before loading driver configuration.

MessageBuilder recommends: Perform the tests.

RNA Parameters

Use upper memory for packet buffers when enabled places packet
buffer space in upper MS-DOS memory.

MessageBuilder recommends: Use upper memory.

Number of solicited buffers allocates the number of packet buffers
(1 to 200). Each buffer uses 300 bytes of memory. The default is 20.

MessageBuilder recommends: 20 buffers.

Number of unsolicited data items allocates space for unsolicited
messages (0 to 200).

MessageBuilder recommends: 0 data items, which allocates no
space.

PCMK Enabler Selection

Specifies the Enabler to use for the 1784-PCMK on the DH+ Device
Driver.

Specific Enabler uses PCMKINIT or RSIPCMK. This Enabler
requires you to enter the socket number containing the card in the
driver dialog. The INTERCHANGE socket numbers are (0 to 7). In
Windows 95, the sockets are numbered (0 to 8).

Generic Enabler uses PCENABLE. This Enabler requires that you
enter a Memory address and IRQ (Interrupt).

MessageBuilder recommends: (Ignores).
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Possible difficulties with installation

• If you used the default installation procedure, the Path in your
AUTOEXEC.BAT file now includes the \AB\BIN and
\RSI\IC\BIN directories. In Windows 3.1x the AUTOEXEC.BAT
file also includes SHARE.EXE. If you edit this file yourself,
MessageBuilder software requires these modifications.

• If the computer has Windows for Workgroups installed, it has a
virtual device driver (VxD) called VSHARE.386. If Windows for
Workgroups uses this share driver, remove the SHARE.EXE file
from the AUTOEXEC.BAT file. The Windows for Workgroups
manual has details on using VSHARE.386.

Note: Windows 95 does not need the SHARE.EXE file. It has its
own virtual device driver installed.

Possible difficulties with INTERCHANGE drivers

The INTERCHANGE drivers may cause conflicts with other drivers
sharing common interrupts or memory areas in the system. Here are
some problems that may occur and what to do about them.

• If you are using a special Windows video driver, try using the
standard Windows VGA driver; you may also have to edit the
EMM386 line in the CONFIG.SYS file to remove specific
memory exclusions added by the special video driver.

Exit Windows and run ABICSTOP (see below). If ABICSTOP is
not successful, comment out the ABICRUN line in the
AUTOEXEC.BAT file and reboot, then run ABICSTOP again.

• If you are experiencing lockups when using a serial mouse in a
DOS application, try waiting several seconds for the mouse to
initialize. If mouse operation is still a problem, run ABICSTOP.

It may be necessary to create a dual boot environment to manage
conflicting drivers. Refer to the DOS user manual for information
on this.

• If you experience error messages during a system reboot, they
may indicate an incomplete or incorrect configuration of the
INTERCHANGE drivers. See Page 2–8 for instructions on
configuring the drivers.

For more details on INTERCHANGE Software, refer to the
INTERCHANGE Software user manuals and the MessageBuilder
online release notes.

Troubleshooting the
Installation Procedure
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Possible conflicts in using communication ports

If you plan to run other software on your computer that uses the
same communication ports as MessageBuilder and INTERCHANGE
Software (such as APS software), follow these steps.

1. Exit from Windows if necessary. Make sure that
INTERCHANGE is not running.

2. Type ABICSTOP at the DOS prompt. For example, type:
      C:\> ABICSTOP.

3. If ABICSTOP is not successful, comment out ABICRUN in the
AUTOEXEC.BAT file:

      REM CALL ABICRUN.BAT

Reboot the computer and run ABICSTOP again.

4. Run the other software.
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This chapter covers the following topics:

• Windows environment

• MessageBuilder window

• Message Editor Table View

• Opening and closing menus

• Status bar and toolbars

• Message Editor Terminal View

• Dialogs

• Getting help.

MessageBuilder software runs in a Microsoft Windows environment.
It uses menus, dialog boxes and tools, and follows the same
keyboard and mouse conventions used by Windows.

You should be familiar with basic Windows conventions. That is,
you should know how to use the mouse, select commands from
menus, and work with windows and dialog boxes.

If you use a mouse, here are the basic terms used:

Feature: How to use it:

Click
Position the mouse pointer on the object, area, or
field, then press and release the left button once.

Double-click
Position the mouse pointer on the object, area, or
field, and click the left button twice quickly.

Choose an item or command
Click to highlight the item to be affected by the next
command, or click on a dialog box option.

Select an item or command
Click on an tool, on a menu command, or on an item
in a dialog box or Help window.

Drag
Point to an item, press and hold the left mouse
button, and move the pointer, then release the
mouse button. Use drag to highlight a text string.

If you prefer to use the keyboard:

Action: How to do it:

Select a command from a menu
Press the ALT key and type the letter underlined in
the menu name simultaneously. Then type the letter
underlined in the command name.

Choose an item or command
Use the arrow keys (or in a dialog, both the TAB and
arrow keys) to move to the item

Select an item or command Highlight an item, then press the ENTER key.

Windows Environment
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When you start MessageBuilder software, the MessageBuilder
window opens. 

Title Bar Minimize Button
Maximize Button

Control-menu Box

Menu Bar

Num Lock

Menu

Border

Command

Mouse Pointer

Status Bar
on     

Caps Lock

Scroll Lock 

      off

      off

Standard Toolbar

⇐⇒ Arrow to
Resize Window

Feature: How to use it:

Control-menu Box
Click to open the Control menu. 
Or double-click to close the current window.

Title Bar Drag to move a window.

Menu Bar

Click a name on the menu bar to open the menu and
display its commands. 
Or press ALT + X, where X is the underlined letter in
the menu name.

Standard Toolbar
Click a tool to carry out a command.
Can be toggled on/off using the View menu.

Command
Click a command to choose it or to carry out its
action.
Or type the underlined letter in the command name.

Status Bar
Shows what the software is doing at the moment.
Can be toggled on/off using the View menu.

Border Drag to enlarge or shrink the window.

Mouse Pointer Use to select an item or object.

Minimize Button Click to reduce the window to an icon.

Maximize Button
Click to enlarge the window to the full size of the
screen.

MessageBuilder Window
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Here are the commands available on each menu when no application
file is open.

File menu has commands that:

• create and open application files

• configure the computer workstation for file transfer

• download new firmware to a MessageView 421 terminal.

• list the last four applications that were opened, for easy reopening

• exit MessageBuilder software.

View menu has commands that:

• toggle the Standard Toolbar on and off

• toggle the Status Bar on and off.

Application menu has commands that:

• manage projects and their devices

• upload an application file or the Historical Event Stack file from a
MessageView 421 terminal

• download the time and date to the terminal’s Real Time Clock

• allow the user to set preferences.

Help menu has commands that:

• identify the versions of MessageBuilder and AB Utilities software
and the registration serial number

• access topics in the MessageBuilder Help utility.

Four tools are active:

• New File

• Open File

• both Help tools.
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When an application is opened, the Message Editor Table View
appears. Messages are created and edited in this View, and have their
attributes set.

The Message Edit box displays the highlighted message from among
those in the Message List.

Use the standard Windows resizing arrows as needed.

Status Bar

Standard Toolbar
Menu Bar

Message Edit Toolbar

Message Edit Box

⇐⇒
Arrow to
Resize WindowAttribute Controls

Title Bar

Vertical 
Scroll Bar

Message List

Feature: How to use it:

Menu Bar
Select a name on the menu bar to open a menu and
display its commands.

Standard Toolbar
Click a tool to edit message text or carry out other
functions.
Toggle it on/off using the View menu.

Message Edit Toolbar Click a tool to edit messages and their variables.

Message Edit Box Edit the message highlighted in the Message List.

Attribute Controls Define attributes for the selected message.

Message List
Messages appear here as they are created. 
The selected one is highlighted and appears in the
Message Edit box.

Status Bar
Shows what the software is doing at the moment.
Toggle it on/off using the View menu.

Note: If the application file name in the title bar has an asterisk (*),
the application has been edited but not saved to disk.

Message Editor Table View
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Here are the commands available on each menu when an application
file is open.

File menu has commands that:

• create, open, close and save application files

• generate reports

• configure the computer workstation for file transfer

• download new firmware to a MessageView 421 terminal

• list the last four applications that were opened, for easy reopening

• exit to the Windows desktop.

Edit menu has commands that:

• copy, cut and paste text strings; undo and restore changes in a
message

• insert, append and delete whole messages

• find, sort and renumber messages in the Message List

• replace text strings in one or many messages

• assign names to topics.

View menu has commands that:

• toggle the Standard Toolbar and the Status Bar on and off

• zoom the Terminal View in or out.

Format menu has commands that:

• specify what size the message text will be in the terminal display

• align text in the display

• display selected text in a message with Flash and Inverse Video

• insert and edit Time and Date Displays, Numeric and ASCII
Display Variables in a message

• (for MessageView 421N and 421F terminals) insert and edit
Numeric Entry variables in a message

• (for terminals whose firmware can support these variables) insert
and edit Numeric Entry and ASCII Entry variables in a message

• insert graphic symbols and ASCII characters in a message

• (for MessageView 421F terminals) enable function keys for a
message.
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Application menu has commands that:

• create tags and their attributes that will be assigned to variables
when messages are created

• manage projects and their devices

• enter a description of the application

• validate and download an application to a MessageView 421
terminal or to a DOS file

• upload an application file or the Historical Event Stack file from a
terminal

• download the time and date to the terminal’s Real Time Clock

• set up the terminal’s communications, control and status tags, and
global attributes

• assign bit triggers and date/time tags for special messages

• (for MessageView 421F terminals) set global attributes and assign
tags for all the function keys and LEDs used in the application

• allow the user to set preferences.

Window menu has commands that:

• open and arrange application windows and arrange their icons

• open the list of problems in the application (“Exceptions”) that
were identified after a Validate or Download command

• open the Terminal View and toggle it with the Table View

• list the windows currently open for easy access, with the active
one checked.

Help menu has commands that:

• access topics in the MessageBuilder Help utility.

• identify the versions of MessageBuilder and AB Utilities software
and the registration serial number



3–7MessageBuilder Basics

Publication 2706-817

Each name on the menu bar opens a menu with a set of commands.

To open a menu:

• point to a name on the menu bar and click the left mouse button

• or press ALT  and the underlined letter in the menu name
simultaneously. For example, to open the File menu, press 
ALT  + F.

MessageBuilder menus look like this:

Note: Appendix A lists the commands on each menu and briefly
explains what each one does.

To choose a menu command:

• click the command name

• or type the underlined letter in the command name

• or use the UP and DOWN ARROW  keys to choose an item; then
press ENTER to select it.

Menu conventions are listed in this table:

Menu convention: What it means:

Greyed command name The command is not available at this time.

A check mark (�) before the
name

The command is active. Select the command to
inactivate the command; the check mark disappears.
Select it again to activate it.

A key combination after the name
A shortcut for the command. Use the shortcut keys if
you prefer instead of the menu command or tool.

An ellipsis (...) after the command

The command opens a dialog box that contains
options that must be selected before
MessageBuilder software can carry out the
command.

A triangle (�) to the right of a
menu command

The command opens a submenu.

Opening and Closing
Menus
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To close a menu:

• click the menu name or anywhere outside the menu

• or press ALT  or F10 to close the menu and move back to the
workspace

• or press ESC to close the menu and remain on the menu bar.

The status bar appears at the bottom of the MessageBuilder window. 

• It indicates what the software is doing at the moment.

• It explains a tool’s function when the left mouse button is pressed
down while the cursor is over a tool.

• It explains the command when a menu command is highlighted.

• It gives the status of the Caps Lock, Num Lock and Scroll Lock
keys on the keyboard.

To toggle the status bar on or off:

1. Choose View from the menu bar.

2. Choose Status Bar from the View menu.

A check mark (�) appears next to the Status Bar command when
it is active. To turn the status bar off, choose the command again.

Status Bar and Toolbars
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Standard and Message Edit toolbars

Two toolbars are located at the top of the application window. Tools
provide easy access to commonly used commands. Instead of
opening a menu and choosing a command, simply click a tool to
carry out an action. Some tools complete the action immediately;
others open a dialog or a menu for further input.

Note: Tools on a toolbar can be accessed only with a mouse. All
toolbar commands are available on one of the menus or in the
Applications area.

Standard Toolbar

Message Edit Toolbar

Message Edit Box

To identify a tool, move the cursor arrow to the tool. Press and hold
the left mouse button while watching the status bar.

• If the tool is correct, release the mouse button.

• If the tool is not correct, move the cursor off the icon before
releasing the mouse button.

Note: Appendix B lists all the available tools and briefly explains
what each one does.

To toggle the Standard Toolbar on and off:

1. Choose View from the menu bar.

2. Choose Toolbar from the View menu.

A check mark (�) appears next to the Toolbar command when it is
active. To disable the Toolbar command, choose the command again.

Note: The Message Edit toolbar cannot be turned off.
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MessageBuilder defaults

MessageBuilder software keeps the most recent Standard Toolbar
and Status Bar settings as its default settings. Default settings are
used:

• the next time MessageBuilder software is opened

• when a new application is created.

In addition, the Preferences command on the Application menu
offers other selectable options. See Page 7–14.

The Terminal View displays messages approximately as they will
appear on a MessageView 421 terminal. This view represents the
front face of the type of terminal the application is designed for.

Display area in the Terminal View.

Message Edit Box in the Table View.

The Message Edit box on the Table View is active while the
Terminal View is displayed. If the Terminal View is the active
window, as a message is edited the changes appear in the Terminal
View display.

The Terminal View may be enlarged or reduced using the Zoom
tools or the Zoom command on the View menu. See Page 7–17.

Note: The Terminal View, like the MessageView terminal, can
display only:

21 characters in Quarter text size

10 characters in Half text size

7 characters in Full text size.

If the message is longer than the Terminal View can display, scroll
through the message in the Message Edit box to see the remainder of
the message. When the Terminal View is the active window, its
display will follow the insertion point in the Message Edit box. That
is, it will scroll through the message up to the cursor point.

Message Editor Terminal
View
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MessageBuilder software uses dialogs to request information it needs
to carry out a command. After you supply the requested information,
select a command button to confirm or cancel the command.

Dialogs also display additional information and warnings, or explain
why a requested task could not be accomplished.

An ellipsis (...) after a dialog command means another dialog will
open when you choose that command.

Some dialogs provide different sets of options, each on a separate
tab. Select the tab to work with a specific set of options.

A sample dialog:

Spin Control

Tab

Command Button

List Box

Radio Button

Check Box

To move around a dialog:

• move the mouse pointer to a field and click the left mouse button

• or press TAB  to move forward through fields and SHIFT+TAB  to
move backward through fields. Use the arrow keys to select a
radio button

• or press the ALT  key and the underlined letter of a field name
simultaneously. For example, to move to the Return Message
Number check box, press ALT +R.

Dialogs
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Features of dialogs

Command Buttons

Short rectangles with text explaining their function. Select a
command button to invoke the command.

Text Boxes

Long rectangles with instructions about what should be entered in
them. Sometimes these boxes contain a default value or text,
sometimes they are empty. The mouse pointer changes to an I-beam
when it is on a text box.

• To add text, place the cursor point where the new text goes and
start typing.

• To delete text, highlight it and press the DELETE  or BACKSPACE

key.

• To replace some or all text, highlight it and type the new text.

List Boxes

Boxes with a down-arrow at the right. To configure an item within a
List Box:

• Click on the down arrow to the right of a list box to display its
list, then click on an item to select that option.

• Or move the highlight to a list box and press ALT  + the
down-arrow key to display the list. Then use the up or down
arrow key to select an option.

If there are more items than can fit in the list, a scroll bar appears.

Some list boxes let you use the mouse to select multiple items. Click
on the first item, press and hold the SHIFT  key, then click the last
item. Or click the first item and drag the pointer to the last item. To
deselect a range, click the first item on the list.

Drop-Down Text Boxes

Text boxes with a down-arrow at the right, separated from the text
box. To configure an item within a Drop-Down Text Box:

• Click on the down arrow to the right of a list box to display its
list, then click on an item to select that option.

• Or move the highlight to a list box and press ALT  + ↓  (the
down-arrow key) to display the list, then use the up or down
arrow key to select an option.

• Or highlight existing text in the box and type the appropriate
name or number.
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Check Boxes

Square boxes that may contain an X or ✓ . Check boxes are used to
select or clear an option. An X or ✓  in the box means the option is
selected. A blank (cleared) box means the option is not selected.

• Click on a check box to select or deselect the option.

• Or select a check box and press the Spacebar to toggle it.

Radio Buttons

Circles that function as a group. One of the group has a solid dot in
the middle (it is selected), and all the others are blank. Choose a
button in the group to select that option and clear all other options.

• Click on a radio button to select it.

• Or select a group of radio buttons and press the up or down arrow
key  to toggle them.

Spin Controls

Small boxes with up/down arrows at the right. To configure an item
within a Spin Control box:

• Click the up or the down arrow until the required number appears
in the box.

• Or highlight the text and type the number.

Tabs and Dialog Buttons

Some dialog boxes have tabs which open to give new sets of options.
Others have buttons that open a Tag Form or other dialog. Select a
tab or button to display a new set of options.
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MessageBuilder software has both context-sensitive and online help.
Help may be invoked by any of the following commands.

• Click the Help Question tool and the mouse arrow changes to a
question mark. Click the question mark on an item for
context-sensitive help.

• Click the Help Contents tool to display an index to Help topics.

• Choose a command from the Help menu. The Contents command
brings up the same index as the Help Contents tool.

• Select a dialog’s Help button to get help about the its topic.

• Press the F1 key at any time to get context-sensitive help.

Using Help

This is a very brief overview of the Help features. For further
information on using Help, select How To Use Help or see the
Microsoft Windows manual.

All of the methods of finding information on a topic produce the
same textual information. Choose the method most convenient for
you among those listed here.

Helpful hints:

• If a term is underlined, you may select it to bring up a new screen
defining or describing that subject.

• If scroll bars appear, you may use them to see more items on the
list or more information on the subject.

• To return to a previous screen, use either the Back button (which
steps through each screen you have called up) or the History
button (which lists all the screens you have called up, so you can
double-click on the one you want to return to).

• To see text on a related subject, use the Previous (<<) or Next
(>>) button.

Getting Help
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 Contents

The Help Contents screen is illustrated above.

1. Double-click a subject on this index to bring up a new screen,
which contains a subindex of subjects on the topic.

2. Then double-click on a subject in the subindex, until you reach
text describing the topic you want information on.

Search

The Search button at the top of the Contents screen brings up a
dialog with an alphabetical list of all the Help headings.

To locate a topic:

• use the scroll bar

• type one or a few letters to display the part of the alphabet that
contains the subject you are interested in.

When you see the name of a Help subject that you want:

1. Highlight the name or type it in the Word box.

2. Select the Show Topics button.

3. Select the Go To button.

A screen appears with text describing or explaining the selected
topic.
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Help Topics:Contents

The Help Topics button at the top of the Help Contents screen brings
up a tabbed dialog. The first tab is Contents.

In this screen, if the button next to a subject is:

• a book, double-click on it to display a list of subtopics

• a question mark, double-click on it to bring up text on the subject.

Help Topics: Index

The Index tab displays a dialog with an alphabetical list of all the
Help headings.
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To locate a topic:

• use the scroll bar

• type one or a few letters in the Type box to display the part of the
alphabet that contains the subject you are interested in.

When you see the name of the subject that you want help with:

1. Highlight the name in the Click box, or type it in the Type box.

2. Select the Display button.

A screen appears with text describing or explaining the selected
topic.

Help Topics: Find+

The Find+ tab displays a dialog you may use to find every instance
of a word that appears in Help text.

To locate all instances of a term anywhere in the Help files:

1. Type part of a word or a whole word in the Enter search text box.

If you want to be more specific, type several words. Find+ locates
exactly what you type, provided it is in the Help text.

2. If it will narrow the search, select one or more of the check boxes
below the Enter box.

3. Select the Find button. The Select a Topic box fills with all the
Help topics that contain the term. The topic that has the most
examples of the term is listed first and highlighted.

4. The first instance of the term in the highlighted topic appears in
the Topic text box. To move from one instance of the term to
another:

• use the Term up/down arrows at the bottom of the screen

• use the scroll bars if they are present to display more of the text.
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5. To select another topic, do one of the following:

• click on a topic to highlight it

• use the Topic up/down arrows at the bottom of the screen to move
the highlight

• use the scroll bars if they are present to display more of the list.

6. When you find a subject about which you want to read more,
click the Display button. A full screen appears with the Help text.

About MessageBuilder

If you must call Allen–Bradley for assistance, you will have to
provide the release date and version number of MessageBuilder
software. Choose About MessageBuilder from the Help menu to get
this dialog:

User name
Company name

It gives you:

• the version number and  release date of MessageBuilder software

• the version number of the Allen-Bradley Utilities software

• the serial number of this particular software package.
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This chapter covers the following topics:

• Design checklist

• Safety considerations

• Applications and projects

• Messages

• Triggering a message

• Controlling devices

• Slaving

• Slave Device

• Historical Event Stack

• Function keys

• Function key types

• LED indicators

• Handshaking

• Tags

• Data types

• Address worksheet

• Defining tags

• Scaling data display variables

• Scaling data entry variables

• Precision and rounding.

Before creating an application, check the following:

� Plan the application: what is it supposed to do, and how?

� Outline the documentation the operator will  work from.

        Finish it after the application is completed.

� Consider safety requirements.

� Review data types and data formats.

� Fill  in the Address Worksheet (Appendix H).

� Review communications (Chapter 5).

Design Checklist
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The application designer must make sure that an application cannot
be used in an unsafe manner. Failsafes must be built into each
application.

!
ATTENTION:    Do not configure Function Keys as
emergency stops or other controls critical for safe
operation. Use separate hard-wired operator interface
devices.

Refer to “Safety Guidelines for the Application, Installation and
Maintenance of Solid State Controls” (Publication SGI-1.1).

Communications interruptions

The MessageView 421 terminal relies on communications with the
logic controller or ASCII Triggering device.

• Communications are interrupted within the terminal when it:

– is in the Front Panel Editor mode
– is receiving an application download from a personal

computer
– has a major fault
– loses power
– detects that the Remote I/O link has failed.

The logic controller considers the terminal as a faulted I/O rack
when it does not communicate. The controller must be programmed
to cope with this situation. Specifically, it must:

• return any machine or process to a safe state

• monitor the rack fault bit associated with the MessageView
terminal’s assigned rack.

Refer to the controller’s user manual.

Safety Considerations
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Here are the steps needed to create an application:

1. The designer should document the application carefully. This
documentation should include the purpose of the application,
what information the operator will need to make good decisions,
and what choices the operator will have to make. The designer
and operator should discuss this document together before the
application is run.

!
ATTENTION:    Documentation is often neglected, but
is very important. The operator can make better
decisions if the designer explains what is going on.

2. The designer creates an application, the basic design unit of
MessageBuilder software. It is designed to be loaded in a specific
type of MessageView terminal, run using a specific type of
controller, and direct a specific operation. It includes:

– messages, with their attributes, triggers, embedded graphics,
and embedded display and entry variables

– configuration parameters for communications port(s) of a
specific MessageView terminal

– global attributes that apply to all messages in the application
– tags, which are named references to data addresses in a

specific logic controller (ASCII Triggering devices use the
tags as memory references)

– function keys and LEDs (MessageView 421F terminals only).

3. The designer associates the application with a project, which is
assigned or created when an application is created. A project can
support more than one application, provided that all of them are
designed for the same type of terminal and the same type of logic
controller. It links the application(s) to:

– the tag database
– the specific devices – the MessageView terminal and the PLC,

SLC or ASCII Triggering device – that the application will
interact with.

4. Values associated with variables are stored in controller memory
addresses, and are referenced by the application via named tags.
The designer usually enters all the tags in the Tag Editor Table
View before creating any messages. Tags may also be edited later
when they are assigned to their variables.

Applications and Projects
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5. The application designer can validate an application at any time,
using the Validate command on the Application menu.
Incompatibilities are caught during validation. See Page 11–2.

Note:  An application is automatically validated by
MessageBuilder software before it is downloaded to a terminal.

6. The designer or operator can monitor how the application is
running. Messages that have their HE Stack attribute set are
logged into the Historical Event Stack file each time they are
triggered. These logged messages include the value of their
display variables at the instant of triggering, and the current date
and time. The HE Stack file is uploaded to the computer on
request.

A MessageView terminal has memory reserved for an application
with up to 4096 standard messages. Messages are triggered
individually by the Logic Controller or ASCII Triggering device as
required by the interaction between: 

• the MessageBuilder application, and

• feedback from the machinery to the Logic Controller or ASCII
Triggering Device.

The content of a message is determined by:

• the MessageBuilder application

• information transferred between the MessageView terminal and
its controller.

Each message has a unique number, which is used to identify it in the
application. Numbers in the range:

• 1 to 9900 are used for application messages

• 9901 to 9999 are reserved for Special Messages

• greater than 9999 are not supported by the MessageView
terminal.

A message’s number is its value trigger. A message may also have a
bit trigger assigned to it. To trigger a specific message in the terminal
display, assert its corresponding bit or value trigger at the proper
location in controller memory. See the section on Triggering on
Page 4–9.

Messages
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A message may be up to 100 characters long, and can include any
combination of text, graphics, and variables. It can have:

• up to one date variable

• up to one time variable

• up to 10 entry or display data variables in any combination,
provided the total message length is 100 characters or fewer

• up to 50 graphics symbols, provided the total message length is
100 characters or fewer.

Variable and Graphic display characteristics in the Message
Editor

Message Component Table View Terminal View

Time Sample Time Sample Time

Date Sample Date Sample Date

Numeric Data Entry Placeholder (^^^) Placeholder (^^^)

Numeric Data Display Placeholder (###) Placeholder (###)

ASCII Data Entry Placeholder (EEE) Placeholder (EEE)

ASCII Data Display Placeholder (AAA) Placeholder (AAA)

ASCII Character Placeholder (~) Placeholder (~)

Graphics Placeholder (GR) Actual graphics symbol

Message text Alphanumeric Alphanumeric

Special Messages

The MessageView terminal supports a predefined set of Special
Messages. Message numbers 9901 to 9999 are reserved for Special
Messages. 

Special Messages are triggered just like any other message while an
application is running. When triggered, they are typically not
displayed by the terminal, but acted upon.

Special Messages:

• cannot be edited, although bit triggers may be assigned to them

• are not displayed in the Message Editor Table View

• are not displayed in the Message Editor Terminal View

• cannot be chained to another message

• are not logged into the Historical Event stack.

The Special Messages dialog is found on Page 7–54.



4–6 Planning an Application

Publication 2706-817

This table gives the current Special Messages. 

Message
Number

Message Description ASCII Triggering Device Requirements

9901 Clear Display
Clears all active display messages.
The display/slave buffers and Slave Devices
are not cleared.

Use the [Ctrl-T] command:
to terminal: [Ctrl-T]9901\ MV Address [CR]

9902
Clear Value
Triggered Message
Queue

Clears the Value Triggered Message Queue
and any display/slave buffers.

Use the [Ctrl-T] command:
to terminal: [Ctrl-T]9902\ MV Address [CR]

9903
Reset MessageView
Terminal

Aborts all terminal functions in progress.
Resets the terminal, which then goes through
its Power On Self Test (POST).

Use the [Ctrl-T] command:
to terminal: [Ctrl-T]9903\ MV Address [CR]

9904 Display Test

Tests every pixel in the terminal display.
During the test, the terminal suspends all
message activity. When the test is completed
the terminal resumes normal Run Mode
operation.

Use the [Ctrl-T] command:
to terminal: [Ctrl-T]9904\ MV Address [CR]

9905
Set Clock – Time –
Date

Sets or updates the Real Time Clock in the
terminal from addresses in the logic
controller. Valid only if the tags are defined in
the Special Messages dialog.

Use six [Ctrl-V] commands: year, month, day, hour,
minute, second:
to terminal: [Ctrl-T]9905\ MV Addr [CR] 
to terminal: [Ctrl-V]Year Value\ 1\ MV Addr [CR]

 [Ctrl-V]Month Value\ 2\ MV Addr [CR]
 [Ctrl-V]Day Value\ 3\ MV Addr [CR]
 [Ctrl-V]Hour Value\ 4\ MV Addr [CR]
 [Ctrl-V]Minute Value\ 5\ MV Addr [CR]
 [Ctrl-V]Second Value\ 6\ MV Addr [CR]

9906
Get Real Time Clock
Time/Date

Sends the terminal Real Time Clock time and
date to addresses in the logic controller.
Valid only if the tags are defined in the
Special Messages dialog.

Use six [Ctrl-I] responses: year, month, day, hour,
minute, second:
to terminal: [Ctrl-T]9906\MV Addr [CR] 
from terminal: [Ctrl-I]9906\ Year Value\ 1 [CR]

     [Ctrl-I]9906\ Month Value\ 2 [CR]
     [Ctrl-I]9906\ Day Value\ 3 [CR]
     [Ctrl-I]9906\ Hour Value\ 4 [CR]
     [Ctrl-I]9906\ Minute Value\ 5 [CR]
     [Ctrl-I]9906\ Second Value\ 6 [CR]

9907 Battery Test

Tests the battery for sufficient power. If the
Battery Test passes, a 1 is sent to the battery
status bit. If the Battery Test fails, a 0 is sent.
Valid only if the tag is defined in the Special
Messages dialog.

Use the [Ctrl-I] response:
to terminal: [Ctrl-T]9907\ MV Addr [CR] 
from terminal: [Ctrl-I]9907\ 1 or 0\ 1 [CR]

9908
Display Brightness
Adjustment1

Adjusts the brightness of the display
according to the value input in the Special
Message.
If an incorrect value is input for the brightness
level, the terminal will ignore the command.
Valid only if the tag is defined in the Special
Messages dialog.

Use the [Ctrl-V] command:
to terminal: [Ctrl-T]9905\ MV Addr [CR] 
to terminal: [Ctrl-V]0 to 7\ 1\ MV Addr [CR]
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1 This table shows the brightness level corresponding to each value in
Special Message 9908’s Ctrl-V command:

Value 0 1 2 3 4 5 6 7

Levels 12% 25% 38% 50% 60% 75% 87% 100%

A MessageView terminal can accept commands from one of these
two types of controlling devices:

• a logic controller such as an Allen-Bradley PLC or SLC

A logic controller communicates with a MessageView terminal
through the Remote I/O port on the daughterboard card.
Terminals with daughterboard cards are Catalog Nos.
2706-M1D1, -M1N1 and -M1F1.

• an ASCII Triggering device, such as an Allen-Bradley computer
product or SLC BASIC Module. See Page 5–7 for a list.

An ASCII Triggering device communicates through the RS-232
port on the main board of the terminal. It is used with terminals
that do not have daughterboard cards: Catalog Nos. 2706-M1D,
-M1N and -M1F.

MessageView features supported by a controlling device

A MessageView terminal can support the following features when
controlled by either type of device:

• displaying triggered messages with or without embedded
variables

• queuing messages

• chaining messages

• supporting Special Messages

• supporting hidden messages to be sent to the Historic Event Stack
when triggered

• displaying messages with Numeric Entry variables embedded, in
421N and 421F terminals

• implementing Handshaking for latched function keys, in 421F
terminals

• scaling Numeric Display and Numeric Entry variables

• returning Message Numbers to the controlling device

• displaying Startup and Background messages

• supporting Debug Mode

• supporting Simulate Mode

Controlling Devices
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MessageView features supported by a logic controller

A MessageView terminal can support the following additional
features when controlled by a PLC or other logic controller:

• supporting Handshaking for numeric entry and ACK messages as
well as for latched function keys

• supporting bit triggering

• supporting Startup and Background messages that contain
embedded display variables

• sending Preset or Last values for variables to the controller

ASCII Triggering Device limitations:

• If the ASCII network has more than one device, the terminal
operator must not send data (such as Entry variables embedded in
a message) from the MessageView terminal to the ASCII
Triggering device. This could cause data collisions. Consider this
when creating an application for such a network.

Data is sent from a terminal when:

– the ACK key is pressed (all terminals)
– numeric keys are used (421N and 421F terminals)
– an enabled Function key is pressed (421F terminals)

• The MessageView terminal supports an output buffer to process
outgoing data responses. The buffer is designed to handle at least
two of the largest responses (such as 20 Ctrl-I responses or 2
messages that contain the maximum of 10 Entry Variables).

If the output buffer becomes full (for instance, if someone
repeatedly presses a Momentary Function Key before the data can
be sent), any new outgoing data is lost until the output buffer is
available again.

• ASCII Trigger applications require a value trigger tag name to be
defined. See Page 10–21. Only the tag name is used; the node
address and node name may be left blank. The tag name is used
internally by the MessageView terminal as a reference.

Communication setup

In MessageBuilder software, a logic controller is specified by its
PLC/SLC/Scanner type. An ASCII Triggering device is a single
device that does not require a device type.
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All messages, including Special Messages, must be triggered to be
displayed on, or used by, the MessageView terminal. A message may
be defined as only value trigger, or both value trigger and bit trigger.

• Value trigger is acquired from either a logic controller or from an
ASCII Triggering Device.

• Bit trigger is acquired only from a logic controller, using Remote
I/O communication.

Note: In time-critical or priority type applications, bit triggering is
recommended if available.

Important: An ASCII Triggering device cannot use Bit Triggering.

Value triggering

This method uses the message number as a trigger. Each message in
an application has its own unique number, so there are as many value
triggers in the application as there are messages.

When the terminal receives the message number value trigger, it

• displays the message if its assigned lines are free and its Hidden
attribute is disabled

• queues the message if its lines are occupied, the Hidden attribute
is disabled and the Message Queue is enabled

• logs the message into the HE Stack whether is is displayed or not,
if its HE Stack attribute is enabled

• ignores the message if the line(s) are occupied and the HE Stack
attribute and the Message Queue are disabled.

• slaves the message whether displayed by the master device or not
if the slave attribute is enabled.

Some messages may be triggered but are not displayed:

• messages with the Hidden attribute set

• Special Messages.

Note: Any message that has its HE Stack or slave attribute set, is
sent to the Historic Event Stack or the slave device when it is
triggered. The message does not have to be displayed.

Triggering a Message
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From a logic controller using Remote I/O

The MessageView terminal supports a Value Trigger tag in the PLC
or other logic controller. When a message is to be triggered, the logic
controller writes the message number to this tag address.

Only one message may be value-triggered at a time. The terminal
scans the Value Trigger tag address at regular intervals. A triggered
message number must remain stable in the Value Trigger tag address
for a minimum of 100 milliseconds, to allow for the terminal scan
times.

The message is not triggered again until the value in the Value
Trigger tag address is changed to a different number and then
changed back. Thus the ladder logic application designer may use a
message number of 0 (zero) to change the Value Trigger tag address
without triggering a message.

From an ASCII Triggering Device using RS-232

The MessageView terminal supports the triggering of messages
using the Value Trigger method. The format of this method is:

[Ctrl-T]Message Number\MessageView Address[CR]

• [Ctrl-T] is the control code for a command to the terminal

• Message Number is the value trigger for the message

• MessageView Address is the node in the network where the
terminal is located

• [CR] is the carriage return that ends a packet.

Note: The delimiter in ASCII triggering packets uses the backslash \.

In order to trigger a message, the ASCII Triggering Device transmits
a [Ctrl-T] packet sequence. When the terminal receives this packet, it
displays or queues the message.

Note: A MessageView terminal in an ASCII network that has an
address from 1 to 126 will respond to messages addressed to it, and
also to messages addressed to 127. A terminal with an address of 127
will respond to messages addressed to 127 only.
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The Message Queue

Queuing is important in situations where multiple message triggers
are likely to occur. Value triggered messages that are triggered but
cannot be displayed at once are stored in the terminal’s Message
Queue if the Queue is enabled.

Note: A bit–triggered message is not queued. The bit remains set
until the controller resets it.

The MessageView terminal supports two fixed Message Queue
lengths, set in the Terminal Setup Advanced dialog. See Page 10–13.
The length may be:

• 64 messages deep (the Queue is enabled)

• 1 message deep (in effect, the Queue is disabled)

The MessageView terminal processes messages according to the
following criteria:

• A triggered message is displayed at once if possible.

• If the specified line for a value–triggered message is not free, it is
placed at the bottom of the Message Queue Stack.

• Messages are processed from the Queue Stack in a top-to-bottom
First In, First Out (FIFO) priority.

• The topmost message is displayed when its assigned display line
is available. The terminal continues to queue additional triggered
messages while it waits to display the topmost message.

Note: Messages in the Queue are not displayed until they reach
the top of the Queue, even if their line is available.

• If the Queue reaches Full status, the next message that is queued
will be entered at the top of the Queue, overwriting a pre–existing
queued message.

Note: The Message Queue is not cleared when the terminal operator
enters the Front Panel Editor (FPE). When the operator closes the
FPE, Run mode resumes and the queued messages are displayed as if
there was no interruption.

The Message Queue is cleared if:

• the terminal has processed all queued messages

• the terminal is reset

• the controller triggers a Clear Queue (9902) Special Message

• the controller triggers a Terminal Reset (9903) Special Message.
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Bit triggering

This method uses bits within a designated word of memory, the Bit
Trigger tag address, to trigger messages. The Bit Trigger tag is
defined in the Terminal Setup dialog (see Page 10–21). Starting with
this tag address, you may reserve up to 64 words (1024 bits) in
sequence for all the bit triggers in the application.

If the system uses Remote I/O to transfer data, the maximum number
of bit triggers may be reduced.

 RIO Method Rack Size
Maximum # of Bit

Triggers

Discrete I/O 1/4 32

Discrete I/O 1/2 64

Discrete I/O 3/4 96

Discrete I/O Full 128

Block Transfer 1/4 to Full 1024

When the Bit Trigger attribute is enabled for a message, its bit is also
assigned. Only one message may be assigned to a particular bit
address.

When a message is to be bit triggered, the logic controller writes a 1
to a specific bit at the Bit Trigger tag address.

• When the logic controller resets the bit to 0, the corresponding
message is not displayed.

• When the logic controller sets the bit to 1, the terminal displays
the message if its assigned display line is available.

Important: If its line is not available and the bit remains set
(1), the terminal will display the message when
the corresponding line becomes available.

If the bit is reset to 0 before the line is available, the terminal will
ignore the message.

• In order to trigger the same message again, its corresponding bit
must be changed to 0 and back to 1.

Note: Any message that has its HE Stack or slave attribute set, is
sent to the Historic Event Stack or the slave device when it is
triggered. The message does not have to be displayed.
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Bit trigger priority

Bit triggered messages are not queued as value trigger messages are.
However, bit triggering does provide a way to prioritize messages. If
two or more bits are set at the same time, the terminal processes
them according to the following criteria:

1. Bit triggered messages are prioritized from Least Significant Bit
(LSB) to Most Significant Bit (MSB):

– within a word, from Bit 0 to Bit 15
– if more than one word is assigned to bit triggering, from 

Word 0 to Word 63.

2. The terminal scans the area of memory assigned to bit triggering
in prioritized order, from LSB to MSB.

3. When the terminal detects a set bit, the message corresponding to
that bit is triggered. It is displayed or not, according to the
following rules:

if the Bit Trigger is: and the Display Line: then the message is:

set (1) is available displayed

set (1) is occupied not displayed

set (1) becomes available displayed

reset (0) becomes available not displayed

Example 1

Two messages are bit triggered at the same time. Assume all display
lines are available and the messages are assigned to different lines.

0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0

0123456789101112131415

Message A Display Line 1
Bit 2 Word 0 set

Message B Display Line 2
Bit 0 Word 1 set

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0123456789101112131415

Word 0

Word 1

Result: Messages A and B are displayed at once.
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Example 2

Two messages are bit triggered at the same time. Assume all display
lines are available and the messages are assigned to the same line.

0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0

0123456789101112131415

Message A Display Line 1
Bit 2 Word 0 set

Message B Display Line 1
Bit 0 Word 1 set

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0123456789101112131415

Word 0

Word 1

Result: Message A is displayed at once. After Message A is
terminated, Message B will be displayed if its corresponding bit is
still set. If its bit is no longer set, Message B will not be displayed
unless it is triggered again.

Example 3

Three messages are bit triggered at the same time. Assume all
display lines are available and two of the messages are assigned to
the same line.

0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0

0123456789101112131415

Message A Display Line 1
Bit 2 Word 0 set

Message B Display Line 2
Bit 0 Word 1 set

0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1

0123456789101112131415

Word 0

Word 1

Message C Display Line 1
Bit 14 Word 1 set

Result: Messages A and B are displayed at once. After Message A is
terminated, Message C will be displayed if its corresponding bit is
still set.

Bit and Value trigger priority

A bit triggered message and a value triggered message may be
triggered at the same time.

• If the messages are assigned to different display lines, both
messages will be displayed.

• If the messages are assigned to the same display line, priority is
determined by the Trigger Priority attribute in the Terminal Setup
Advanced dialog. See Page 10–17.
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A MessageView terminal with a RIO daughterboard (Catalog Nos.
2706-M1D1, -M1N1 or -M1F1) and firmware that supports a Slave
Port can act as a master device with up to 126 slave devices. 

Note: A MessageView 421D terminal without a daughterboard can
be used as a slave device. A list of slave devices is given on Page
5–6.

An example of a master terminal setup with four slaves

MessageView Terminal
RS-232

RIO

PLC5

RS-232

RS-485

RS-485

Black
Box

Black
Box

Black
Box

Black
Box

Black
Box

Slave

Slave

Slave

Slave

MessageView Terminal slave buffers

Each slave device is addressed individually. The MessageView
terminal has 14 buffers that store messages that are monitored,
updated, and continuously displayed by the slave(s). Each slave on
the network has its own node address. Each message is directed to a
specific slave to be displayed on a specific line.

The MessageView Terminal buffer system works as follows:

1. Message 1, sent to the slave at node 6 slated for line 1, is stored in
one of the buffers and displayed immediately by the slave.

2. Message 2, sent to the slave at node 2 slated for line 1, is stored in
another buffer and displayed by the second slave.

3. Message 3, sent to the slave at node 6 slated for line 2, is stored in
a third buffer and displayed concurrently with Message 1.

4. Message 4, sent to the slave at node 6 slated for line 1, overwrites
the message in the first buffer and is slaved at once.

5. If all the buffers are full, and if no buffer has a message for the
slave at node 6 line 4, a new message for the slave at node 6 line
4 overwrites the message in the oldest node 6 buffer. If none of
the buffers has a message for node 6, then the oldest buffer is
overwritten, no matter which node it was addressed to.

Slaving
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6. A message slated for Any Line is displayed on the same line that
it was displayed on by the Master Device. If the message was a
Hidden Any Line message, it is displayed on line 1 of the slave’s
display.

7. A message with address 127 is placed in a buffer and is sent to all
slaves. All other buffers with the same Line Number attribute
(e.g., Line 3) are cleared.

8. A message with address 127 slated as an All Lines message is
placed in a buffer and is sent to all slaves. All other buffers are
cleared.

Note: If the terminal operator accesses its Front Panel Editor, or
switches the RS-232 port to MessageBuilder parameters, all slaving
activities are interrupted. Slaving activities are resumed when the
operator sets the RS-232 port to Aux. Port parameters and exits the
Front Panel Editor.

Slave Message embedded variables

Numeric and ASCII Entry variables and Function keys are supported
in slaved messages, but they are active only on the Master Device.
The terminal removes the embedded entry variables, enabled
Function keys and (unless Ctrl-G is used) embedded Graphic
symbols before transmitting the message to the Slave Device(s).

If the following are embedded in messages, they are supported on
both the Master and the Slave Device(s):

• date and time

• graphics (if Ctrl-G is used; see Page 7–41)

• Numeric and ASCII Display variables

Data variables are continuously updated in the slave display as long
as the slave message is active.

Other features include:

• Numeric Display variable data may be scaled.

• Messages with the Hidden and Slave Enable attributes set are not
displayed by the master, but are displayed by the slave device
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Slave Packet

A message intended for transmission to a slave device has the
following format:

[Optional Control Byte][ASCII Text][Optional Display
Mode Byte][Slave Address Byte][Line Number Byte][CR]

MessageBuilder software allows for the automatic or manual
insertion of the Optional Control Byte and Optional Display Mode
Byte.

If you choose to embed them manually, the individual control codes
are found on Page 7–42. The slave packet fields are:

• Control Byte: specifies text size or clears the slave display.

• ASCII Text: the message itself, including embedded variables and
graphics. The maximum length for any message is 100
characters; in a slave packet the control codes are not counted.

• Display Mode Byte: specifies scrolling, centering and hold
message options.

• Slave Address Byte: specifies the Slave Device node address, an
integer from 1 to 127. Addresses 1-126 specify an individual
node where a Slave Device is connected. Address 127 addresses
all Slave Devices.

• Line Number Byte: specifies a Display Line number. An integer
from 1 to 4 specifies a specific line; 50 clears all lines if Control
Byte was Ctrl-C.

• CR: a carriage return, to signal the end of the message.

Note: Non–printable codes and characters are not included in the
character count for slaved messages.

Slave device alarm relay

The MessageView terminal supports a slave device alarm relay. A
message with the Relay attribute enabled will energize the slave
device alarm relay when the slave device receives the relay packet.

The alarm will remain energized until a message with the Relay
attribute disabled is slaved to that node and line number, replacing
the alarm message and de-energizing the alarm.

The following slave device supports an alarm relay:

• DL50
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A MessageView 421D terminal without a daughterboard (Catalog
No. 2607-M1D only) is a Slave Device. MessageView 421D Slave
Devices are shipped with an application downloaded. The
application provides the ASCII characters and graphics needed to
display messages. 

The MessageView 421D Slave Device terminal does not support a
Startup or Background message. It acts as a “dumb terminal”, which
can receive data but not transmit it. It can accept commands from a
variety of slaving (master) devices. A list of master devices is given
on Page 5–8.

A message is displayed as soon as it is received from the master
device. There is no buffering or Message Queue. If a message is
received that is slated for a line which has another message
displayed, the old message is terminated at once and the new
message is displayed.

Embedded variables are treated as follows:

• Display, time and date variables in slaved messages are displayed
by the 421D Slave Device. They are updated by the Master
Device as long as they are displayed.

• ASCII Characters are displayed.

• Graphics may be displayed if the Ctrl-G control code is inserted.

The slave packet format and control codes are given on Page 7–42.

Slave Device
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The MessageView terminal features a Historical Event (HE) Stack.
The HE Stack file supports up to 4000 messages, each 21
alphanumeric characters long. Messages with the HE Stack attribute
enabled are recorded in the Historical Event Stack each time they are
triggered. 

The Historical Event Stack file includes for each message:

• Message number.

• Message text, which includes:

– data display variables at the time of triggering
– placeholders for data entry variables
– placeholders for graphic symbols.

• Message topic.

• Time and date when the message was triggered.

• Time and date when the message was acknowledged, if the Ack
Time attribute was enabled. See Page 7–39.

Historical Event Stack messages are stored in the terminal’s memory
in chronological order.

The terminal can alert the operator when the Historical Event Stack
file is 85%, 95% and 100% full, so that overflows can be avoided. If
the Stack file is full, new messages overwrite messages in the file,
starting with the oldest.

Viewing the Historical Event Stack

The Historical Event Stack may be viewed using either:

• the terminal’s Front Panel Editor

• the personal computer via the HE Stack Upload command.

When using the Front Panel Editor, the terminal operator may view
the Historical Event Stack in either of two formats:

• frequency of occurrence

• chronological order.

The HE Stack Upload command, on the Application menu, uploads
the HE Stack file to a computer file in CSV (Comma Separated
Variable) format. This format allows the user to import the file into a
spreadsheet or database software package for analysis. See Page
11–13. 

Historical Event Stack



4–20 Planning an Application

Publication 2706-817

A MessageView 421F terminal supports 16 Function keys (F1 to
F16) and 16 LEDs on the front panel. 

A typical message with Function keys enabled informs the operator
the intended function of each enabled function key. For instance:
F1 Start F2 Stop Pump

Pressing a Function key sets or clears a bit value assigned to the
Function key’s write tag address. The controller logic program can
use the write tag address for a variety of control operations such as a
machine’s start and stop functions.

!
ATTENTION:    Do not use a MessageView terminal
for emergency stops or other controls critical for the
safety of personnel or equipment. Use separate
hard-wired operator interface devices.

Global attributes

Individual Function key attributes are globally defined. For instance,
if F1 is defined as momentary, every time it is enabled for a message
it is a Momentary Function Key. If a Latched Function Key is
needed, you must enable a different key.

The MessageView terminal supports three types of Function key
operations as global attributes:

• momentary

• maintained

• latched.

See the section on each type starting on Page 4–23. Other global
attributes are discussed in these sections.

Function Keys
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Enabling and disabling function keys:

Function keys are enabled only when a message assigned Function
key operations is displayed (activated). For example:

PRESS
F1 - Start Pump
F2 - Stop Pump
F3 - Sound Warning

F1, F2 and F3 are enabled.
F4 through F16 are disabled.

Note: Unless a Function key is specifically enabled for the active
message, it is disabled on the terminal.

!
ATTENTION:    As a safety precaution, enable only
the function keys that are used in the message. Unused
function keys should remain disabled, since adverse
effects could result.

All 16 Function keys may be enabled for a single message if
required. However, only one message assigned to Function key
operation can be displayed at a time.

Jog and non-jog modes

Messages with momentary, maintained or latched function keys
enabled may be defined as either jog or non-jog. 

• Messages are defined as non-jog if their Auto Clear attribute is
enabled. Non-jog messages are terminated at the completion of a
Function key operation, including Hold Time. For example:

PRESS
F1 - Start Pump
F2 - Stop Pump
F3 - Sound Warning

The message is terminated after any of F1,
F2 or F3 is pressed and released, and the
Hold Time, if any, expires.

• Messages are defined as jog if their Auto Clear attribute is
disabled. Jog messages, including their associated Function keys,
remain displayed (active) even after a function key is pressed and
its Wait Time has expired. For example:

PRESS
F1 - Start Pump
F2 - Stop Pump
F3 - Sound Warning

The message remains active after any of
F1, F2 or F3 is pressed and released, and
the Hold Time, if any, expires.
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Jog mode is an aspect of the Auto Clear attribute which becomes
apparent in messages that have Function keys enabled. It is
non-global. For example, Message 5 with F1 enabled may be jog
mode and Message 25 with F1 enabled may be non-jog, in the same
application.

Terminating Function Key messages

A Function key message in Jog mode remains displayed until it is
specifically terminated. Another message triggered to be displayed
on the same line will not clear it.

Function key enabled messages are terminated by:

• pressing the Function key, if the Auto Clear attribute is set
(non–jog)

• pressing the [0] and [+/-] keys on the terminal at the same time

• triggering Special Message 9901, Clear Display

• performing a terminal reset.

When the controller is an ASCII Triggering device

Each time a Function key is pressed, the MessageView terminal
sends a [Ctrl-F] command to the ASCII Triggering device.

[Ctrl-F]Message #\F-Key #\F-Key Action[CR]

• Message # is the number of the displayed message

• F-Key # is the function key being pressed

• F-Key Action is the resulting state, 0=OFF and 1=ON.

If the Function key is of Latched type, the ASCII Triggering device
sends a [Ctrl-U] command to the terminal to unlatch it.

[Ctrl-U]Function Key #\MessageView Address[CR],

• Function Key # is the Function key being unlatched, and the

• MessageView Address is the node address of the terminal in the
ASCII network.
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Momentary Function Keys
A Momentary Function Key remains in a changed state as long as
the key is pressed. When it is released, after a preset Hold Time has
expired the key changes back to its original state. The Hold Time
value represents a brief delay in which the control function remains
active after the operator releases the Function key. This Hold time is
set in the Function Keys dialog, which is accessed through a
command on the Application menu.

The MessageView terminal supports Hold Times of 0, 50, 250, 500,
750 or 1000 milliseconds.

A Momentary Function Key does not have a definitive handshake
tag.

!
ATTENTION:    If communication with the logic
controller uses Remote I/O protocol with block
transfer, the Function key write tags must all be
assigned to the same block as the Function Key Return
Message Number tag.

Maintained Function Keys

A Maintained Function Key changes state (0 to 1, or 1 to 0) when
pressed, and remains in the changed state when released. It returns to
its original state when the function key is pressed and released again.

A Maintained Function Key retains its current state after the message
is terminated.

Since a Maintained Function Key toggles between two states, its
Initial state (0 or 1) must be specified independently of its Contact
Normally Open/Normally Closed state. The initial state of a
Maintained Function Key after a powerup or terminal reset depends
on the Values At Startup attribute, which is set in the Terminal Setup
Advanced Dialog.

• Preset: the Function key’s state at startup is the same as its initial
state, set in the application.

• Last: the Function key’s state at startup is its last state before the
power down or reset.

A Maintained Function Key does not have a definitive handshake
tag.

!
ATTENTION:    If communication with the logic
controller uses Remote I/O protocol with block
transfer, the function key write tags must all be
assigned to the same block as the Function Key Return
Message Number tag.

Function Key Types
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Toggling a Maintained Function Keys

The procedure for toggling a Maintained Function key depends on
whether the initial message is in Jog or non-Jog mode.

To return the Function key’s associated bit to its former state:

• If the message is in jog mode, the operator may press and release
the Function key a second time. If the operator continues to press
and release the Function key the associated bit will be toggled.

• If the message is in non-jog mode, a second message that has the
same Function key enabled must be triggered. It tells the operator
to press and release the Function key.

Latched Function Keys

A Latched Function Key changes state (0 to 1 or 1 to 0) when
pressed, and remains in the changed state when released. It does not
unlatch if it is pressed again. A Latched Function Key returns to its
original state only when the logic controller sets the latch handshake
bit.

For the procedure when the controller is an ASCII Triggering device,
see Page 4–22.

A Latched Function Key retains its latched state after the message is
terminated. After a terminal reset or powerup, the initial state of a
Latched Function Key is always its released state.

A Latched Function Key requires a handshake tag. The handshake
tag unlatches the Function key when the bit at the handshake tag
address is set to 1 by the logic controller.

Handshake Bit = 0
Write Tag Bit = 0

Function Key
    Pressed

Function Key
  Initial State

Controller Program Sets

Handshake Bit = 0 Handshake Bit = 0

Handshake Bit to 1

Handshake Bit = 1

Controller Program Sets
Handshake Bit to 0

OFF ON ON OFF

Function Key
   Released

Write Tag Bit = 0Write Tag Bit = 1 Write Tag Bit = 1

!
ATTENTION:    If communication with the logic
controller uses Remote I/O protocol with block
transfer, the Function key write tags must all be
assigned to the same block as the Function Key Return
Message Number tag.
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MessageView 421F terminals have a red LED located next to each
function key. Each LED may or may not have an Indicator tag
assigned to it.

Indicator tags are globally defined in the LED dialog.

• When a LED is assigned a certain tag, that tag remains assigned
to it throughout the application.

• When an LED does not have a tag assigned to it, the LED has no
tag any time it is used in the application.

When the LED does not have an Indicator tag assigned to it, the
LED follows the state of the associated Function key (LED1 with F1,
LED 16 with F16). For example, LED4 will light when Function key
F4 is pressed. LED4 remains lit as long as the Function key is in the
On state and the message displayed remains active.

When the LED has an Indicator tag assigned to it, the LED operates
independently of the associated Function key. For example, pressing
and releasing Function key F1 will have no effect on the operation of
LED1. The controller program turns the LED On and Off by setting
or clearing the bit at the Indicator tag address. Thus the logic
controller can indicate a process status to the operator without
displaying a message.

➀➀

No Indicator Tag  Indicator Tag

➁➂

➃

Step Description

➀

➁

➂

Bit set to 1 in F-key

Function Key pressed

LED changes state

Step Description

➀
➁

➂

➃

Bit at Indicator Tag address
set by logic controller

➂

Write Tag address

based on bit read from

INITIAL
STATE

ÎÎÎ
ÎÎÎ
ÎÎÎ

NEXT
STATE

INITIAL
STATE

ÎÎÎ
ÎÎÎ
ÎÎÎ

NEXT
STATE

➁

Write Tag address

Function Key pressed
Bit set to 1 in F-key
Write Tag address

LED changes state
based on bit read from
Indicator Tag address

LED Indicators
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An ASCII Triggering device sends the [Ctrl-L] command to control
a tagged LED:

[Ctrl-L]LED #\LED State\MessageView Address[CR]

• LED # is the LED being toggled

• LED State is 1 (On) or 0 (Off)

• MessageView Address is the node address of the terminal in the
ASCII network.

Handshaking is a means of acknowledging that a command has been
received and performed by either the MessageView terminal or the
logic controller. 

The MessageView terminal supports handshaking for:

• latched function keys

• numeric and ASCII data entry variables

• Auxiliary Port devices (hardware handshaking).

The MessageView terminal supports pseudo handshaking for:

• momentary function keys

• maintained function keys

• acknowledge messages

• all other messages.

Latched Function Key handshake

Latched Function Keys require a defined handshake tag. When a
message uses a Latched Function Key, the Function key write tag
notifies the logic controller that the Function key bit assigned is
latched in the On state. The controller then uses the handshake tag to
notify the MessageView terminal when the Function key is to be
unlatched.

The handshake tag for a Latched Function Key is globally defined in
the Function Key dialog. That is, the tag assigned to a Latched
Function Key is the same tag every time that Function key is enabled
for a message.

Handshaking
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Numeric and ASCII Data Entry handshake

Numeric and ASCII data entry variables do not require a defined
handshake tag. However if you want to enable the handshake feature
of a data entry variable message, both a notification tag and a
handshake tag must be defined.

• When a notification tag is assigned, the MessageView terminal
has a means of signalling that data entered from the terminal has
been transferred to the logic controller.

• When a handshake tag is assigned, the logic controller has a
means of signalling the MessageView terminal that it received the
data.

Note: Define both notification and handshake tag or neither. If only
one is defined, the application will not pass validation.

Note: If a message contains more than one data entry variable, each
variable is supported by its own write tag address. However the
notification and handshake tags are shared by all data entry variables
in the message. Consider the write tag to be local to the individual
data entry variable, and the notification and handshake tags global to
the message as a whole.

Example:

Message A contains:

Enter Air Temperature: XXX; Enter Water Temperature: YYY.

where XXX and YYY are data entry variables.

If XXX is assigned these tag addresses:

Write Tag Address: TAG_A
Notification Tag address: TAG_NOTIFY
Handshake Tag Address: TAG_HAND

Then YYY would be assigned these tag addresses:

Write Tag Address (any tag address but TAG_A)
Notification Tag Address TAG_NOTIFY
Handshake Tag Address TAG_HAND

If the notification or handshake tag is changed in one of the data
entry variables in a message, the change affects all data entry
variables in that message.
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When data entry handshaking is used, the controller logic is required
to set the handshake tag bit before the user-defined handshake
timeout occurs. If the terminal does not receive the handshake bit
before time expires, it will display a handshake timeout message.
The terminal operator must acknowledge the timeout message before
the application can resume. See page 10–16 to adjust the timeout
time. 

Example of handshaking with Entry Variables: 

Operator enters
value.

Handshake Tag = 0

Operator presses
Enter key.

Terminal Sets Notification Tag = 1

Handshake Tag = 0
Notification Tag = 0

Controller ladder logic program
 Verifies that notification address is set to 1.
Sets handshake address to 1.

–
–

Controller program then clears handshake tag.

 ➁

 ➂
 ➃

Controller Sets Handshake Tag = 1
Notification Tag = 1

Handshake Tag = 0
Notification Tag = 0

Message contains an Entry Variable. ➀

 ➄

Handshake Tag = 0
Notification Tag = 0

Terminal clears notification tag.

Notification Tag Handshake Tag
B3

1 1

B3

WHEN THE TERMINAL SETS THE NOTIFICATION TAG, IT WAITS FOR THE CONTROLLER TO SET THE
HANDSHAKE TAG.
IF THE HANDSHAKE TAG IS NOT SET BEFORE THE SPECIFIED TIMEOUT TIME, THE TERMINAL NOTIFIES
THE OPERATOR THAT THERE IS A COMMUNICATIONS PROBLEM.
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Hardware handshake for an auxiliary port

A MessageView terminal may have its RS-232 port connected to an
auxiliary device. A number of auxiliary devices are listed on Pages
5–6 and 5–7. 

The RS-232 cable has an RTS line from the terminal to notify the
device when it is ready to receive, and a CTS line from the device to
notify the terminal when it is ready to receive. These are used as
follows:

• If the terminal’s input buffer is full, the terminal asserts the RTS
line so the auxiliary device will stop sending data.

• If the terminal detects an asserted CTS line, it will not send any
more data.

• If the terminal detects an asserted CTS line after 30 seconds, the
terminal displays a CTS error message. This message remains
active for 2 seconds, then it is cleared from the display. After 30
seconds the terminal tests the CTS line again and if necessary
displays the CTS error message again. This cycle is repeated until
the communications problem is corrected and the CTS line is
non–asserted.

Momentary or Maintained Function Keys pseudo handshake

The MessageView terminal supports a pseudo handshake for
Momentary and Maintained Function Keys. The pseudo handshake
uses the Function Key Return Message Number tag defined in the
Terminal Setup Control Tags dialog. See Page 10–24. 

If the Function Key Return Message Number tag is defined, the
MessageView terminal will return the message number associated
with the Function key each time the Function key is pressed. This
provides a means of signalling to the logic controller that a Function
key bit has been set or reset.

The Function Key Return Message Number tag is globally defined.
That is, the Return Message Number tag address is the same for all
messages using a Function key.
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Acknowledge messages pseudo handshake

The MessageView terminal supports a pseudo handshake for
acknowledgeable messages. The pseudo handshake uses the
Acknowledge Return Message Number tag defined in the Terminal
Setup Control Tags dialog. See Page 10–23.

If the Acknowledge Return Message Number tag is defined, the
MessageView terminal will return the message number associated
with a message each time an acknowledgeable message is
acknowledged. If a message is not acknowledged, no message
number is returned. This provides a means of signalling to the logic
controller that a message has been acknowledged.

The Acknowledge Return Message Number tag is globally defined.
That is, the Return Message Number tag address is the same for all
acknowledgeable messages.

All messages pseudo handshake

The MessageView terminal supports a pseudo handshake for all
messages not included in the above handshake types. The pseudo
handshake uses the Return Message Number tag defined in the
Terminal Setup Control Tags dialog. See Page 10–21.

If the Return Message Number tag is defined, the MessageView
terminal will return the message number associated with a message
that does not have the Ack attribute or function keys, each time the
message is displayed. If a message is not displayed, no message
number is returned. This provides a means of signalling to the logic
controller that a message has been displayed.

Note: Hidden messages do not return a message number when they
are processed, since they are not displayed.

The Return Message Number tag is globally defined. That is, the
Return Message Number tag address is the same for all messages.
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Create tags in the Tag Editor to link message triggers and message
variables with specific controller addresses. A tag specifies the
address and data type, whether a value should be written to that
address or read from it, and other information. Chapter 8 shows how
tags are used in MessageBuilder applications.

Message triggers and each embedded variable in a message must be
linked to a controller data table. The MessageView terminal either
reads the data for a message trigger or a display variable, or writes
data for an entry variable.

MessageView Display

PLC/SLC Data Tables

Input Table

Output Table

Integer Table

Counters, Timers, 
Status, Control, etc.

Message with
Entry Variable
Discrete I/O

  Message with
Display Variable
    Discrete I/O

  Message with
Display Variable
  Block Transfer

Tags
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Assign a tag to any data type the PLC or SLC supports.

 SLC File Types

File Type Read/Write Identifier File Number Element
Integer

Sub-Element
Bit Number

Output Read O 0 0-255 n/a 0-15

Input Read I 1 0-255 n/a 0-15

Status Read/Write S 2 0-82 n/a 0-15

Bit (Binary) Read/Write B 3, 9-255 0-255 n/a 0-4094

Timer Read/Write T 4, 9-255 0-255 PRE, ACC EN, TT, DN

Counter Read/Write C 5, 9-255 0-255 PRE, ACC CU, CD, DN, OV, UN

Control Read/Write R 6, 9-255 0-255 LEN, POS
EN, EU, DN, EM, ER,

UL, IN , FD

Integer Read/Write N 7, 9-255 0-255 n/a 0-15

String Read ST 9-255 0-255 LEN, DATA n/a

ASCII Read A 9-255 0-255 n/a 0-15

PLC-5 File Types

File Type Read/Write Identifier File Number Element
Integer

Sub-Element
Bit Number

Output Read O 0 0-277➀ n/a 0-17➀

Input Read➁ I 1 0-277➀ n/a 0-17➀

Status Read/Write S 2 0-127 n/a 0-15

Bit (Binary) Read/Write B 3-999 0-999 n/a 0-15999

Timer Read/Write T 3-999 0-999 PRE, ACC EN, TT, DN

Counter Read/Write C 3-999 0-99 PRE, ACC CU, CD, DN, OV, UN

Control Read/Write R 3-999 0-999 LEN, POS
EN, EU, DN, EM, ER,

UL, IN , FD

Integer Read/Write N 3-999 0-999 n/a 0-15

BCD Read/Write D 3-999 0-999 n/a 0-15

Block
Transfer

Read/Write BT 3-999 0-999 n/a n/a

Message Read MG 3-999 0-584
ERR, RLEN,
DLEN, DATA

 NR, TO, EN, ST, DN,
ER, CO, EW, SD, SE

PID Read/Write PD 3-999 n/a n/a n/a

SFC Read/Write SC 3-999 n/a n/a n/a

String Read ST 9-255 0-255 LEN, DATA n/a

ASCII Read A 9-255 0-255 n/a 0-15

➀ Octal format, all other values are decimal.

➁  Remote I/O allows the MessageView to write its own output words.
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The MessageView terminal can read and write both of these data
types: 

• single bit data type

• value data type.

Bit data

Bit data occupies a single bit address and represent an On (closed) or
Off (open) condition.

Address B3/10 = On = Off1 0

Use a bit address:

• to read or write a value of 0 or 1 in a variable

• to trigger a message.

Value data

Value data types occupy a word (2 bytes or 16 bits) address that
represents a numeric value. No matter how large or small the value, a
whole word must be assigned to it.

0 0 0 0 0 0 0 1 0 0 0 1 0 1 0

124816326412825651210242048409681921638432768

1
Address N7:2
   = 277

Data Formats

The MessageView terminal recognizes and transfers 5 data formats.

Data Format Range

Bit 0 or 1

Unsigned Integer 0 to 65535

Signed Integer -32768 to +32767

BCD 0 to 9999

Character Array alphanumeric characters

Bit 

Data in bit format occupies only one bit of memory. Its address is
given not as a word (N7:2), but as a bit (N7:2/10). A bit is a location,
and depends on its position in the word. It can be set or reset.

Data Types



4–34 Planning an Application

Publication 2706-817

Signed and Unsigned Integers

Data in signed and unsigned integer format occupy one word 
(2 bytes or 16 bits) of memory, no matter how small the value is.

Every bit has a value that depends on its position in the word. The
value encoded is the sum of the bits that are set.

0 0 0 0 0 0 0 1 0 0 0 1 0 1 0 1

124816326412825651210242048409681921638432768

256 16 4 1+ + + = 277

Unsigned Integer

1 1 1 1 1 1 1 0 1 1 1 0 1 0 1

Signed Integer

1248163264128256512102420484096819216384

1

256 16 4+ + = –277+ 1

Sign Bit
1=Negative
0=Positive

2’s 
Complement

BCD

Data in BCD format (also called 4-BCD) occupy one word of
memory. Every four bits encodes a single decimal digit 0 � 9.

0 0 0 0 0 0 1 0 0 1 1 1 0 1 1

BCD
1248

1

124812481248

2 7 70 = 277

Character Array

Data in Character Array format are assigned to ASCII variables. The
length of a character array is from 1 to 32 bytes.

The ST file type is a character array. Other file types can also be
viewed as characters.
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Before entering tags in the Tag Editor dialog, use a copy of the
Address Worksheet in Appendix H to record them. Each line in the
worksheet is 1 word (2 bytes or 16 bits), since this is the unit of
controller address memory. Use separate worksheets for display
(logic controller write) and for entry (logic controller read) variables,
since these are stored in different memory areas.

The figure shows two examples of recording addresses. For proper
address formats, refer to the controller’s user manual. Assign:

• a whole word (16 bits) to signed and unsigned integers and 4BCD
data types

• specific bits to bit data types

• a word (or words adjacent to one another) for bit triggers

• character arrays to ASCII data types.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Entry Address Worksheet

Controller Address

Word Address
Tag Name

I:020

O:027

O:028

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1 0

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

Word Address
Tag Name

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1 0

Octal

Decimal

Octal

Decimal

RTRN_MSG_NO

HANDSH

Read Tag Name = MOTOR_DISPLAY

Write Tag Name = MOTOR_ENTRY

Handshake Tag Name = HANDSH

Notification Tag Name = RTRN_MSG_NO

READ

WRITE

MOTOR_DISPLAY

Display Address Worksheet

MOTOR_ENTRYI:021

Address Worksheet
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Read or Write tags that define controller addresses for variables are
entered in the Tag Editor. See Page 8–2. A tag has the following
attributes:

Tag Attributes Description

Tag Name Unique name identifying tag address

Data Type Bit, BCD, Unsigned/Signed Integer, Character Array

Array Size
Number of elements in a character array. 
For other data types, leave blank.

Description General description of the variable

Node Name
Name of the logic controller that will store the
address

Tag Address Specifies word or bit location in controller memory

Initial Value Value in tag address at powerup

Update Frequency
How often the tag address will be updated while the
operation is running

Scaling➀ Scale and scale offset values

Data Entry Limits➀ Upper and lower limits of data stored at tag address

➀ Usage depends on the variable. These attributes can be entered only in the Form View.

The Tag Editor supports two different methods for entering tags:

• Table View for entering multiple tags.

• Form View for entering a single tag.

Table View Form View

Tags are stored in a database that is referenced by a project name.
The project name is entered when creating a new application file. 

Note: A project can be created only when a new application is
created. However, once it has been created, existing or new
applications may be assigned to it.

Defining Tags
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Scaled Data Display Variables take raw numeric values and
mathematically manipulate them so the values can be shown in
standard units such as:

• gallons

• feet per second

• pounds per square inch.

Values from the logic controller address are scaled using the formula:

y =  mx + b  

y = scaled (displayed) value

m = scale (multiplier)

x = value stored in controller address

b = offset.

The scale and offset values are entered in the Tag Editor.

Example: Scaling a Display Variable

Flow Rate
Transducer
Value

510

Valve #1

Flow Rate
Transducer 510

Controller

13
Scaling
(x 0.0059 + 10)

Note: Messages sent to slave devices may contain scaled variables.
The variable tag contains the scaling information.

Scaling Data Display
Variables
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Data entered by a MessageView terminal operator can be scaled
from engineering units such as:

• gallons

• pounds per square inch.

to machine control values.

Values entered at the terminal are scaled according to the formula:

x =
y - b

m =
Entered Value - Offset

Scale

y =  mx + b  

y = scaled  value (entered by operator)

m = scale (multiplier)

x = controller value

b = offset.

To calculate value (x) stored at the controller address, the formula becomes:

The scale and offset values are entered in the Tag Editor. Scaled
values affect the controller values as follows:

• A scale (m) entered as a value >1 generates an x value smaller
than y - b.

• A scale (m) entered as a value <1 generates an x value larger than
y - b.

Note: An ASCII Input device may transmit either numeric or
alphanumeric data.

• If it sends numeric data, it may enter the data in a Numeric Entry
variable where it may be scaled if necessary.

• If it sends alphanumeric data, it enters the data in an ASCII Entry
variable, where it cannot be scaled.

Scaling Data Entry
Variables
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Example: Scaling a data entry variable

The offset (b) is specified as 2 and the scale (m) is specified as .01.
If an operator enters a value of 30 for (y):

 
x =

y - b
m =

30 - 2
.01

= 2800

The terminal sends a value of 2,800 to the controller, which
compares it to the value from the weigh scale  transducer:

Value  from 
Weigh Scale= 2,800

Operator Inputs
Weight of 30 Pounds

MessageView Terminal
Scales Value to 2,800
for Match Code

Weigh Scale Value (2,800)
Matches Input Value (2,800)
Package is Accepted

 ➂

 ➁

 ➃

 ➀
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Data Limits for a scaled variable

If a value exceeds the range for the selected data type, the terminal
will display a “Value Not in Range” warning. When using scaling, it
is a good idea to limit the minimum and maximum values an
operator can enter. These values are set in the Tag Editor Form View.

The range for scaled values should be calculated before the Tag
Form dialog is filled out. Use the following formula to determine
scaled minimum and maximum values:

Maximum Input Value =

Minimum Input Value =

Maximum Value for Data Type x Scale + Offset

Minimum Value for Data Type x Scale + Offset

Example:

Scale = 1.8 and Offset = 32 (Fahrenheit to Celsius conversion)

Data type is Signed Integer (-32,768 to +32,767)

The minimum and maximum values an operator can enter without
truncating:

Maximum Input Value =

Minimum Input Value =

32,767 x 1.8

-32,768 x 1.8

+ 32 = 59012

+ 32 = -58950

Initial value of a scaled variable

The initial value specified in the Tag Form dialog is written to the
controller upon powerup or reset. This initial value is not scaled, so it
must be entered in the units used by the logic controller.

For instance, assume the terminal uses °C and the controller uses °F.
To initialize the terminal to a value of 32 °F, the initial value in the
Tag Editor needs to be 32, not 0.
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The logic controller stores values only as integers. Digits to the right
of the decimal are rounded off. However the terminal can scale
decimal values to or from integer values.

In this illustration, the entered value of 7.5 is rounded up to 8. When
this value is displayed or used in a mathematical formula, the result
may be incorrect.

Entered Value = 7.5 Displayed Value = 8

Controller Value = 8
(rounded)

If decimal precision is needed, select appropriate values for scale and
offset.

Example:

Use scaling to convert a decimal value from degrees Fahrenheit to
degrees Celsius.

Scale
Rounded4964.44

4964
Offset = 32

Scale = .018 4964

121.36
Entered Value

121.35
Displayed Value

Controller

Scale
50.5

51
Offset = 32
Scale = 1.8 51

122.9
Entered Value

123.8
Displayed Value

Controller

Fixed Decimal
Decimal Position = 2
Field Width = 6

Keypad Controlled Decimal
Decimal Position = Operator Entered
Field Width = 6

123.8

Rounded

The decimal point is positioned to provide a display appropriate to the scaled value.

Controller Value =
Entered Value – Offset

Scale

Displayed Value =  Controller Value x Scale +
Offset

Equations for Scaling Example

121.36 – 32

0.018
=  4964.44  =  4964

(4964 x 0.018) + 32 = 121.35

Stored Value =

Displayed Value =

Fixed Decimal

Stored Value =

Displayed Value =

122.9 – 32

1.8
=  50.5 = 51

(51 x 1.8) + 32 = 123.8

Stored Value =

Displayed Value =

Keypad Controlled Decimal

The terminal stores the full precision value and the controller stores
the rounded value.

Note: The value stored in the terminal may be different than the
value sent to the controller because of rounding that occurs during
pre-scaling.

Precision and Rounding
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This chapter covers the following topics:

• MessageView 421 terminal ports

• RS-232 Port communication

• ASCII Triggering commands

• Remote I/O communication

• Discrete I/O

• Block transfer.

Each Message View 421 terminal has a standard RS-232 port on the
Main Logic Board. It may also include an optional Remote I/O
(RIO) Communications daughterboard card. 

The MessageView terminal’s two available ports are used as follows:

• The Remote I/O Port (optional) connects to a logic controller on a
Remote I/O network.

• The RS-232 Port connects to:

– the RS-232 port of a personal computer
– other devices set up in the application to be used when the

terminal is in Run Mode, which are listed on Page 5–3.

Remote I/O Port

Certain MessageView terminals have a Remote I/O Port installed
(Catalog Nos. 2706-M1D1, -M1N1 and -M1F1). The RIO port is
used for the sole purpose of communicating with:

• a logic controller, which runs the operation

The Remote I/O port of a MessageView terminal, when connected to
a logic controller, is used to transmit and receive data utilizing
discrete I/O and block transfer modes.

Each MessageView terminal is configured to match the device type
and communication parameters of the Logic Controller in its Remote
I/O system. The configuration is set up when the application is
created, so a terminal may be used in a variety of systems according
to the application downloaded into it. This will be discussed starting
on Page 5–12.

MessageView 421 Terminal
Ports
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RS-232 Port

All MessageView terminals incorporate an RS-232 port for serial
communications.

Use the RS-232 port to connect the terminal to:

A MessageView terminal uses its RS-232 port:

• to transfer applications and other information between the
MessageView terminal and a personal computer

• to communicate with an ASCII Input device (terminals which
support ASCII Input)

• to communicate with one or more slave devices (terminals which
support the slaving feature)

• to communicate with an ASCII Triggering device (Catalog Nos.
2706-M1D, -M1N and -M1F)

• to connect a 421D slave device (Catalog No. 2706-M1D) to a
master device.

RS-232 port: DF1 configuration

The RS-232 port of a MessageView terminal is used to transfer files
to and from a computer using DF1 point-to-point communication
protocol.

• DF1 parameters in the MessageView terminal used in
point-to-point communications with a computer containing
MessageBuilder software are predefined and non-configurable.

• DF1 parameters in the computer were defined when the
INTERCHANGE Configuration Utility was installed. See 
Page 2–7.

DF1 parameters are given here for reference only.

Parameter: DF1 Settings:

Baud Rate 19.2K

Parity None

Data Bits 8

Stop Bits 1

Hardware Handshaking None

Error Type CRC

RS-232 port: Auxiliary Device configuration

If the terminal is to communicate with an Auxiliary Device (one of
those listed on Page 5–3), you must configure the RS-232 port
communication parameters for that device.

Configuration options will be discussed starting on Page 5–3, and
configuration procedures starting on Page 10–9.
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The RS-232 port of the MessageView terminal may be used to
communicate with: 

• a personal computer running MessageBuilder (see Page 11–6) or
the File Transfer Utility (see Page 11–15).

• an ASCII Triggering Device (see the list on Page 5–7)

• an ASCII Input Device (see the list on Page 5–6)

• one or more slave devices (see the list on Page 5–6)

• a master device (see the list on Page 5–8)

Switching RS-232 settings in the MessageView terminal 

The MessageView terminal shares its RS-232 port between
communications with a computer that has MessageBuilder software
installed, and communications with an Auxiliary Device. The
terminal’s RS-232 port must be switched (configured) to the proper
setting before communications can be established.

Example: The terminal’s RS-232 port’s last communication was
from a bar code reader (an ASCII Input device). Next, the HE Stack
file has to be uploaded to a personal computer that has
MessageBuilder software running. The terminal operator must
configure the RS-232 port as a MessageBuilder port to establish
communication with the computer.

To do this, the operator enters the terminal’s Front Panel Editor. The
first menu item, “Change Port To: MessageBuilder” allows the
operator to switch to the MessageBuilder port settings in one quick
step without entering half a dozen communication parameters. After
the HE Stack file has been uploaded, the terminal operator switches
the “Change Port To:” menu item to ASCII Input and returns the
terminal to Run Mode.

Important: If you find your computer cannot communicate with
the MessageView terminal, verify that the RS-232
port is set to the correct communication device.

RS-232 Port
Communication
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If the Front Panel Editor “Change Port To:” menu item reads:

•  “Change Port To: MessageBuilder”, the RS-232 port is currently
set to communicate with the Auxiliary Device the application is
designed for.

• “Change Port To: [ASCII Triggering, Slave Device, Slave Port, or
ASCII Input]”, the RS-232 port is currently set to communicate
with the computer.

The name in the “Change Port To:” menu item is the type of
Auxiliary Device the application is designed for.

Note: The physical connection between the computer and the
terminal does not have to be maintained after an application is
downloaded. If it is not maintained, the connection must be
re-established when a file is to be uploaded to or downloaded from
the computer.

RS-232 Port Power-Up attribute

The application sets the MessageView terminal’s RS-232 port to
power up to one of the two possible settings when the application
starts running:

• MessageBuilder parameters

• auxiliary port parameters.

The Port Power-Up attribute is configured in the Advanced tab in the
Terminal Setup dialog. See Page 10–16.

MessageView terminal hardware/firmware

MessageBuilder software has been designed to configure the RS-232
port parameters for communication with a device compatible with
the MessageView terminal’s hardware/firmware configuration.

If the terminal’s RS-232 port is used to communicate with:

• the computer only, the port parameters do not have to be
configured in the application. They are predefined in the
INTERCHANGE Configuration Utility (see Page 5–2) and the
MessageView terminal’s firmware.

• an Auxiliary Device while the application is running, the port
parameters must be configured in the application to match those
of the auxiliary device.



5–5Communications Overview

Publication 2706-817

The RS-232 port parameters may be configured in the Terminal
Setup dialog using either the Aux. Port tab (see Page 10–27) or the
Comms. Setup button (see Page 10–9). This table shows where to
configure parameters for each type of terminal.

Catalog # Firmware Protocol
RS-232 Port Parameter

Configuration
Remarks

2706-M1D
ASCII Triggering
Slave Device

Comms. Setup button
Terminal controlled by an ASCII Triggering device.
Terminal acting as a Slave Device.

2706-M1N ASCII Triggering Comms. Setup button Terminal controlled by an ASCII Triggering device.

2706-M1F ASCII Triggering Comms. Setup button Terminal controlled by an ASCII Triggering device.

2706-M1D1

Remote I/O

Slave Port
ASCII Input

Comms. Setup button

Aux. Port tab

Terminal controlled by a logic controller through the
Remote I/O port.
Connection to an ASCII Input device.
Connection to a slave device or devices.

2706-M1N1

Remote I/O

Slave Port
ASCII Input

Comms. Setup button

Aux. Port tab

Terminal controlled by a logic controller through the
Remote I/O port.
Connection to an ASCII Input device.
Connection to a slave device or devices.

2706-M1F1

Remote I/O

Slave Port
ASCII Input

Comms. Setup button

Aux. Port tab

Terminal controlled by a logic controller through the
Remote I/O port.
Connection to an ASCII Input device.
Connection to a slave device or devices.

Using the Aux. Port tab

The Aux. Port tab in the Terminal Setup dialog allows you to
configure an alternate set of communication parameters for the
RS-232 port on the terminal. 

This tab is used when the terminal specified in the Terminal Setup
dialog has a Remote I/O port (Catalog Nos. 27006-M1D1, -M1N1 or
-M1F1).
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The Auxiliary Device uses the same RS-232 port that Message-
Builder software uses to download the application, but the port
parameters may be different.

• See Page 10–27 for the procedure to configure the RS-232 port to
communicate with one of the auxiliary devices listed below.

• See Page 5–3 for an outline of the procedure the terminal
operator uses to switch from one set of port parameters to the
other.

Note: Parameters for communication between the MessageView
terminal and the computer are built into the terminal firmware, and
cannot be edited.

ASCII Input device

A MessageView terminal with a RIO daughterboard and firmware
that supports ASCII Input, can accept data from an ASCII Input
device. Data from such a device is entered into ASCII  or Numeric
Entry variables embedded in a message. 

ASCII Input devices include the following:

• bar code scanner

• AdaptaScan  reader

• PLC  port 0.

• other devices with serial communication that can send ASCII
data.

To set up a terminal to communicate with an ASCII Input device, see
Page 10–27.

Slave Port (master device)

A MessageView terminal with a RIO daughterboard and firmware
that supports slaving can command up to 126 slave devices. The
slave devices display messages as they are commanded. Each slave
device may be addressed individually, or a command may be sent to
all slaves at the same time using node address 127. 

Slave devices include:

• Allen-Bradley Dataliner  DL10

• Allen-Bradley Dataliner  DL20

• Allen-Bradley Dataliner  DL50

• MessageView 421D terminal without a daughterboard (Catalog
No. 2706-M1D). See Page 5–8 for the 421D Slave Device.

To set up a terminal as a master device to communicate with slave
devices, see Page 10–27.
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Using the Comms. Setup button

The Comms. Setup button in the Terminal Setup dialog allows you to
configure communication parameters for the RS-232 port on the
terminal. 

This dialog may be accessed only when the terminal specified in the
Terminal Setup dialog is a slave device or is controlled by an ASCII
Triggering device (Catalog Nos. 2706-M1D, -M1N and -M1F).

When the MessageView terminal communicates with an ASCII
Triggering device or acts as a slave to a master device, it uses the
same RS-232 port that Message Builder software uses to download
the application, but the port parameters may be different.

• See Page 10–9 for the procedure to configure the RS-232 port to
communicate with one of these devices.

• See Page 5–3 for an outline of the procedure the terminal
operator uses to switch from one set of port parameters to the
other.

Note: Parameters for communication between the MessageView
terminal and the computer are built in to the terminal firmware, and
cannot be edited.

ASCII Triggering device

An ASCII Triggering device is used to trigger messages on the
MessageView terminal using RS-232 ASCII protocol.

ASCII Triggering devices include: 

• SLC 5/03 , SLC 5/04  Port 0

• SLC BASIC Module

• PLC-5  Port 0

• other logic controllers with serial ports

• Allen-Bradley Industrial Computers

• any ASCII Transmitting device, including a VT100 Dumb
Terminal.
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To set up a terminal to communicate with an ASCII Triggering
device, see Page 10–9.

For the format of commands to and from an ASCII Triggering
device, see the section starting on Page 5–8.

MessageView 421D Slave Device

A MessageView 421D Slave Device (Catalog No. 2706-M1D) is a
MessageView terminal with no daughterboard and no numeric or
function keys. It is shipped with an application loaded. The
application supplies the alphanumeric fonts and graphic characters
needed to display the messages sent from the master device.

The slave terminal may receive commands from any one of the
following slaving devices (masters):

• Allen-Bradley Dataliner  DL20

• Allen-Bradley Dataliner  DL40

• MessageView  421D terminal whose firmware supports slaving

• MessageView  421N terminal whose firmware supports slaving

• MessageView  421F terminal whose firmware supports slaving

• Allen-Bradley Industrial Computers.

To set up a terminal as a Slave Device, see Page 10–9.

For the format of commands to a slave device, see the section
starting on Page 7–42.

Messages to the MessageView terminal 

Trigger a message with [Ctrl-T]

Used by the ASCII Triggering device to trigger a specific message in
the terminal.

Format: [Ctrl-T]Message#\ MV Address[CR]

• Message# range: 1 to 9999; limited to the subset used in the
application

• MV Address range: 1 to 127 for a single node; 127 to address all
devices

Example: [Ctrl-T]24\ 6[CR]

• The terminal at node #6 displays message #24 in the downloaded
application

ASCII Triggering
Commands
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Send data to a display variable with [Ctrl-V]

Used by the ASCII Triggering device to send data to a specific
display variable in the terminal. Each variable must be addressed
individually. Numeric data may be scaled.

Format: [Ctrl-V]Variable Data\ Variable Position\ MV Address[CR]

• Variable Data range: -32768 to +65535 for numeric data

       any ASCII character for ASCII data

• Variable Position range: 1 to 10

Note: Variable position is the position of the variable in the
message, counting from left to right. If the message contains only
one display variable, the position is 1.

• MV Address range: 1 to 127 for a single node; 127 to address all
devices

Data enclosed in quotation marks is interpreted as ASCII data, even
if it consists of numbers.

Example: [Ctrl-V]“Press “ACK””\ 1\ 2[CR]

• The terminal at node #2 displays Press “ACK”  in the first
display variable in the currently active message.

Activate/Deactivate an LED with [Ctrl-L]

Used by the ASCII Triggering device to toggle a specific LED in the
terminal.

• Format: [Ctrl-L]LED#\ LED State\ MV Address[CR]

• LED# range: 1 to 16

• LED State range 0 or 1; 0 represents the LED Off state, 1
represents the LED On state

• MV Address range: 1 to 127 for a single node; 127 to address all
devices

Example: [Ctrl-L]4\ 1\ 22[CR]

• The terminal at node #22 turns LED #4 On.
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Unlatch a latched function key with [Ctrl-U]

Used by the ASCII Triggering device to unlatch a specific latched
function key in the terminal.

Format: [Ctrl-U]F-key#\ MV Address[CR]

• F-key# range: 1 to 16

• MV Address range: 1 to 127 for a single node; 127 to address all
devices

Example: [Ctrl-U]7\ 22[CR]

• The terminal at node #22 unlatches function key #7. The terminal
then sends a Ctrl-F message when the message is received and
acted upon.

Messages from the MessageView terminal:

Send data from entry variables [Ctrl-I]

Used by the terminal to send input data to the ASCII device.

Format: [Ctrl-I]Message#\ Variable Data\ Variable Position[CR]

• Message# range: 1 to 9999; limited to the subset used in the
application

• Variable Data range: -32768 to +65535 for numeric data

        any ASCII character for ASCII data

• Variable Position range: 1 to 10

Note: Variable position is the position of the variable in the
message, counting from left to right. If the message contains only
one entry variable, the position is 1.

• MV Address range: 1 to 127 for a single node; 127 to address all
devices

Example: [Ctrl-I]64\ 44232\ 3[CR]

• The terminal sends the value 44232 which was input in the third
variable in message #64.

Note: If users are entering data [Ctrl-I] at the same time at different
terminals in the network, they may cause data collisions. The
MessageView node address was intentionally left off the Data Entry
[Ctrl-I] response message to discourage this situation.

!
ATTENTION:  If the ASCII network has more than
one terminal, data should not be sent from any terminal
to the ASCII device. Data collisions may result if the
ASCII device has data coming from more than one
source.
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Acknowledge an alarm message with [Ctrl-K]

Used by the terminal to inform the ASCII Triggering device that the
operator has pressed the ACK key in response to an alarm message.

Format: [Ctrl-K]Message#[CR]

• Message# range: 1 to 9999; limited to the subset used in the
application

Example: [Ctrl-K]75[CR]

• The terminal displayed message #75, which was defined as an
acknowledgeable message. The operator pressed the ACK key,
and this response message was sent to the ASCII Triggering
device.

Report a function key press with [Ctrl-F]

Used by the terminal to inform the ASCII Triggering device that the
operator has pressed a function key.

Format: [Ctrl-F]Message#\ F-key#\ F-key action[CR]

• Message# range: 1 to 9999; limited to the subset used in the
application

• F-key# range: 1 to 16

• F-key action range: 0 or 1; the application defined the function
key as Normally Open or Normally Closed; this Normal state is
defined as 0.

Example: [Ctrl-F]33\ 5\ 1[CR]

• When the terminal operator pressed function key #5 which was
enabled in Message #33, the terminal informs the ASCII
Triggering device that the function key has changed to the altered
state.

Note: If the operator presses a momentary function key, the
terminal will automatically send another [Ctrl-F] message when
its Hold Time is up:

     [Ctrl-F]33\ 5\ 0[CR]

Note: If a latched function key is unlatched after the terminal
receives a [Ctrl-U] message, the Message# parameter in the
[Ctrl-F] message is 0.



5–12 Communications Overview

Publication 2706-817

Return message number with [Ctrl-N]

Certain types of messages have their message number returned to the
ASCII Triggering device using [Ctrl-K], [Ctrl-I] or [Ctrl-F]. The
terminal uses the [Ctrl-N] command to report all other types of
messages when they are triggered.

Format: [Ctrl-N]Message#[CR]

• Message# range: 1 to 9999; limited to the subset used in the
application

Example: [Ctrl-N]637[CR]

• The terminal reports that message #637 was triggered.

Report the HE Stack status with [Ctrl-H]

Used by the terminal to report to the ASCII Triggering device that
the Historical Event Stack is 85%, 95% or 100% full.

Format: [Ctrl-H]HE Stack Status[CR]

• HE Stack Status range: 85, 95 or 100

Example: [Ctrl-H]85[CR]

• The Historical Event Stack is 85% full.

On a remote I/O network, the MessageView 421 terminal appears
like any other Remote I/O rack. Configure the terminal to occupy all
or part of a single rack, up to 128 I/O.

Two types of addresses can be assigned to application variables on a
Remote I/O network:

• discrete - a single input or output bit address

• block transfer - a series of contiguous word addresses transferred
as a unit.

Important:  Plan the addresses before starting to create the
application for most efficient use of memory.

The direction of data transfer over a remote I/O link is from the point
of view of the logic controller:

• entry variables are BTR (block transfer read): data from the
terminal to the controller

• display variables are BTW (block transfer write): data from the
controller to the terminal.

Remote I/O
Communication
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Module groups

The MessageView 421 I/O can occupy 1/4, 1/2, 3/4, or a Full rack.
Each 1/4 rack contains two module groups (32 input and 32 output
bits). An entire rack contains 8 module groups that are numbered
from 0 to 7.

Rack # MessageView I/O

Four 1/4 
Rack Sizes

Eight Input/Output
Module Groups

0 1 2 3 4 5 6 7

1/41/4 1/41/4

Input

Output 0 1 2 3 4 5 6 7

Each input or output module group has 16 bits

If a MessageView terminal does not occupy a full rack, another
terminal or device can be configured for the unused modules. For
example:

Parameter MessageView 421 Other Rack Device

Rack Number 1 1

Starting Module Group 0 6

Rack Size 3/4 1/4

Last Chassis? No Yes

Important: Two I/O systems can not share the same module.

 The maximum rack number that can be assigned to the terminal
depends on the type of logic controller.
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Controller Types

The Remote I/O port can communicate with any of the PLC or SLC
controller/scanner types listed below. 

Controller/Scanner Type Lowest Rack # Highest Rack #
Supports

Block
Transfer?

IBM PC 6008-SI
VME 6008-SV
DEC QBUS 6008-SQ

0 7 Yes

PLC 5/11 3 3 Yes

PLC 5/15
PLC 5/20

1 3 Yes

PLC 5/25
PLC 5/30

1 7 Yes

PLC 5/40 1 17octal Yes

PLC 5/60
PLC 5/80

1 27octal Yes

SLC 1747-SN Series A 0 3 No

SLC 1747-SN Series B 0 3 Yes

Other 1771-SN Subsystem 1 7octal No

Remote I/O Communication parameters

Define RIO communication parameters in the Communication Setup
dialog, which is accessed from the Terminal Setup dialog.
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The options in this dialog are:

Remote I/O
Device

Remote I/O
Parameter

Description Options

PLC/Scanner Type
Type of controller that will
communicate with the RIO
port of the terminal

See Table on 
Page 5–14

Name

Unique name assigned to
controller. Enter it in the
Node Name field in the Tag
Editor

User assigns it

Terminal Rack Address
Unique node address of
MessageView 421 terminal
on Remote I/O link

0-76octal

Module Group
Module groups occupied by
the terminal in the rack; they
must be next to one another

0,1 2,3 4,5 6,7

Baud Rate
The baud rate of the RIO
link determines the
maximum cable length.

57.6 K to 10,000 ft.
115.0 K to 5,000 ft.
230.4 K to 2,500 ft.

Last Chassis

Specifies whether the
terminal occupies the
highest assigned module
group within the rack

Yes, No

To configure Remote I/O:

Parameter Range Default

Rack Number 0 to 76octal (0 to 62decimal) 02octal (4decimal)

Rack Size 1/4, 1/2, 3/4,  Full Full

Last Chassis Yes, No Yes

Starting Module Group 0, 2, 4, 6 0

Pass-Through (This option is not available.)

Block Transfer Enabled, Disabled Disabled

Baud Rate 57.6K, 115.2K, 230.4K 57.2K

Number of Files in Block
Transfer

1

Number of Bytes in
Block Transfer

128
Use Block Transfer
Length

Number of Bytes of
Discrete I/O

16

Discrete I/O addresses communicate directly with the PLC (or other
logic controller). Discrete I/O is recommended for any critical values
that you want updated immediately. 

The number of I/O points in the PLC rack is limited to 16 bytes (128
bits). In planning a large application assign tag addresses of variables
that are less time-sensitive to block transfer. Use copies of the Tag
Address worksheet in Appendix H to help design the application.

Discrete I/O
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Example: Discrete I/O

The MessageView 421 terminal occupies rack #3 in which its
starting module group is 0. The F1 key is addressed as I:030/03, and
the bit trigger for the next message as O:031/01.

➁   The PLC ladder program monitors address I:030/03.

Rack #3 MessageView I/O

0 1 2 3 4 5 6 70 1 2 3 4 5 6 7

8 Input Words 8 Output Words

030 031

➂  The operator presses F1. The terminal sets a bit in the
address assigned to that function key and clears the message.

➃ The ladder program reads bit 03 at address I:030/03.

030

031

Input Word

Output Word

➀  The MessageView monitors the status of
the 8 input words in its rack assignment.

➄   The ladder program sets bit 01 at address O:031/01.

0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0

01

0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0

03 01

23456701234567

0123456701234567

➅   The terminal reads the address, which is assigned as a bit
trigger for the next message. The next message is displayed.



5–17Communications Overview

Publication 2706-817

The RIO interface on the MessageView RIO daughterboard supports
the transfer of blocks of data between a PLC and a MessageView
421 terminal. 

Note: Some logic controllers do not support block transfer. Check
the user manual for the controller used in the system.

Using Block Transfers

Block transfers are assigned to a single byte of input data (module
control byte) and output data (module status byte) within the rack
assigned to the terminal. These two bytes control the operation of the
block transfer and are no longer available for discrete I/O.

These bytes always occupy the low byte of the lowest module group
in the terminal rack assignment. For example, if the starting module
group is 0:

Rack 03 MessageView I/O

0 2 4 61 3 5 7

01234561
0

11121314151617

01234561
0

11121314151617

Starting Module
Group 0

Input Word

Output Word

Status Byte

Module Control Byte

7

7

No matter how many block transfers are assigned (1 to 10), one byte
is reserved in the input and and one in the output rack.

Note: Two copies of the worksheet in Appendix H are used for
Discrete I/O (input and output). Be sure to block off the status byte
and module control byte in these worksheets if the application uses
block transfer.

Block transfer directions are in reference to the PLC:

• Block Transfer Reads (BTR) are inputs to the PLC. They are used
to transfer data from data entry variables on the MessageView
terminal.

• Block Transfer Writes (BTW) are outputs from the PLC. They are
used to transfer data to data display variables on the
MessageView terminal.

Block Transfer
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PLC

Block Transfer Read

Block Transfer Write

MessageView Terminal

Configuring a Block Transfer

Configure MessageView 421 block transfers using the Block
Transfer dialog which is accessed from the Communication Setup
dialog.

Note: When a block transfer starting address is assigned in the
Block Transfer dialog, the size of the block (up to 64 words) is
also specified. The terminal uses the block size (length) to
identify the data segment being transferred.
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Each block transfer must have certain information specified:

• Enabled: whether the block transfer enabled or disabled.

• Address: the starting address to read or write the block transfer.

• Mode: select R for a Read operation or W for a Write operation.

• Length: how many words are transferred (1 to 64). The
MessageView terminal uses the length to identify data blocks.

Each block transfer read must be a unique length and each block
transfer write must be a unique length. However a read block can
be the same length as a write block.

A length of 63 is reserved for Pass-Through.

• Pass-Through: (This option is not available at this time.)

• Block Transfer Timeout: specifies a timeout value for
transferring applications using Pass-Through. A value of 0
disables the timeout.

• Each block transfer requires a corresponding Block Transfer
Write or Block Transfer Read instruction in the ladder program
for the controller. The Data File and Length settings must match
the Data File and Length settings in the Block Transfer dialog.

BTR or BTW
BLOCK TRANSFER READ/WRITE
Rack                                                  03
Group                                                  0
Module                                                0
Control Block                               N36:0
Data File                                      N37:1
Length                                                 4
Continuous                                         N

High or Low Byte (Always 0 for MessageView)

MessageView Rack Assignment
Group No. 0 � 7

Address of the data file which is written or read.
Must match the address entered in the Block
Transfer dialog.

Length of the data being transferred. Must match
the length entered in the Block Transfer dialog.

File that controls how the instruction works

Operating mode of the transfer
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Helpful Hints for Block Transfers

Keep these suggestions in mind when using block transfers:

• Read and Write Blocks can use the same address.

• Read and Write Blocks may overlap partially or completely.

• Since Remote I/O scanners usually make only one block transfer
in one I/O scan:

– improve response times by compacting the data into the
fewest possible blocks (no unused bits)

– if the Function Key Return Message Number global attribute
is enabled, make sure that the tags for function keys are in the
same block as the Function Key Return Message Number tag.

Example: Block Transfer Read

In this example, the MessageView 421 terminal is assigned to rack
#3 and its starting module group is 0. A Numeric Variable Entry
variable has the address N7:2, and its value is read by the logic
controller in a part of the data block being transferred.

BLOCK TRANSFER READ
Rack                                                  03
Group                                                  0
Module                                                0
Control Block                               N36:0
Data File                                        N7:2
Length                                                 4
Continuous                                         N

➀   The operator enters 30 as the motor
speed in the Numeric Variable Entry.

➁   Using information supplied by the Communication
Setup utility, the MessageView determines the
position of the data and the block size.

Entry variable with  
Tag Name “Motor_Speed” to
Address N7:2

➂   The MessageView terminal places the
data in the first word of a 4 word block.

➃   The PLC reads the 4 word block of data
and stores it at the Data File address.

BTR
(EN)

➄   The value (30) entered on the MessageView
terminal display is now stored at N7:2.

Read From
MessageView

Data To PLC

Word 1 30
Word 2
Word 3
Word 4
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Example: Block Transfer Write

In this example, the MessageView 421 terminal is assigned to rack
#3 and its starting module group is 0. A Numeric Variable Display
variable has the address N7:0, and its value is written by the logic
controller to a portion of the data block being transferred.

BTW
(EN)BLOCK TRANSFER WRITE

Rack                                                  03
Group                                                  0
Module                                                0
Control Block                               N16:1
Data File                                        N7:0
Length                                               10
Continuous                                         N

➀   The PLC receives and stores data from
an input device, in this example a flow
sensor.

➁   The PLC ladder logic program initiates a
block transfer of a data block (10 words)
containing the display data.

Display variable with
Tag Name “Flow_Rate” from 
Address N7:5

➂   The MessageView terminal receives the data and
determines the starting address where the data is
written by matching the block size with the address
entered in the Communication Setup utility.

➄  The MessageView updates the Numeric Variable
Display using the data from the controller.

Flow Rate
Transducer

Data From
PLC

N7:5

10 WORDS
N7:0
N7:1
N7:2
N7:3
N7:4
N7:5
N7:6
N7:7
N7:8
N7:9

Flow Rate Data

➃   The MessageView now carries a copy of that
segment of the logic controllers data table.

Tag Name = Flow_Rate
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Example: Transferring Multiple Blocks

Multiple block transfers use a single channel (single Module Control
and Status Bytes defined). Each block transfer read or block transfer
write must be a unique length since the MessageView terminal uses
the block size to determine the starting location of the read or write.
The following is an example of a block transfer write of two blocks.

BTW
(EN)BLOCK TRANSFER WRITE

Rack                                                  03
Group                                                  0
Module                                                0
Control Bloc                                 N16:6
Data File                                    N90:10
Length                                               60
Continuous                                         N

➀   The PLC ladder logic program initiates
multiple block transfers of 2 data blocks
(7 words and 60 words).

➁  The MessageView terminal receives the first data
block and determines the starting address N7:0
where the data is written by matching the block size
with the address entered in the Communication Setup
utility.
The MessageView handles the second block in the
same manner.

Data From
PLC

N7:0
N7:1
N7:2
N7:3
N7:4
N7:5
N7:6
N7:7
N7:8
N7:9

➂   The MessageView carries a copy of the
logic controller data tables N7:0 to N7:6.

BTW
(EN)BLOCK TRANSFER WRITE

Rack                                                  03
Group                                                  0
Module                                                0
Control Block                               N16:1
Data File                                        N7:0
Length                                                 7
Continuous                                        N

Data From
PLC

➄  The MessageView display variables are updated 
using the new data.

Block 1 Transfer N90:8
N90:9
N90:10
N90:11

➃  The MessageView carries a copy of the
logic controller data tables N90:10 to N90:69.

Block 2 Transfer

. . .N90:12

N90:67
N90:68
N90:69
N90:70
N90:71

Note: If interfacing to an Allen-Bradley PLC2, single block transfer
is recommended.



 
Chapter   6

Publication 2706-817

����

� �
�	 ����
���
�
 �
���

This chapter covers the following topics:

• Starting MessageBuilder

• Creating a new application

• Opening an existing application

• Saving an application

• Renaming and describing an application

• Closing an application

• Exiting MessageBuilder.

MessageBuilder opens like any other Windows application.

To start MessageBuilder:

1. At the DOS prompt, type win and press ENTER.

2. Double-click the MessageBuilder group icon in the Program
Manager. Then double-click the MessageBuilder icon to open the
welcome screen showing copyright and release information.

Or use the Run command in the File menu of the Program
Manager, and type the path and file name.

User name
Company name

Starting MessageBuilder
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The MessageBuilder window opens, ready to display a new or
existing application file.

A MessageBuilder application is a unified set of messages with the
associated tags and devices. To create a new application, specify the
name of the application and its project.

1. Click the New File tool on the Standard Toolbar to open the New
Application dialog.

Or choose New from the File menu.

Communication ports and
protocols of the selected

Catalog and Version

Greyed until a valid
Project Name is entered

Terminal Type list box

       List box of available
Catalogs and Versions of

the selected Terminal Type

Note: When you select an MV Type option, its three catalog
numbers are displayed. When you highlight one of the Catalog and
Version options, its Ports are displayed.

Creating a New
Application
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2. In the Application Name box, enter a name up to 32 characters
long. This name cannot start with a number or contain spaces.

When MessageBuilder software saves the application, the default
file name is the first 8 characters of the application name, with the
extension .MBA. Page 6–6 explains how to save under a
different file name.

3. In the Project Name box, select or enter a name up to 32
characters long. This name cannot start with a number or contain
spaces.

The Project Name List box gives all existing project names.
Select one of these if the new application will use the same tag
definitions and devices as a previous application.

The Project Name links the application with a database of tag
definitions and device (terminal and controller) information.

!
ATTENTION:    If a project name must be changed in
MessageBuilder software, or a project deleted from the
software, DO NOT use a DOS or Windows command.
Use the Project Management command on the
Application menu.

4. Define the specific MessageView 421 terminal that will run the
application. If the terminal device with its catalog information is
not already associated with the project, add it now.

• In the Terminal Name box, select or enter a name (up to 32
characters long) for the terminal.

• In the Filter by MV Type  list box, select the correct
MessageView terminal type for the application.

• In the Catalog and Version list, highlight the catalog number
and firmware version (FRN x.xx) installed in the terminal.
Note: Make sure that the Catalog number and Firmware
Version selected matches the Catalog number and Firmware
Version of the terminal in which the application will reside.

• The Ports box displays the physical ports and protocol for the
selected terminal type. This box is read only.

5. If a description will be useful, select the Description button to
open another dialog. See Page 6–8.

6. Select the OK  button to begin creating the MessageBuilder
application.

☞ To copy, rename, or delete devices
from a project, see Page 9–1.

☞ For an existing terminal, the 
dialog displays defined terminal 
information.
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To reopen an application:

The bottom of the File menu lists up to four application files, the
ones that were opened most recently. To reopen one of them, simply
select it.

Note: The paths for files in the File menu are given if different from
the current directory. In the File menu illustrated at the left below,
one file (ACCT4.MBA) was opened from a floppy disk and saved to
the current directory.

Note:  Devices or tags in a reopened application may not match
those in its assigned project. See Page 9–8 for details on how to
reconcile the project with its application.

To open an application file that is not listed on the File menu:

1. Click the File Open tool on the Standard Toolbar to display the
File Open dialog .

Or choose Open from the File menu.

The File Name list box shows all MessageBuilder application
(MBA) files in the current drive and directory.

• To locate a file on another drive, select the drive name in the
Drives list box.

• To locate a file in another directory, use the scroll bars if
needed to locate the correct directory in the Directories list
box, or find it through its parent directory. Select the directory
name.

Opening an Existing
Application
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2. Double-click the name of a file in the File Name list box to select
and open the file.

• Or highlight the name and select OK.

• Or enter the path name and name of the file in the File Name box
and select OK .

Multiple applications open

MessageBuilder supports multiple open applications. Create new
application files or open existing files as needed. 

When you open a second application, it is cascaded over the first.
Use the commands on the Window menu to toggle between Cascade
and Tile. The active application in the Window menu is checked.

To activate a different open application, either:

• select it on the Window menu

• click on its title bar.

The application with its title bar highlighted is the active one. The
Edit Box, menu commands and tool icons apply only to the active
application.

This illustration shows tiled applications with the lower one active.
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If too many applications are open for available computer memory,
this dialog appears. Close some applications before opening any
more new ones.

The File menu provides two commands for saving an application:

• Use the Save command to save the application to the default
drive and directory, overwriting the previous version.

• Use the Save As command to save a revised application with a
new name so the previous version is not overwritten.

Important: It is good practice to save an application frequently.

The first time an application is saved, the Save As dialog opens so
the file can be named.

To save an existing application file:

• click the Save File tool on the Standard Toolbar

• choose Save from the File menu.

MessageBuilder replaces the previous version of the application on
disk with the new version.

To save a new or existing application with a new name: 

1. Choose Save As from the File menu to open the Save As dialog.

Saving an Application
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The first time an application is saved, its default name is the first
8 letters of the application name.

2. Accept the default or enter another name (1 to 8 characters long)
in the File Name box. MessageBuilder automatically adds the
.MBA filename extension to the name.

Note: You may save the file with another file type (filename
extension). However do not use .MVA, which is used for the
translated form that runs on a MessageView terminal.

3. If a file has already been saved to the name entered in the File
Name box, this dialog appears:

Select Yes to overwrite the file, and No to return to the File Save
As dialog.

4. To save the file to a different directory, select the directory name
in the Directories box. To save it to another drive, select a drive
name in the Drives box.

5. Select the OK  button.

The name under which you save the application becomes the
default for the next save (Save or Save As command).

Note: MessageBuilder tracks the date/time and version of an
application when it is saved. Choose Description from the
Application menu to see this information.

When an application has been edited but not saved, its name in the
title bar has an asterisk.
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Use the Description command on the Application menu to:

• enter an application description which can be included in a report

• view the version number of an application and when it was last
saved.

To open the Application Description dialog:

• choose Description from the Application menu

• select the Description button in the New Application dialog.

Note: The Application Name and Project Name do not appear when
the Description dialog is accessed from the New Application dialog.

I-Beam Pointer

Current Project Associated With Application

Version

Application Name

When the Application was Saved

This dialog gives the date and time of the last save, and the current
version. Each time an application file is edited and saved, the version
number is automatically incremented.

Renaming and Describing
an Application
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To enter or edit an application description:

Important:   The description is downloaded to the terminal with the
application, so it uses terminal memory.

1. Select the Description box and type the description. The text
automatically wraps.

To change the location of the insertion point in the Description
box, move the I-beam pointer or use the arrow keys. The insertion
point moves with the text when the scroll bar is used.

– To start a new line,  press CTRL+ENTER.

Note: ENTER alone closes the Description dialog.

– To delete text, drag pointer over the text to highlight it, then
press BACKSPACE or DELETE.

– To replace text, drag pointer over the text to highlight it, then
type the new text.

– To add text, position the cursor where you want to insert text
and then type the new text.

– Use any of the standard Window editing functions to edit text.

2. When done, select OK  to close the dialog.

To edit a description in a different application:

Change the application name in this dialog if you want to enter or
revise a description in a different application than the open one. This
change does not affect the open application.

1. Select the Application Name box. Highlight the text, then type a
new name.

2. Create or edit the dialog for this application file.

3. Select OK  to close the dialog.
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To close an application file:

• double-click the control-menu box on the Application dialog, or

• choose Close from the File menu.

If you made changes to the application since the last save,
MessageBuilder gives you the option of saving the file before
closing it.

When you exit MessageBuilder to the Windows desktop, all open
applications are closed.

Note: Always exit MessageBuilder software before turning off the
computer.

To quit MessageBuilder:

• double-click the Control-menu box on the MessageBuilder
window, or

• choose Exit from the File menu.

If any applications are open and unmodified, they are closed
automatically.

If any or all were modified since the last save, a dialog for each
application asks if it should be saved before closing.

Select Yes to save the application and exit, No to exit without saving,
and Cancel to return to MessageBuilder.

Closing an Application

Exiting MessageBuilder
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This chapter covers the following topics:

• The Message Editor dialog

• Working with messages

• Selecting messages

• Editing messages

• Set Preferences

• Message Editor Terminal View

• Embedded variables and graphics

• Numeric variable display

• ASCII variable display

• Numeric variable entry

• ASCII variable entry

• Message attributes

• Slaving

• Function keys

• LED attributes

• Special Messages.

When a new or existing application is opened, the Message Editor
Table View appears. It is the main window for application design. 

Project Name Application File Name

Menu Bar

Standard Toolbar

Message List

Status Bar

Message Edit Box

Message Edit Toolbar

Attribute Controls

The Message Editor Dialog
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In the Message Editor Table View you can:

• create and revise individual messages

• enter and revise attributes for each message

• work with many commands and tools which are available only
when an application is open.

The Message List at the bottom of the Message Editor Table View
lists all messages in the application. 

• The Number column displays the Message number, which is used
as the Value Trigger.

• The Topic column displays the message subgroup to which the
message is assigned.

• The Message Text column displays the text and placeholders that
make up the message text.

Each message in an application is created and edited individually.

To create a new message:

MessageBuilder software has four ways to create a message and add
it to the Message List.

To append a message at the end of the Message List:

• click the Append Message tool on the Message Edit Toolbar

• select New Message in the Edit menu.

To insert a message above the currently highlighted message:

• click the Insert Message tool on the Message Edit Toolbar

• select Insert Message in the Edit menu.

Each new message is highlighted in the Message List, and is
displayed in the Message Edit box. It has default text of “Message
#X”, where X is its Message Number.

To delete a message:

Highlight the message in the Message List, then:

• click the Delete Message tool

• press ALT  + DEL

• select Delete Message on the Edit menu.

To restore a deleted message:

• click the Undo tool

• press CTRL + Z

• select Undo on the Edit menu.

Working with Messages
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When a message is selected in the Message List, the message text
appears in the Message Edit box, and its attributes are displayed in
the Attribute Controls section of the Message Editor Table View.

Selecting a message for editing

Select (highlight) a message in the Message List:

• manually

• by using the Find command in the Edit menu.

Important:  The attribute box labelled Message changes the
message number of the selected message. It does not
select a message in the Message List.

To select a message manually:

If the message is visible, highlight it. A highlighted message is
selected and its message text appears automatically in the Message
Edit box. To highlight (select) a message:

• click on the message

• select the Message List and use the up or down arrow keys.

Note: Double-click a message to highlight the message’s text in the
Message Edit box.

If the message is not visible, select the Message List and scroll it up
or down through the list until the message is visible, using:

• arrow keys

• Page Up or Page Down keys

• the vertical scroll bar.

The Message List vertical scroll bar appears when there are more
messages than the application window can display at once.

Note: Make the Application window wider if necessary to display
this scroll bar.

Selecting Messages
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To select a message using the Find command:

1. Press CTRL  + F to open the Find Message dialog box.

Or select the Find command in the Edit menu.

2. Under Search select Up or Down for the direction of search.

3. To specify the type of search, select one of the options under the
Search For command. The Find ... box changes its title to suit
the option.

4. Enter text or a value in the Find ... box as follows:

• Text – in the Find Text box, type a text string, which can be any
part of a message’s text. Include spaces and punctuation.
Variables and graphics cannot be part of the search.

Note: The Match Case option is active only when Text is
selected. Select it if capitalization is important in the search
string; otherwise Search is not case-sensitive.

• Message Number – in the Find Message Number spin control:

– type the message number
– use the spin control to display the desired number.

• Bit Trigger Bit  – in the Find Bit Trigger Bit  spin control: 

– type the number of the bit trigger for the message
– use the spin control to display the desired number.

• Topic – in the Find Topic list box, select the list box and
highlight the correct topic. 

Note: Search For Topic locates messages scattered through the
application. If you want to edit all messages assigned to a topic,
they can be brought together in the Message List by Sorting.
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5. Select the Find Next button.

When a match is found, the matching message is highlighted in
the Message List and appears in the Message Edit box.

If a match is not found by the bottom (top) of the list, the Find
function wraps to continue the search through the rest of the list.

If there is no match, a dialog appears:

6. Select the Find Next button again to locate the next message that
meets the search criteria. The Find Message dialog remains open
until Close is selected.

7. Select the Close button to return to the Message Editor Table
View at the last found message.

To edit a message, select it by highlighting it in the Message List.
The selected message’s text appears in the Message Edit box. A
vertical bar appears at the insertion point.

Message Edit BoxMessage Edit Bar

Insertion point

To highlight text in the Message Edit box:

• in the Message List, double-click on the message to highlight the
whole message in the Message Edit box

• in the Message Edit box, click and drag to highlight all or part of
a message

• in the Message Edit box, double-click to highlight the word or
placeholder under the cursor

• in the Message Edit box, hold down the SHIFT  key and use the
left or right arrow keys to highlight all or part of the message.

Editing Messages
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Creating a text string

To add or insert text in a message:

1. Click in the Message Edit box where the text is to go.

Or select the Message Edit box and move the insertion pointer
using the left/right arrow keys or the Home/End keys.

2. Start typing.

Important:  Highlighted text is overwritten.

Accented characters

Characters that do not appear on the computer keyboard, such as
accented characters used in European languages, may be added to
any MessageBuilder message. These characters and their ASCII
numbers are given in the ASCII tables in Appendix I.

When ASCII and Extended ASCII characters are added to
MessageBuilder messages, they are treated as text characters. See
Page 7–21 for a discussion of ASCII Control characters.

To use ASCII characters in a message:

1. Set the insertion pointer in the Message Edit box where the
ASCII character is to go.

2. Look up the ASCII character on Page I–2 or I–3, and note
decimal number.

The range of valid ASCII and Extended ASCII characters is 032
to 0255. Characters numbered 0 to 31 are reserved for control
characters.

3. Press ALT + #, where # is the decimal representation of the
character preceded by a zero. For instance:

• 065 represents the letter A.

• 055 represents the number 7.

• 0160 represents the accented character á.

• 0248 represents the degree sign °.

The character appears in the Message Edit box at the insertion point.
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To cut a text string:

1. Set the insertion pointer in the Message Edit box at the start or
end of the text to be cut.

2. Drag the mouse pointer over the text to highlight it.

Or hold down the SHIFT  key and use the left or right arrow keys.

3. Click the Cut tool.

• Or press CTRL  + X.

• Or select Cut from the Edit menu.

The selected text is removed and is copied to the Windows clipboard.
It may be Pasted to the same or another message.

To copy a text string:

1. Set the insertion pointer in the Message Edit box at the start or
end of the text to be copied.

2. Drag the mouse pointer over the text to highlight it.

Or hold down the SHIFT  key and use the left or right arrow keys.

3. Click the Copy tool.

• Or press CTRL  + C.

• Or select Copy from the Edit menu.

The selected text remains highlighted and is copied to the Windows
clipboard. It may be Pasted to the same or another message.

Note: If it is to be pasted in the same message, move the insertion
pointer to remove the highlighting.

To paste a text string:

1. Cut or copy the text string to the Windows clipboard.

2. If necessary, use the Find command or scroll bar to bring up the
destination message in the Message Edit box.

3. Set the insertion pointer in the Message Edit box.

4. Click the Paste tool.

• Or press CTRL  + V.

• Or select Paste from the Edit menu.

Note: A text string may be pasted repeatedly. Any cut or copied text
string remains on the clipboard until:

• some other text string is cut or copied

• Microsoft Windows is closed.

Note: Text can be copied to or from another Windows application
using these techniques.
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Important:  When a text string is Copied, Cut and Pasted, or
Replaced, any embedded variables or graphics are lost
in transit. They must be recreated using the Embedded
Variable tool or commands. However, see the next
section to copy a message and its attributes.

Copying and Pasting a message with its variables and attributes:

1. Select the source message in the Message List.

2. Click the Copy tool to copy the message, including its text,
embedded variables and attributes, to the Windows Clipboard.

Or select Copy from the Edit menu.

Important:  Make sure that the insertion pointer is not in the
Message Edit box, and that text in the Message Edit box
is not selected.

If text is highlighted in the Message Edit box and then
copied, the Message Paste dialog will have just the Text
Only option active. In other words, if you highlight and
copy part or all of the message in the Message Edit box,
the text is pasted into the destination message, but its
variables and attributes are not.

3. Create a destination message, see Page 7–2.

Or highlight an existing message in the Message List, which will
be replaced by the copied message.

Important:  Make sure that the insertion pointer is not in the
Message Edit box, and that text in the Message Edit box
is not selected.

When the insertion pointer is in the Message Edit box,
the Paste command simply copies the text string into
the destination message. The Message Paste dialog does
not appear.

4. Click the Paste tool, and the Message Paste dialog appears. 

Or select Paste from the Edit menu.
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The dialog displays the destination message number and the text
string copied in the Windows clipboard.

5. Select one of these options:

Option: Message Text:
Embedded
Variables:

Attributes:

Text Only Copied n/a n/a

Text with Embedded
Variables

Copied Copied n/a

Attributes Only n/a n/a Copied

All Copied Copied Copied

6. Select OK to implement the choice.

Replacing a text string in a message or messages

1. Press CTRL  + H to bring up the Replace dialog.

Or select Replace in the Edit menu.

2. Enter the Find Text string and the Replace Text string.

Find Text and Replace Text can not include graphics or
variables. However they may have spaces and punctuation.

3. Select the Match Case check box if capitalization is important in
the Find Text string.

4. Select one of the Search radio buttons to choose whether the
search should go up or down through the Message List.

5. Select Find Next and then for each message found, decide
whether to replace the text string.

Or select Replace All and the text string is replaced automatically
in every message where it occurs.
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Storing changes to the current message

To store changes to a message, do one of the following:

• Click the Store Message tool to store and update the edited
message and its attributes into the highlighted message in the
Message List.

• Highlight a different message in the Message List. Before a new
message appears in the Message Edit box, changes to the
previous message are stored.

To cancel all changes in the current message:

Click the Cancel Changes tool to return the message in the Message
Edit box to the last time it was stored. Changes include additions,
deletions or edits to attributes, embedded variables and text.

Undoing and Redoing editing changes

Undo reverses all editing changes, including changes in the
message’s attributes, to the currently selected message. It can even
restore a deleted message.

To Undo changes:

• Click on the Undo tool.

• Or press CTRL  + Z.

• Or select Undo on the Edit menu.

Until the message has been stored once, the Undo tool or command
is greyed out. After it has been stored, additions or cuts to the
message are reversed one at a time until the Undo tool or command
is greyed out again.

Redo reverses the effects of an Undo, restoring the editing and
attribute changes to the message.

To Redo the changes:

• Click on the Redo tool.

• Or press CTRL  + Y.

• Or select Redo on the Edit menu.

The message’s Undo changes are restored, one item at a time, until
the Redo tool or command is greyed out again. Even if another
message is highlighted, the last message that had changes undone is
returned to the Message Edit box.
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Sorting messages

1. Select Sort on the Edit menu to open the Sort Messages dialog.

2. To specify which attribute of the messages in the Message List to
sort on, select one of the radio buttons under the Sort On
command.

• Message Number arranges messages in numerical order.

Each message keeps its own message number in a Sort, so you
can restore the original list by Sorting on Message Number.

• Trigger  arranges messages in order of the address of  their bit
triggers. Messages without bit triggers appear first in the list in
their original order.

• Text arranges messages in order by the initial item. Priority goes
in order to:

– a variable
– a space
– a number
– a letter.

• Topic places messages with the same topic together.

Note: If you want messages to be sorted within the topic, do a
preliminary Sort on the other attribute(s) before sorting on Topic.

3. Select Master List to retain this sort as a default when the
application is closed and reopened.

If Master List is not enabled, the Sort is used temporarily while
editing. In fact, a number of Table Views can be displayed at the
same time with different sort orders for their Message Lists.

4. Select OK  to perform the Sort. Messages are rearranged in the
Message List according to the option chosen.
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Renumbering messages

!
ATTENTION:    When you renumber a message or
messages, recheck chained messages. They must be
edited if they refer to a number that was changed.

Message numbers may be changed in two ways.

• To change the number of a message, select the Message attribute.

Use the up/down arrow to display a new number for the
highlighted message, or enter a value in the spin control, then
click the Store Message tool.

• To change the numbers of all messages in the Message List, select
Renumber on the Edit menu to bring up a dialog:

In the Renumber Messages dialog:

1. Type the number the Message List should start with.

Or use the spin control to display the correct number.

2. Select OK to return to the Message Editor Table View.

All messages in the Message List are renumbered in order following
the initial number.

Note: This command simply renumbers messages, it does not change
their order in the Message List. However it may be used after a Sort
command to get the numbers back in sequence.

Topic

The Topic attribute allows messages in an application to be
organized or grouped by subject matter or function.

Use the Topic list box to assign a topic to each message; default is
Topic 1. Assign all messages concerned with one aspect of the
application to the same topic. 

You can Sort messages by topic. See the Sort option on Page 7–11.
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To rename topics:

Rename any or all topics used in the application. The new text can
have up to 12 ASCII characters, including spaces.

1. Select Topics on the Edit menu to open the Topics to View dialog:

2. Select a text box and type an informative Topic name.

3. Repeat for every topic used in the application if desired.

4. Select OK  to confirm the changes.

Every message that is assigned to a named topic will have that name
shown in its Topic column in the Message List. In addition, the
Topic dropdown list now has the new topic names.

To view only messages with the same Topic:

Messages assigned to the same topic may be scattered through the
Message List. You can filter messages so the Message List displays
only certain selected topics, to make editing more convenient.

1. Select Topics on the Edit menu to open the Topics to View dialog.

2. Deselect the check boxes beside topics that you don’t want in the
Message List at the moment.

3. Select OK . The Message List now displays only messages
assigned to the selected topic(s).

4. Select all the check boxes to return to the original Message List.

Validating messages

MessageBuilder software validates applications and messages so that
all attributes, variables, tags and devices are compatible with one
another. Appendix D contains a list of Validation error messages.

• MessageBuilder software automatically validates all applications
before they are downloaded.

• You may validate an application at any time by selecting Validate
on the Application menu. 

• You can also set up MessageBuilder to validate each message
individually when it is stored or updated. See Page 7–15.
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Note: Whenever you use the Paste command MessageBuilder
validates the message, to make sure the destination terminal can
support all its attributes. For instance, if you try to paste a message
containing the Enable Slave attribute into an application intended to
run on a terminal whose firmware cannot support Slave Port, you
will be unable to do so.

Error messages

If an error or warning message appears while you are:

• creating or editing an application, see Appendix C.

• validating an application, see Appendix D.

• uploading or downloading an application, see Appendix E.

These appendices list the error messages and what to do for each
one.

When you set preferences, they remain as you set them even when
the computer is shut down and restarted. Preferences include:

• validate individual messages

• change the colors that distinguish Flash text and Embedded
characters in the Message Edit box.

To set preferences:

1. Select Preferences on the Application menu.

2. Select one of the options on the Preferences submenu.

3. Configure the option.

4. Select OK  to return to the Message Editor Table View.

Message Options

This option allows you to decide whether MessageBuilder software
should validate each message as it is created and stored. Select
Message Options to display the Application Preferences dialog:

Enable or disable the Automatic Message Validation option by
clicking in the check box.

Default is to disable this option.

Set Preferences
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Colors

Flashing Text defaults to blue in the Message Edit box, and
Embedded Text to red. Embedded text includes variables and
graphics. Inverse Video appears with black and white inverted, so it
does not need a special color to emphasize it.

When you select this option, the Color Selection box is displayed:

1. Select the type of text whose color you would like to change.

2. Select the Edit Color button. The Color dialog appears with the
current color selected.

Selected color

3. If you prefer to create a custom color, select the Define Custom
Colors button, and a color mixing dialog appears:
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4. Experiment by selecting values in the boxes, or by moving the
cursor about in the color panel.

5. When the current color suits you, select the Add to Custom
Color button, and the color appears in the first Custom Color
square on the other side of the dialog. Repeat as often as you like.

Note: The original color remains selected until you change it.

6. Select the basic or custom color you prefer, and press OK  to
return to the Message Editor Table View.

7. If you later decide the default color was better, call up the Color
Selection dialog and select the Restore Defaults button.

It is useful to see how a message will look on the terminal display.
To open the Terminal View:

• click the Terminal View tool

• select Terminal View on the Window menu.

Note: The application is designed for a particular type of terminal.
The Terminal View shows the front face of that terminal type.

Message Editor Terminal
View
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The Terminal View displays the active (highlighted) message. If the
Terminal View is the active window, when a message is being edited
in the Message Edit box, the changes appear in the Terminal View
display. (An active window has its Title Bar highlighted.)

• Text appears as entered, in its correct display mode size.

• Variables are represented by placeholders (see the table on Page
7–18).

• Graphics appear as they will appear on the terminal display.

• Scrolling is not supported in the Terminal View, but Flash and
Inverse Video appear as they will on the terminal display.

Note: If the message is longer than the Terminal View can display,
scroll through the message in the Message Edit box to see the
remainder of the message. When the Terminal View is the active
window, its display will follow the insertion point in the Message
Edit box. That is, it will scroll through the message up to the cursor
point.

To return to the Message Editor Table View, select:

• The Table View tool.

• The Table View command in the Window menu.

• At the bottom of the Window menu is a list of open windows.
Two of them have the same name. The name that is checked
represents the active Terminal View, so the Table View is
represented by the name that is not checked (inactive). Select it to
activate the Table View.

Zoom

The Terminal View can be resized in one of two ways:

• Click on one of the Zoom tools.

The Zoom In [+] and Zoom Out [-] tools may be clicked up to
four times. When the display reaches the maximum or minimum
size, the tool you have used becomes inactive and is greyed out.

• Or select the Zoom command on the View menu to open a dialog:

Select a Zoom To percentage increase over the basic size. Select
OK , and the Terminal View is resized.
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Variables of several kinds, and graphics, may be embedded in a
message. Specifics and limitations of each type are given in Chapter
4; see page references in each section below.

When the insertion pointer is in the Message Edit box, open the
Format menu or click the Embedded Variables tool to display a list
of the types of variables, graphics and ASCII Control Characters.

This table represents the available Embedded Variables and
Graphics.

Variable Placeholder
Maximum

Field
Length

Decimal
Point

Tags Tag Format
Displayed by
Slave Device?

Time Sample time 10 n/a None n/a Yes

Date Sample date 10 n/a None n/a Yes

Numeric Variable
Display

# 12
Fixed/
Floating

Read
Signed or Unsigned
Integer, BCD
Scaled if required

Yes

ASCII Variable
Display

A 32 n/a Read Character Array Yes

Numeric Variable
Entry

^ 12
Fixed/
Keyboard
Controlled

Write

Optional:
Notification and
Handshake

Signed or Unsigned
Integer, BCD
Scaled if required

Bit
Bit

No

ASCII Variable
Entry

E 32 n/a

Write
Optional:
Notification and
Handshake

Character Array

Bit
Bit

No

ASCII Control
Character

~ n/a n/a None n/a No

Graphics Gr n/a n/a None n/a
Only if Ctrl-G is
inserted before
Gr

Placeholders

The number of symbols in the placeholder for a variable represents
the field width specified in its dialog.

Placeholders for all the variables in this table are displayed in the
Message Edit box in a different color from the rest of the text. You
can change this color using the Preferences dialog. See Page 7–15.

A placeholder may be removed using the Backspace key or the Cut
tool or command. It can be pasted only when the entire message is
copied and pasted as described on Page 7–8.

Embedded Variables and
Graphics
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Adding Time or Date to a message

Time and Date displays may be included in messages, but not more
than one of each per message. 

To add either time or date to a message:

1. Set the insertion pointer  in the Message Edit box where the time
or date display should be placed.

2. Click on the Embedded Variable tool to display a menu of
choices.

Or select the Format menu to display a similar menu.

3. Select Time Display or Date Display.

A placeholder for Time or Date is added to the message at the
insertion point. The placeholder value is an arbitrary time or date
which does not change.

When a message containing a Time or Date variable is displayed by
a MessageView terminal, the terminal continually updates the Time
or Date variable according to its Real Time Clock.

You can change the format in which time or date are displayed on the
terminal. Use the Time/Date tab on the Terminal Setup dialog, see
Page 10–18.

Note: A Time or Date placeholder may be removed using the
Backspace key or the Cut tool or command. It can be pasted only
when the entire message is copied and pasted as described on Page
7–8.

Slave devices

Slave devices support the display of Time and Date variables in
messages. The time and date are updated while the slave message is
actively displayed.
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Adding graphics to a message

A set of 32 ISA bitmap graphics is supplied with MessageBuilder
software. They illustrate components commonly used in
manufacturing. See Page B–6 for the list of ISA symbols.

Graphics may be embedded in a message. Each graphic occupies an
area 24 x 16 pixels: the area required by two half display mode
characters. Since a message has a maximum of 100 characters, it can
theoretically have up to 50 graphics symbols. Graphics cannot be
resized.

Note: Graphics may be embedded only in half text size display
mode messages. If they are used in quarter or full text size display
mode messages, the application will not pass Validation.

To add a graphic to a message:

1. Set the insertion pointer in the Message Edit box where the
graphic should be placed.

2. Click on the Embedded Variable tool to display a menu of
choices.

Or select the Format menu to display a similar menu.

3. Select Graphic to display the Select Graphic dialog which
illustrates and names all 32 ISA symbols:

4. Use the scroll bar if necessary to display the required graphic
symbol.

5. Double-click on the symbol.

Or highlight the symbol and select OK.

A placeholder, Gr, is added to the message at the insertion point.

Note: A Graphic placeholder may be removed using the Backspace
key or the Cut tool or command. It can be pasted only when the
entire message is copied and pasted as described on Page 7–8.
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Slave devices

Slave devices support and display graphics embedded in messages
only if a Ctrl-G is inserted before each graphic. If this control
character is not inserted, the terminal replaces the graphic with two
spaces before sending the message to the slave.

Adding ASCII Control Characters to a message 

This option is used to embed ASCII control characters in a message.
ASCII control characters are used to embed Control Mode and
Display Mode Control Bytes in a message to be slaved. Slaving is
discussed in the section starting on Page 7–41.

Important: This option is not used to embed ASCII and Extended
ASCII characters, which include the accented
characters used in European languages. See Page 7–6.

To add an ASCII Control Character to a message:

1. Set the insertion pointer in the Message Edit box where the
Control Character should be placed.

2. Click on the Embedded Variable tool to display a menu of
choices.

Or select the Format menu to display a similar menu.

3. Select ASCII Char to display the ASCII Characters dialog:

4. Select the number corresponding to the ASCII character you
want.

See the ASCII Table on Page I–2. ASCII characters with decimal
numbers 0 to 31 are reserved for control characters.

5. Select OK.

A placeholder, ~, is added to the message at the insertion point.

Note: ASCII characters with numbers 0 to 31 are reserved for
control characters. If #32 or higher is selected in this dialog, it will
be represented in the Message Edit box by a placeholder, even
though that number does not represent a control character.
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Note: An ASCII Control Character placeholder may be removed
using the Backspace key or the Cut tool or command. It can be
pasted only when the entire message is copied and pasted as
described on Page 7–8.

Adding numeric and ASCII variables to a message

A message may contain embedded numeric and ASCII variables.
They may be:

• display variables that display values in the logic controller

• entry variables that allow the terminal operator to enter values at
the terminal via:

– the front panel keypad
– an ASCII Input device.

A message may have up to 10 display/entry variables, provided the
total message length is not over 100 characters.

To add a variable to a message:

1. Set the insertion pointer in the Message Edit box where the
variable should be placed.

2. Click on the Embedded Variable tool to display a menu of
choices.

Or select the Format menu to display a similar menu.

3. Select the name of the variable type to display its dialog box.

Each type of variable has its own dialog box. They are discussed
in detail in the next few pages.

4. Edit the attributes for the variable.

5. Select OK.

A placeholder is added to the message at the insertion pointer:

• # for Numeric Display variables

• A for ASCII Display variables

• ^ for Numeric Entry variables

• E for ASCII Entry variables.

The number of symbols in the placeholder for each entry and display
variable represents the field width specified in its dialog.

Note: A Variable placeholder may  be removed using the Backspace
key or the Cut tool or command. It can be pasted only when the
entire message is copied and pasted as described on Page 7–8.
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To edit a variable:

1. Double-click on the placeholder to select the variable.

Or click and drag the mouse pointer over the placeholder.

Or hold down the SHIFT  key and use the left or right arrow keys.

2. Click on the Embedded Variable tool to display the dialog for the
selected variable type.

Or select the Edit Variable command on the Format menu.

3. Revise as necessary.

4. Select OK.

A Numeric Variable Display provides a numeric readout of a value
stored at a controller tag address. 

To create the variable, set the insertion pointer in the Message Edit
box where the variable should be placed.

• Click the Embedded Variable tool on the Message Edit toolbar
and select Numeric Variable Display on the dialog.

• Or select the Numeric Variable Display command on the Format
menu.

To edit the variable, highlight the variable placeholder in the
message.

• Click the Embedded Variable tool.

• Or select the Edit Variable command on the Format menu.

When a variable is created or edited, its dialog appears:

Numeric Variable Display
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Digits

The Field Width spin control specifies the maximum number of
characters (0 to 9, +, -, and .) that can appear in the display. If the
value from the logic controller exceeds the specified field width, the
field on the terminal display fills with >>> symbols. 

Default is 12. To change the field width, select or enter a value in the
spin control.

To fill empty data positions with zeros rather than leaving them
blank, enable the Fill With Zeros  check box. Default is disabled.

00065932

65,932

8 Digit Field Width
Zero Fill

8 Digit Field Width
No Zero Fill

Value to Display

65932

Decimal Point

A logic controller can store only integer values, so the value sent to a
display variable is always an integer. However if the value is scaled,
it may be displayed as a decimal. See the section on scaling
beginning on Page 4–37. 

The Decimal Point area specifies whether a scaled value displays
with a fixed or floating point decimal.

Value from Controller

32767 x (.0001) +94 =

SCALE
Scale = .0001
Offset = 94

Displayed Value = 97.2767

= 32767

• Select Fixed Point to position the decimal point 0 to 4 places to
the left of the rightmost character. Select or enter the number of
decimal places in the Position spin control. The decimal position
must be less than the field width.

Select:
For This
Position:

0 97

1 97.2

2 97.27

3 97.276

4 97.2767

• Select Floating Point to have the terminal position the decimal.
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Read Tag

The Read Tag specifies the name of the tag address from which the
terminal  will read the display data. Select a tag from the Read Tag
list box or type in a new Read Tag name. Valid data types for the
read tag are unsigned/signed integer or BCD.

Note: It is easier to create an application if all its tags are entered in
the Tag Editor before you start to write messages. If a new Read Tag
name is used, its parameters must be edited when it is assigned.

If the variable will be scaled, needs different data limits, or has a new
Read Tag assigned:

1. Put the insertion pointer in the Read Tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog.

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

Slave devices

Slave devices support the display of Numeric Display variables in
messages. They are updated while the slave message is actively
displayed.

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.
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An ASCII Variable Display provides an alphanumeric readout of a
ASCII text string stored at a controller tag address. 

To create the variable, set the insertion pointer in the Message Edit
box where the variable should be placed.

• Click the Embedded Variable tool on the Message Edit toolbar
and select ASCII Variable Display on the dialog.

• Or select the ASCII Variable Display command on the Format
menu.

To edit the variable, highlight the variable placeholder in the
message.

• Click the Embedded Variable tool.

• Or select the Edit Variable command on the Format menu.

When a variable is created or edited, its dialog appears:

Characters

The Field Width spin control specifies the maximum number of
alphanumeric characters that can be entered in the variable.

Note: The message will not pass Validation if the Field Width is
greater than the Read Tag’s Character Array value.

Default is 32. To change the field width, select or enter a value in the
spin control.

Read Tag

The Read Tag specifies the name of the tag address from which the
terminal  will read the display data. Select a tag from the Read Tag
list box, or type in a new Read Tag name. The only valid data type
for the read tag is Character Array.

Note: It is easier to create an application if all its tags are entered in
the Tag Editor before you start to write messages. If a new Read Tag
name is used, its parameters must be edited when it is assigned.

ASCII Variable Display
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If the Read Tag is new, or its parameters need to be edited:

1. Put the insertion pointer in the Read Tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog.

3. Edit the tag’s attributes (see the section starting on Page 8–2).

Note: Character Array size must be between 1 and 32.

4. Select OK .

Slave devices

Slave devices support the display of ASCII Display variables in
messages. They are updated while the slave message is actively
displayed.

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.

A Numeric Variable Entry allows the terminal operator to change or
enter a value stored at a controller address. It may be used for this
purpose in any application designed for a MessageView 421N or
421F terminal. 

In addition, this variable may be used with an ASCII Input device
when the input is in numeric form. It may be used for this purpose in
an application designed for a terminal that has both a daughterboard
(Catalog No. 2706-M1D1, -M1N1 or -M1F1) and firmware that can
support ASCII Input.

To create the variable, set the insertion pointer in the Message Edit
box where the variable will be placed.

• Click the Embedded Variable tool on the Message Edit toolbar
and select Numeric Variable Entry on the dialog.

• Or select the Numeric Variable Entry command on the Format
menu.

Numeric Variable Entry
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To edit the variable, highlight the variable placeholder in the
message.

• Click the Embedded Variable tool.

• Or select the Edit Variable command on the Format menu.

When a variable is created or edited, its dialog appears:

Format

The Field Width spin control specifies the maximum number of
characters (0 to 9, +, -, and .) that can be entered in the variable.

Default is 12. To change the field width, select or enter a value in the
spin control.

Decimal Point

A logic controller can store only integer values. If the entered value
is a decimal, it will be rounded by the logic controller. However if
the value is scaled, it may be entered as a decimal, but stored as an
integer. See the section on entry scaling beginning on Page 4–38.

The Decimal Point area specifies whether the decimal point is fixed
(formatted), or keypad controlled. 

• Select Fixed to position the decimal point 0 to 4 places to the left
of the rightmost character. As the terminal operator enters the
value the numbers are shifted to the left around the decimal point.

Select or enter a value in the Position spin control. The decimal
position must be less than the field width.

Select:
For This
Position:

0 6

1 6.5

2 6.55

3 6.553

4 6.5535



7–29Creating Messages

Publication 2706-817

• Select Keypad Controlled to allow the operator to enter the
decimal point using the keypad.

Tags

The Write Tag list box specifies the name of the tag address to
which the terminal  will write  the entered data. Select a tag from the
Write Tag list box, or enter a new tag name. Valid data types for the
write tag are unsigned/signed integer or BCD.

The Notification Tag list box specifies the name of the tag address
where the terminal sets a bit to 1 when a value is sent to the logic
controller.

Handshake Tag list box specifies the name of the tag address where
the controller sets a bit to 1 when a notification has been received.

Select these tags from their tag list boxes or type in new tag names.
The only valid data type for either Notification or Handshake tag is
bit.

Note: Use both Notification and Handshake Tag, or neither. See the
section on handshaking on Page 4–26. If only one tag is entered, the
application will not pass Validation.

Note: It is easier to create an application if all its tags are entered in
the Tag Editor before you start to write messages. If a new Read Tag
name is used, its parameters must be edited when it is assigned.

If the variable will be scaled, needs different data limits, or has a new
Read Tag assigned:

1. Put the insertion pointer in the Read Tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .
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Slave devices

Slave devices do not support the display of Numeric Entry variables
in messages. Numeric Entry variables are removed from a message
by the master MessageView terminal before the message is slaved.

Although slave devices do not display Numeric Entry variables in a
message, the master terminal does display them whenever it displays
the message.

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.

An ASCII Variable Entry allows the terminal operator to change to
change or enter a value stored at a controller address. This variable
may be used in an application designed for a terminal that has both a
daughterboard (Catalog No. 2706-M1D1, -M1N1 or -M1F1) and
firmware that can support an ASCII Input device.

An ASCII Variable Entry allows the entry of:

• numeric values from the front keypad

• alphanumeric characters from an ASCII Input device; input
devices are listed on Page 5–6.

If the ASCII Entry variable is defined as:

• an integer (signed or unsigned) the entered data is displayed in
numeric format. It may be scaled like data in a Numeric Entry
variable.

• a character array, the entered data is displayed in alphanumeric
format. It cannot be scaled.

To create the variable, set the insertion pointer in the Message Edit
box where the variable should be placed.

• Click the Embedded Variable tool on the Message Edit toolbar
and select Numeric Variable Entry on the dialog.

• Or select the ASCII Variable Entry command on the Format
menu.

To edit the variable, highlight the variable placeholder in the
message.

• Click the Embedded Variable tool.

• Or select the Edit Variable command on the Format menu.

ASCII Variable Entry
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When a variable is created or edited, its dialog appears:

Format

The Field Width spin control specifies the maximum number of
alphanumeric characters that can be entered in the variable.

Note: The message will not pass Validation if the Field Width is
greater than the Write Tag’s Character Array value.

Default is 32. To change the field width (range 1 to 32), select or
enter a value in the spin control.

Note: If the input device sends more characters than fit in the Field
Width, the extra characters are ignored.

Tags

The Write Tag list box specifies the name of the tag address to
which the terminal  will write  the entered data. Select a tag from the
Write Tag list box or enter a new Write Tag name. The only valid
data type is Character Array.

The Notification Tag list box specifies the name of the tag address
where the terminal sets a bit to 1 when a value is sent to the logic
controller.

Handshake Tag list box specifies the name of the tag address where
the controller sets a bit to 1 when a notification has been received.

Select these tags from their tag list boxes or enter new tag names.
The only valid data type for either Notification or Handshake tag is
bit.

Note: Use both Notification and Handshake Tag, or neither. See the
section on handshaking on Page 4–26. If only one tag is entered, the
application will not pass Validation.

Note: It is easier to create an application if all its tags are entered in
the Tag Editor before you start to write messages. If a new tag name
is used, its parameters must be edited when it is assigned.
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If the tags are new, or if a tag needs to have its parameters edited:

1. Put the insertion pointer in the tag to be edited.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2)

Note: Character array tags must have length in the range 2 to 33.

4. Select OK .

Slave devices

Slave devices do not support the display of ASCII Entry variables in
messages. ASCII Entry variables are removed from a message by the
master MessageView terminal before the message is slaved.

Although slave devices do not display ASCII Entry variables in a
message, the master terminal does display them whenever it displays
the message.

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.



7–33Creating Messages

Publication 2706-817

The message’s attributes appear in the Attributes section of the
Message Editor Table View. 

Attributes

Attributes for each message may be set using the Message Editor
Table View:

• at the time the message is created

• at any later time when the message is selected (highlighted) in the
Message List and displayed in the Message Edit box.

Click the Store Message tool to store the current text and attribute
settings for the selected message. 

Note: A message is stored automatically when another message is
selected for editing.

Click the Cancel Changes tool to restore the message as it was before
editing. All changes, whether adding, deleting or editing attributes,
revert to their condition when the message was last stored. 

To edit related messages together, use the Topics command on the
Edit menu. See Page 7–12. In the Topics dialog, deselect all topics
but the one(s) needed at the moment. The Message List now contains
only messages assigned to the selected topic(s).

To view the original Message List, simply bring up the Topics dialog
and select all the topics.

Message Attributes
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Message

Use the Message spin control to assign a new number to the
currently selected message. This attribute does not change the
position of the message in the list.

Important:  The message number is often used as a trigger. If a
message number is changed, verify that another
message does not chain to the old message number.

To change the order of messages in the list but not their numbers, use
the Sort command on the Edit menu. See Page 7–11.

Text Size and Line Number

Select one of the available text sizes from the Text Size list box or
from the Text Size menu that opens from the Format menu. Options
are Quarter, Half, and Full.

Select an option from the Line list box. Options are 1, 2, 3, 4, All
and Any. Default is Quarter Display mode and Line 1. 

This table gives the available options depending on which text size is
selected. If a message is assigned to a line too close to the bottom of
the display for its size, the error will be caught when the application
is validated.

Text Size Occupies: Characters: Starting Line

Quarter 1 display line 21 1, 2, 3, 4, All, Any

Half 2 display lines 10 1, 2, 3, All, Any

Full all 4 display lines 7 1

Select All  to use the whole display for the message. This may be
useful for complex messages.

After it is triggered, a message with Starting Line All must wait
until:

• all lines on the display are available, or

• Special message 9901, Clear Display, is triggered.

Select Any to display the message on the first available line starting
from the top of the display.

Note: Graphics may be used only in Half Text Display mode
messages. Each graphic is as wide as two characters. If graphics are
used in a Quarter or Full Display mode message, the application will
not pass Validation.
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Example of priorities in displaying a message: 

 The terminal display has a quarter display mode message on Line 2.
A half display mode message is value triggered. If it is assigned to:

• Line 3, it is displayed at once.

• Any, it is displayed at once on Line 3.

• Line 1 or 2, it is put in the Message Queue until the first message
is terminated.

• All, it is put in the Message Queue until the first message is
terminated.

• Line 4, it cannot be displayed; this discrepancy is caught during
Validation of the application.

To display more than one message:

Assign messages to different lines if they are to be displayed at the
same time. The terminal can display:

• four different messages in Quarter Display mode

• two messages in Quarter Display mode and one in Half Display
mode

• two messages in Half Display mode.

When messages require action by the operator, consider the
following:

• Only one message may be displayed at a time that requires the
operator to use either:

– numeric keys, although one message can have up to 10
Numeric Entry variables (MessageView 421N or 421F
terminals)

– the ACK  key (all terminal types)

• In MessageView 421F terminals, only one message may be
displayed at a time that requires the operator to press a Function
key. However another message can be displayed that contains
either Numeric Entry variables or the Ack attribute.

Clearing messages from the terminal display

Wait Time

Select the Wait Time  list box to specify the minimum time the
message will be displayed. Wait time may be 0 to 31 seconds; default
is 1 second.

Note: If Scroll is disabled and Auto Clear is enabled, Wait Time
cannot be 0. If it is 0, the application will not pass Validation.
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Auto Clear

Use the Auto Clear check box to clear the message from the display
after its Wait Time  has expired. Disable Auto Clear to display the
message until another message is triggered (or comes to the top of
the queue) that is assigned to the same line(s).

Note: If Wait Time  is 0 and Scroll is disabled, Auto Clear must be
disabled. If it is enabled, the application will not pass Validation.

If a message has a Function key or keys enabled, the Jog Mode
aspect of the Auto Clear attribute is used.

• Non–jog mode: if Auto Clear is enabled, the Function key
message is terminated as soon as a Function key operation is
completed (including Hold Time if any)

• Jog mode: if Auto Clear is disabled, the Function key message
remains active until:

– the the terminal operator presses the [0] and [+/-] keys on the
terminal at the same time

– the controller triggers Special Message 9901, Clear Display
– the controller triggers Special Message 9903, Reset Terminal
– the terminal operator resets the terminal manually.

Jog mode is discussed in detail on Page 4–21.

Scrolling

Use the Scroll check box to enable scrolling.

• The Scroll attribute is disabled to pop the message onto the
display.

A message longer than the display is wide appears in segments,
each remaining for the Wait Time  specified for the message.

• The Scroll attribute is enabled to scroll the message onto the
display from the right side, one character at a time.

A message too long for the display scrolls off the display at the
left. When the last character appears, the message remains for its
Wait Time before it is terminated.

If the Auto Clear attribute is not set, the message will continue to
scroll until another message is triggered or queued for the same
line(s).

When Scroll is enabled, the Scroll Time list box is activated. Use
the Scroll Time list box to set the time interval between one
character appearing and the next. Range is 0.1  to 5 seconds; default
is 0.2 seconds.
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Note: A long message may be checked in the Terminal View if you:

• set the insertion pointer in the Message Edit box at different
points along the message; the message in the Terminal View starts
with the insertion point.

• if the All Line attribute is set, use the Return (Enter) key to break
up the message into segments.

Note: If Auto Clear is enabled and Wait Time  is 0, Scroll must be
enabled. If it is disabled, the application will not pass Validation.

     If All  is selected in the Line attribute, Scroll must be disabled.

Hidden

A Hidden message is triggered like any other message but not
displayed. When the Hidden attribute is enabled its message never
appears on the terminal display.

Since a Hidden message is not displayed, it cannot support any type
of operator action.

Note: Set the HE Stack attribute for a Hidden message to log a
Display Variable into the stack without displaying it.

Note: Set the Slave Enable attribute for a Hidden message to have a
slave device display a message that does not appear on the master
device’s display.

Text Attributes

Several attributes define the way in which a message is displayed.

Center

A message is left justified by default. To toggle between centered
and left justified for the message in the Message Edit box, do one of
the following:

• select the Center check box to enable or disable centering

• click the Center or Left Justify icon

• select Align from the Format menu, and choose Left or Center in
the menu that appears.

If you want a message to be right justified, insert spaces at the start
of the message in the Message Edit box, and check the result in the
Terminal View.

Note: The number of displayable characters in a centered message
must be less than or equal to the number of characters per display
line available for the selected text size.
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Inverse

A message or any part of a message may be displayed with black and
white reversed. In the Message Edit box, highlight:

• text

• a variable

• a graphic

• the entire message.

Then either:

• click the Inverse Video icon

• select Inverse Video from the Format menu.

Any text, variables or graphics entered in the message while the
Inverse Video icon is selected, will be in Inverse Video setting.

The selected text will be displayed with black and white reversed in
the Message Edit box and in the Terminal View.

Flash

A message or any part of a message may be displayed flashing on
and off. In the Message Edit box, highlight:

• text

• a variable

• a graphic

• the entire message.

Then either:

• click the Flash icon

• select Flash from the Format menu.

Any text, variables or graphics entered in the message while the
Flash icon is selected, will be in Flash setting.

The selected text will be displayed in a different color in the
Message Edit box. It will flash on and off in the Terminal View and
in the MessageView terminal.

Note: To change the color distinguishing Flashing text in the
Message Edit box, see Page 7–15.
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Freeze

Use the Freeze check box to keep display variables at the value they
had when their message was triggered. If the Freeze attribute is
disabled the terminal continually updates display variables as long as
the message is displayed.

Note: The value sent to the Historical Event Stack (if the HE Stack
attribute is enabled) is the value at the moment of triggering.

Historical Event Stack

Use the HE Stack check box to enable this attribute. The message
will be logged into the Historical Event Stack file each time it is
triggered.

The logged message includes the time and date when the message is
triggered, and the value in each display variable at the moment it is
triggered. See Page 4–19 for a discussion of the Historical Event
Stack.

Acknowledge Time

The Ack Time attribute may be used to log into the HE stack with
the message, the time and date when the message was acknowledged
if both the following apply:

• the message requires the operator to press the ACK  key on the
terminal, and

• the HE Stack attribute is enabled.

Acknowledgeable Message 

Messages may be defined as acknowledgeable messages which
require operator intervention.

Acknowledgeable messages remain displayed (active) until the
terminal operator presses the ACK  key and the preset acknowledge
hold time (50 ms) has expired. The bit at the global Acknowledge
tag address is set. The controller program checks this bit to make
sure the terminal operator has pressed the key before triggering
another message.

Use the Ack check box to define a message as acknowledgeable.
When Ack is enabled, Wait Time  is overridden.
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While a message requiring acknowledgement is displayed, other
messages may not be displayed if they:

• require an acknowledgement, or

• contain entry variables.

Note: On a MessageView 421F terminal, a message with function
keys enabled may be displayed at the same time as a message
requiring acknowledgement.

!
ATTENTION:    When using Remote I/O, if the
Acknowledge Message Return number global attribute
is enabled, assign the bit for the ACK key to the same
Block transfer block as the Acknowledge Message
Return number.

Bit Trigger

A Bit Trigger is optional, since a message can be triggered using its
Message Number. A Bit Trigger address must be unique, and a bit
address can be used to trigger only one message in the application.

Select the Enable check box to enable the Bit  spin control. To edit
the number of the bit trigger:

• select a value on the Bit  spin control, or

• highlight the current number, then type the correct bit address.

An application can have up to 1024 bit triggers if Block Transfers
are used, but  the maximum number of bit triggers is much smaller if
only discrete I/O is used.

Note: In an application designed for use with an ASCII Triggering
device, bit triggers are not supported.

Triggering is discussed in the section starting on Page 4–9.
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Chain

A message may be chained to another. That is, a message can trigger
another message by invoking its message number. A chained
message has exactly the same attributes as if it were not chained.

When the first message in a chain is triggered, it is displayed or
queued. After it is terminated, if the next message in the chain:

– has the same display line as the previous message, it has
priority over messages in the queue and is displayed

– has a different display line assigned, and that line is free, the
message is displayed

– has a different display line assigned, and that line is occupied,
the message is appended to the Message Queue.

• Select the Enable check box, then select the chained Message
Number from the To: spin control.

• Or highlight the current number and type the chained Message
Number.

Any message in the application may be chained to another. A chain
may even be circular, with the last message triggering the first
message. A circular chain can be useful in certain cases. To break the
chain:

• tell the terminal operator to do a Powerup Reset, or

• trigger Special message 9901, Clear Display.

ASCII Triggering devices

ASCII Triggering devices do not support embedded display variables
in chained messages.

A MessageView terminal with a Remote I/O daughterboard (Catalog
Nos. 2706-M1D1, -M1N1 or -M1F1) and firmware that supports a
Slave Port can act as a master device with up to 126 slave devices.
Each Slave device at a specific Node Address displays the messages
sent to its Node Address. 

Slaved messages may contain variables, graphics and message
attributes set up by the MessageBuilder software, with the following
cautions:

• A graphic must be preceded by a Ctrl-G, or the terminal will
replace the graphic with two spaces before sending the message
to the slave.

• The terminal removes embedded data entry variables from a
message before sending the message to the slave.

Slaving
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Slave Packet format

The MessageView terminal supports transmission of messages to a
slave device, using Simplex protocol.

The Simplex protocol consists of a data packet with 6 data fields:

Field Field 1 Field 2 Field 3 Field 4 Field 5 Field 6

Contents
Optional
Control
Byte

ASCII Text
and special
Control
Characters

Optional
Display
Mode Byte

Slave
Address

Line
Number

Carriage
Return
(CR]

Number
of Bytes

1 0 to 100 1 1 1 1

Note: Simplex protocol is compatible with Allen-Bradley DL20,
DL40, DL50 and MessageView 421D slave devices.

Field 1: Optional Control Byte

This is an optional field which indicates the text size of the slaved
message as it is transmitted. The following characters are used:

Byte Decimal Value Definition

Default – Quarter height text

Ctrl-S 19 Half height text

Ctrl-W 23 Full height text

Ctrl-C 3
Clear Display line, based on Line Number Byte.
Used with Line Number Byte to specify line.

The optional Control Byte may be omitted. If omitted, the default
size will be Quarter height text.

If the Auto Format attribute is enabled, the Optional Control Byte is
automatically embedded, based on the text size selected in the
message’s Text Size attribute.

The Optional Control Byte may be placed in the message manually,
embedding it as the first character in the text portion of the message.
It overrides a Control Byte embedded by Auto Format.
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Field 2: ASCII Text

This field contains the ASCII characters and/or special ASCII
control characters that are to be displayed by, or to control, a slave
device.

The ASCII text can include embedded variables, graphics and
control codes for Flash and Inverse Video. It can have up to 100
characters.

The following codes may be embedded in the ASCII text:

Byte Decimal Value Definition

Ctrl-F 6
toggle between Flashing and non–Flashing
characters

Ctrl-I 9
toggle between Inverse Video and non–Inverse
Video characters

Ctrl-G 7
Embedded Graphic, where the next byte is a
graphic, ISA symbol 1 to 32

If Auto Format is enabled, Flash and Inverse Video control
characters will be embedded automatically, based on whether the
attribute is enabled in the Message Edit box.

If the first or last byte of the ASCII Text field is a control character,
it will be interpreted as the Optional Control Byte or the Optional
Display Mode Byte, respectively.

Note: An embedded Carriage Return control character (decimal 13)
is not allowed in the ASCII Text portion of the slave packet.

Field 3: Optional Display Mode Byte

This optional field indicates how the message text is to be displayed.
The following characters are used:

Byte Decimal Value Definition

Default –

Holding message, non-Auto Clear
If the message is longer than the display width, Wait
Time between segments of the message is 1
second.

Ctrl-A 1
Holding message, non-Auto Clear
If the message is longer than the display width, Wait
Time is 3 seconds.

Ctrl-C 3
Scrolling message, non-Auto Clear, Scroll Time 0.2
seconds, Wait Time is 1 second.

Ctrl-V 22
Center message (message length must be less than
or equal to the number of characters in the display
line for that text size).
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If the Optional Display Mode Byte is omitted, the message will
remain displayed on the slave device unless it is cleared. If the
message is longer than the packet length, the first segment of the
message remains displayed for 1 second. After 1 second the second
packet is sent with the next portion of the message, and so on until
all packets have been sent. The message will repeat this cycle unless
it is cleared.

If Auto Format is enabled,the Optional Display Byte defaults to the
default status unless the Scroll or Center Message attribute is
enabled.

The Optional Display Mode Byte may be manually placed in the
message by embedding it as the last character in the text portion of
the message. It overrides a character embedded by Auto Format.

Field 4: Slave Address

The Slave Address Byte is a single byte field that specifies the Node
Address of the receiving slave device. Valid slave node addresses are
integers from 1 to 127, except for 13.

Note: If a Slave Device has a Node Address of 127, it will respond
to all messages, regardless of the slave packet address. If a message
packet has a Node Address of 127 it will be received by all slave
devices on the network.

Field 5: Line Number Byte

The Line Number Byte indicates the display line on which the
message will appear. The Line Number Byte is automatically
embedded in the slave packet based on the message’s Line attribute.

Line Attribute Selected Line Number Embedded

1 1

2 2

3 3

4 4

Any
1 to 4, depending on the line where the Master
device displays the message

All 50

The “All” Line attribute (50) is used with the Ctrl-C Optional
Control Byte to clear all lines on the slave device.

The Line Number Byte function depends on the slave device and its
functions. Consult the slave device’s user manual for the line
configurations it supports.
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Field 6: Carriage Return

The Carriage Return (decimal 13) indicates the end of a message
packet. It is embedded at the end of the Slave Packet automatically.

Slaving attributes

Enable

Select Enable to send this message out the RS-232 port to the slave
device specified in the address attribute.

If Enable is not selected, the message is used by the slaving (master)
terminal only.

Auto Format

If Auto Format is enabled,  the MessageView terminal sends the
entire message to a slave at once, up to the maximum message length
of 100 characters. The terminal also embeds the optional Control
byte, ASCII Text Code bytes, Optional Display Mode byte and Line
Number byte automatically.

• Optional Control byte is set according to the Text Size attribute.

• Flashing, Inverse Video and embedded Graphics have the proper
control characters set according to the corresponding attributes.

• Optional Display Mode byte is set according to the Scroll and
Center attributes.

• Line Number is set according to the Line attribute.

Note: If you place an embedded Control Byte:

• at the beginning of the text portion of the message, it will
override an automatically placed Control Byte.

• at the end of the text portion of the message, it will override an
automatically placed Display Mode Control Byte.

If Auto Format is disabled, the MessageView terminal:

• sends the message to the slave device in package lengths
corresponding to the value set in the Length attribute.

• does not embed the optional Control Byte, ASCII Text Code
Bytes, or Display Mode Byte in the message packet.

In this case these optional bytes must be placed manually in the text
portion of the message, using the ASCII Control Characters  dialog
(accessed through the Format menu). See Page 7–21.
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Example:

~This ~Message~ is half height.~

Placeholders for Ctrl-F
(ASCII Text Code Byte for Flash)

Placeholder for Ctrl-S
(optional Control Byte for Half Text Size)

Placeholder for Ctrl-C
(optional Display Mode Byte for Scroll)

Note: If the slave device is a MessageView 421D Slave Device
terminal (Catalog No. 2706-M1D), it is recommended that you
enable Auto Format.

Address

Use the Address spin control to specify the Node Address to which
the message is to be slaved. Each slave device has its own node
address. See Page 4–15 for a diagram of a possible network.

The address for an individual slave device is a number from 1 to 126.
Address 127 sends the message to all slave devices on the network.

Length

The Length attribute is enabled if Auto Format is disabled, so a
packet length may be selected.

Use the up/down arrow keys to select a number from 7 to 100 in the
Length spin control.

If the message is larger than the selected Length, the MessageView
terminal will divide it up into packets. The last packet will have
spaces inserted after the last character in the message if necessary to
meet the Length requirements.

For instance, a message 28 characters long with a Length of 10 is
sent in three packets. The last packet contains 8 characters and 2
spaces to fill it.

Note: If Auto Format is disabled and the Line attribute is “All”, only
the number of characters in the Length attribute will be sent, even if
each line portion of the message is longer. For example, if Text Size
attribute is Quarter (21 characters per line) and the Length attribute
is set at 10, the last eleven characters of each line will never be sent
to the slave if each line contains 21 characters.
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Relay

Enable the Relay Energize attribute to trigger (enable) an alarm
relay in a DL50 slave device.

The message with the Relay attribute set is displayed at the same
time as the alarm is triggered, and should explain why the alarm was
triggered.

If the message is divided into packets, the MessageView terminal
sends the packets in this order:

Message Packet #1 – Relay Packet – Message Packet #2 –
Message Packet #3 ...

Important: The alarm relay will not de-energize until another
message is slaved to that Alarm Relay, disabling it.

!
ATTENTION:   Use the alarm relay as a warning only.
Do not use it for control.

Slave Packet transmission rate

Slave Packets are sent to the slave at a user-defined rate called the
Inter-Packet Delay.  This delay is the time allowed between
successive packets sent from the master to the slave device.
Inter-Packet Delay is set in the Aux. Port tab of the Terminal Setup
dialog, see Page 10–28.
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MessageView 421F terminals have 16 Function keys on their
keypad. Function keys may be used in any application designed for a
MessageView 421F terminal. See the section starting on Page 4–20
for a discussion of Function keys.

Note: Function keys are not “embedded”in the message. The
message enables one or more Function keys based on the Function
key enable dialog (Format menu) and typically tells the terminal
operator which keys to press. The text description is developed by
the application designer.

A message with Function keys enabled:

• can not be displayed with another message that has Function keys
enabled

• may be displayed with a message that contains entry variables or
with a message which requires acknowledgement.

Function key attributes

When the application is designed, make a list of the Function keys
that will be used. Set them all up before any messages are created,
and then enable them for specific messages as needed.

Important:  Function key attributes are global. That is, once a
Function key’s attributes are set, they are the same
every time that Function key is used in any message
within the application. If attributes are changed in one
instance, they are changed for all instances.

Select Function Keys in the Application menu to open the Function
Keys dialog.

Function Keys
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Function Key: Select a Function key from the Function Key list
box. After all its attributes are set, you may select another Function
key and set its attributes.

Type: Select the Type list box and highlight the type needed.

• None: the Function key is not used.

• Momentary:  changes state (0 to 1 or 1 to 0) when pressed and
released. Changes back to its initial state after the defined Hold
Time has expired.

• Maintained:  changes state (0 to 1 or 1 to 0) when pressed and
remains in the changed state when released.

– If the message is in Jog mode, the Function key returns to its
original state when pressed and released again.

– If the message is in non-Jog mode, a new message must be
triggered and displayed with the same Function key enabled,
so the key can be pressed and released again.

• Latched: changes state (0 to 1 or 1 to 0) when pressed and
remains in the changed state when released. To return the
Function key to its original state, the logic controller must set a
handshake bit. See Page 4–24 for a discussion of Latched
Function Keys and handshaking.

Initial State: If a Maintained Function Key was selected under
Type, select Open or Closed initial state. This option is greyed out
when another type is selected. A Maintained Function Key toggles
between two states, so the state on powerup does not need to be the
same as the Contact Open/Closed state.

Contacts: Select either Normally Open or Normally Closed,
depending on how the Function key is to be used.

Hold Time: If a Momentary Function Key was selected under Type,
select a Hold Time. This option is greyed out when another type is
selected. Hold Time can be 0, 50, 250, 500, 750 or 1000
milliseconds; default is 500 ms. 

The terminal holds the Function Key bit set/cleared for the Hold
Time, even if the key is physically released at once. The Hold Time
should be longer than the scan time of the controller, to ensure that
the bit is read at least once.
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Function key tags

Write Tag:  Select a write tag from the list box or type in a new
Write Tag name. A write tag is required for each enabled Function
key. The only valid data type for a Function key Write tag is bit 
type. 

The write tag is the address location used by both the MessageView
terminal and the logic controller to reflect the On or Off state of the
Function key.

Handshake Tag: If a Latched Function Key was selected under
Type, select a handshake tag from the list box or type in a new
Handshake Tag name. This option is greyed out for Momentary and
Maintained Function Keys. The only valid data type for a Function
key Handshake tag is bit type. 

The value at this tag address is set/reset by the controller. When the
bit is set, the terminal releases the Latched Function Key, and it
returns to its initial state.

Indicator Tag:  The indicator tag is a read-only tag in the Function
Keys dialog. It is discussed in the section on LED attributes on Page
7–52.

To edit the Write or Handshake tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.
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Enable Function Keys

Any or all of the Function keys may be enabled for any message. To
enable Function keys for the current message:

1. Select the Enable Function Keys tool to bring up the Enable
Function Keys dialog.

Or select Enable Function Key on the Format menu.

The dialog displays the message number.

2. Select the check box in front of each Function key the current
message will use.

3. Select OK  to return to the Message Editor Table View.

The text of the message typically tells the operator what to do with
each enabled function key. For instance:

F1 Start Conveyor F4 Enable Paint Sprayer.

Using jog mode in messages with Function keys enabled

Jog mode is discussed in detail on Page 4–21.

Example 1: When Auto Clear is enabled the message is terminated
as soon as a Function key is pressed, and if a Momentary Function
key, its Hold Time is expired. To enable Jog mode, disable the Auto
Clear attribute for the message. The message then remains active on
the display until:

• the the terminal operator presses the [0] and [+/-] keys on the
terminal at the same time

• the controller triggers Special Message 9901, Clear Display

• the terminal is reset.



7–52 Creating Messages

Publication 2706-817

Example 2: A Maintained Function Key that has been pressed only
once remains in the changed state after the message is terminated. It
may be returned to its original state in either of two ways.

• Enable jog mode by disabling the Auto Clear attribute. The
message tells the operator to press and release the Function key
twice.

• Chain or trigger another message that has the same Function key
enabled. The second message tells the operator to press the
Function key again.

The LED located beside the Function key may or may not have its
Indicator tag defined. LEDs may be used in any application designed
for a MessageView 421F terminal. See Page 4–25 for a discussion of
LEDs. 

When the application is designed, make a list of the LEDs to be used
and note which ones need an Indicator tag defined. Set them all up
before any messages are created.

Important:  LED attributes are global.

• When an LED does not have a tag assigned to it, the LED has no
tag any time it is used in the application.

• When a LED is assigned a certain tag, that tag remains assigned
to it throughout the application.

When the LED does not have an Indicator tag assigned to it, then the
LED follows the state of the associated Function key (LED1 with F1,
LED 16 with F16). For example, LED4 will light when Function key
F4 is pressed, and LED4 remains lit for the duration of the Function
key’s On state while the message associated with the Function key is
actively displayed.

When the LED has an Indicator tag assigned to it, the LED operates
independently of the associated Function key. For example, pressing
and releasing Function key F1 will have no effect on the operation of
LED1. The controller logic program controls the LED by setting or
clearing the bit at the Indicator tag address. Thus the controller can
indicate a process status without displaying a message.

Note: All assigned LED tags are monitored on a continuous basis
except when the terminal is in its Front Panel Editor mode.

LED Attributes
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Defining LED tags

1. Select LED Indicators on the Application menu to open the LED
Indicator Tags dialog.

2. For each LED that needs an indicator tag, choose an existing tag
name from the list box or create a new tag.

The only valid data type for an LED Indicator tag is bit.

3. Select OK  to return to the Message Editor Table View.

To edit the LED tag attributes:

1. Put the insertion pointer in the LED Tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.
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Special Messages give commands to the terminal. They may be
called up using either a value trigger (the message number) or a bit
trigger, just like other messages. See Page 4–5 for a list of Special
Messages.

The Special Messages dialog is used only when:

• one or more Special Messages need to be defined as a bit trigger.

• the Special Messages Set Time/Date or Set Brightness will be
used, and needs to have its read tags assigned.

• the Special Messages Get Time/Date or Test Battery will be used,
and needs to have its write tags assigned.

To assign a bit trigger to a Special Message

1. Select Special Messages on the Application menu to bring up the
Special Messages dialog:

2. Select the Bit Trigger Enable box for the special message.

3. Use the Bit Number spin control to assign an address to the bit
trigger.

4. When all special messages are edited, select OK  to return to the
Message Editor Table View.

Important: Bit triggers cannot be used when the terminal is
controlled by an ASCII Triggering Device.

Special Messages
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Write Tags

If the Get Date/Time or Test Battery Special Message is used, its tags
need to be defined. Select the Write Tags tab. This dialog appears:

1. For each variable, choose an existing tag name from the List Box,
or create a new tag. The only valid data type for:

• a Date or Time Write Tag is Unsigned Integer.

• the Test Battery tag is Bit.

2. Select OK  to return to the Special Messages dialog.

3. Select OK  to return to the Message Editor Table View.

Read Tags

If the Set Time/Date or Set Brightness Special Message is used, its
tags need to be defined. Select the Read Tags tab. This dialog
appears:
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1. For each variable, choose an existing tag name from the List Box,
or create a new tag. The only valid data type for:

• a Date or Time Read Tag is Unsigned Integer.

• the Brightness Level tag is Bit.

2. Select OK  to return to the Special Messages dialog.

3. Select OK  to return to the Message Editor Table View.

To edit the Special Message tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

ASCII Triggering devices

Tag Node Name and Address attributes are ignored by an ASCII
Triggering device. They may be omitted when creating applications
for use with such a device.
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This chapter covers the following topics:

• Using the tag editor

• Validating tag addresses

• Defining tags

• Working with tags

• Finding tags

• Sorting tags

• Printing tags

• Using tools

• Tag import/export utility

– importing tags
– exporting tags
– examining the results of an import/export.

Tags define the link between each variable and its assigned address
in the logic controller. See the section starting on Page 4–31 for a
discussion of how tags work.

Enter tag information in either of two ways:

Table View

Enter and edit all tags for the application in a table which has its own
toolbar, and columns for tag attributes. This is also called the
Summary View.

Form View

Enter or edit a single tag from an Edit Tag dialog, available through
the variable’s dialog in the Message Editor Table View.

If Numeric Variables are to be scaled, change from the Tag Editor
Table View to the Form View as needed.

Using the Tag Editor
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Opening the Tag Editor

To open the Table View 68

Choose Tag Editor from the Application menu.

You can toggle the Status Bar and Tool Bar on and off just as with
the Message Editor Table View. Simply select the appropriate
command in the View menu.

Tag Toolbar

Error on row 
(in this case,
duplicate tag name)

Editing this row

Name of
this window

Type of View

Toolbar

Project Name

Menu Bar

Status Bar
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To open the Form View:

• From a dialog in MessageBuilder, select or enter a tag name and
select the Edit Tag button.

• From the Tag Editor Table View, choose Form from the View
menu.

Navigating through the Tag Editor

To move between fields in Form View or Table View:

Move the mouse pointer to the field and click the left button.

• Or press TAB to move forward through fields and SHIFT+TAB to
move backward.

• Or in Form View, press ALT  + X, where X is the underlined letter
in the field name.

To change from Table View to Form View:

Click the Form tool on the toolbar.

• Or choose Form from the View menu.

• Or choose Form Editor from the Tools menu.

To change from Form View to Table View:

Select the Tag Editor button in the Tag Form View.

• Or select Summary from the View menu.

• Or choose List Editor from the Tools menu.

Note: If you enter data in the Form View, it will not appear in the
Table View when you switch views. Choose Refresh from the
Window menu to display the new data.
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To exit the Tag Editor:

Double-click the Control-menu box at the top left of the window.

• Or in Table View, choose Exit from the Project menu to return to
the Message Editor Table View.

• Or in Form View, select OK  or Cancel to return to the Table
View, then exit from the Table View.

Before starting to create tags, set up the Tag Editor to validate tag
addresses. Address Validation checks only tags that are entered or
modified while it is active. 

Important: Addresses for existing tags are not validated.

To activate address validation

Choose Address Validation from the Options menu. A check mark
next to the command indicates that the option is activated.

The Tag Editor checks each address against the type of device
specified in the Node Name field. If the address is not valid for that
device, the Tag Editor displays the following warning:

Select: To:

Return to the invalid address in the Table View

Save the tag in the database with the invalid address

For information on valid addresses for a specific type of controller,
refer to the user manual for that controller.

Note: In Form View, address validation is always active.

Validating Tag Addresses

Table View only
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 69

Table View Form View

Field Description Valid Characters Notes

Tag Name ①
The name of the
tag

Maximum characters = 32.

• A to Z, a to z, 0 to 9

• hyphen (–), underscore(_),
    percent (%).

If an invalid character is entered, the Tag Editor beeps and does
not display it.

• Do not use blanks, tabs, carriage returns or non-printable 
   characters.

• Tag names cannot begin with 0 – 9, hyphen, or percent.

• Tag names are not case-sensitive: LIST, List, and list are all
    the same to the Tag Editor.

• Tag names must be unique in a project.

Data Type ①
The data format
for the tag

Select one of the following:

• bit

• 4BCD

• unsigned integer

• signed integer

• character array
Use either of these methods:

• Type the letter of the data type, for
   example, b for bit.

• Use TAB to move to the Data Type
    field, press ALT + ↓    to display the
   list of data types.

The tag Data Type determines the data format for the variable.

Array Size
(Character Array
type only)

The number of
characters in the
array

Range of characters = 2 to 33;

• A to Z, 1 to 9.

• Do not use blanks, tabs, carriage returns or non-printable
    characters.

• Array size must be an integer.

Defining Tags
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Field Description Valid Characters Notes

Description ②
A description of
the tag

Maximum characters = 255.

• any printable character.
Use either of these methods: 
Select the box and type, or 
Use the Description Editor (see
below).

• Do not use blanks, tabs, carriage returns or non-printable
    characters.

Node Name ①

The node on the
network where
the device is
located

A node name cannot be the same as
a tag name or a terminal name.
Maximum characters = 32.

• A to Z, a to z, 0 to 9

• hyphen (–), underscore(_),
    percent (%).

The node name must match the controller name entered in the
Communication Setup dialog. See Page 10–6.
If an invalid character is entered, the Tag Editor beeps and does
not display it.

• Do not use blanks, tabs, carriage returns or non-printable
    characters.

• Node names cannot begin with 0 – 9, hyphen, or percent.

• Node names are not case-sensitive: SLC, Slc and slc are all
   the same to the Tag Editor.

Address ①

The data table
address in the
logic controller
for the tag

Maximum characters = 32
For more information on valid
addresses, refer to the controller’s
user manual.

• Do not use blanks, tabs, carriage returns or non-printable
   characters.

Initial Value
(Numeric Entry
variables only)

The starting
value for the tag
in engineering
units, which may
not be the same
units used by
the controller.

If the Data Type is a bit, enter either

• 0 or 1.
Maximum characters for other Data
Types = 24; they can be:

• 0 to 9

• e, E, +, –, and period (.).

• Do not use blanks, tabs, carriage returns or non-printable
    characters.

• Maximum precision is 6 places to the right of the decimal
    point.

• If present, a sign (+ or –) for the number must be first.
    Default is +.

• If present, a sign for the exponent must immediately follow the
    e or E. Default is +.

• Default initial value is 0.

Update
Frequency

How often the
terminal should
read the data in
the tag address

• 1 to 9, where 1 is the fastest
   update rate.
Use either of these methods:

• Click the down arrow and click on
    the rate.

• Use TAB to move to the Update
     Frequency field, press ALT + ↓   to
    display the list of frequencies.

Does not apply to Remote I/O.
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Field Description Valid Characters Notes

Scaling    ③
Scale = ‘m’ 
  in y = mx + b
Offset: = ‘b’
  in y = mx + b

The values that
convert the tag’s
controller integer
values (“x” ) to
engineering
units (“y”)

Maximum characters = 12

• 0 to 9

• e, E, +, –, and period (.)

• Do not use blanks, tabs or carriage returns.

• Maximum precision for scale is 4 places to the right of the
   decimal point.

• Maximum precision for offset is 6 places to the right of the
   decimal point.

• If present, a sign (+ or –) for the number must be first. 
    Default is no sign, which represents +.

• If present, a sign for the exponent must immediately follow the
    e or E. 
    Default is no sign, which represents +.

Data Entry

Limits ③    70

The minimum
and maximum
values that the
operator can
enter for the tag

Maximum characters = 12

• 0 to 9

• e, E, +, –, and period (.)

• Do not use blanks, tabs or carriage returns.

• Maximum precision is 4 places to the right of the decimal
    point.

• If present, a sign (+ or –) for the number must be first. 
    Default is +.

• If present, a sign for the exponent must immediately follow the
    e or E. 
    Default is +.

①  Required fields for either Table View or Form View.

②  To bring up the Description Editor:
  1. Select the Description field.
  2.  Click the right mouse button.
  3.  Choose Editor from the menu that appears.
  4.  When finished entering the description, select OK.

③  Scaling and Data Entry fields
    In Form View, these fields are present only when the Data Type is signed/unsigned integer or BCD.
    In Table View, these fields are not present.
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Saving Tags

To save tag definitions in Form View: 71

Select OK.

• Or press ENTER..

• Or select the Tag Editor button to move to the Table View.

To close the form without saving anything, select the Cancel button.

To save tag definitions in Table View:

Double-click in the Status Column for that tag.

• Or in the last column press ENTER.

• Or use the arrow keys to move the highlight to a different
(existing) row.

• Or use the scroll bar or the Page Up or Page Down keys to move
to a different row.

• Or insert a new tag in the table.

• Or change to the form view.

Different Views

To display: Do this:

only data types unsigned or signed integer,
BCD, or character array (if you are in the
Table View)

choose BCD/Integer from View menu

all tags in the project (if you are in the
BCD/Integer View)

choose Summary from View menu.

another copy of the current view
click or choose New from the

Windows menu.

Inserting and Deleting Tags

To select a row (a tag), click the left mouse button in the Status
Column for its row.

For this result: Do this:

insert a tag
click or choose Insert from Edit menu. 

A blank line appears in the table on
which to enter a new tag.

delete a tag
click or choose Delete from Edit menu.

The tag is deleted from the
application and cannot be retrieved.

cut a tag

click or choose Cut from Edit menu.

The tag is cut from the current
project. It may be added to this or
another application using the Paste
command.

Working With Tags

Table View only
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Copying tags

Select, Copy and Paste entire tags or individual fields. Then edit
their attributes as needed. See also Duplicating Tags below. 72

In fact, since tags and fields are copied to the Microsoft Windows
clipboard, they can be pasted in another application, even an
application in another project.

When a tag is copied, the new tag’s name is the same as the original
tag’s name in the Tag Editor Table View. An X appears in the Status
column for the new tag’s row until its name is changed.

For this result: Do this:

select a field click the left mouse button in the field

select a row
click the left mouse button in the Status column for
the row (the column at the far left)

select several adjoining rows

click the left mouse button in the Status column for
the first row. Then either:
  drag the mouse down the column, or
  press and hold the SHIFT key and press the Page
  Up or  Page Down  key

select several separated rows
click the left mouse button in the Status column for
the first row. Then press and hold the CTRL key and
click in the Status column of the other rows.

To copy and paste tag information:

1. Select the row that you want to copy, or the contents of a field.

2. Click the Copy tool.

Or choose Copy from the Edit menu.

3. Use the up/down arrow keys to move the cursor to the new
location.

4. Click the Paste tool.

Or choose Paste from the Edit menu.

If a tag is pasted, it is inserted above the current row.

If a field is pasted, it replaces the contents of the field that contains
the insertion point. Be careful to paste it in a field in the same
column.

Table View only
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To copy tags into another application:

1. Copy the tag(s) and exit the Tag Editor.

2. Open another application in the same or another project (see Page
6–4).

3. Open its Tag Editor Table View and paste the tags in it.

Duplicating tags

Use this option when a number of tags have similar attributes but are
assigned to different variables in the application. Create one tag and
duplicate it as many times as needed. Then change the name and
address on each new tag to suit the variable it will be assigned to.

To duplicate a tag once: 73

1. Select the tag name that you want to duplicate.

2. Click the Duplicate Once tool.

Or choose Duplicate Once from the Edit menu.

The Tag Editor duplicates the tag row and places it after the current
row. The tag name is incremented according to the options specified
in the Duplication dialog.

To duplicate a tag several times:

1. Select the tag name you want to duplicate.

2. Click the Duplicate Several tool.

Or choose Duplicate Several from the Edit menu.

The Tag Editor duplicates the current row and increments the tag
names according to options specified in the Duplication dialog.

To set the number of duplicates:

1. Select Duplication on the Options menu to open the Duplication
dialog.
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2. Select the Increment Name check box to choose whether or not
to distinguish names of duplicated tags by adding a number to the
name. Default is to add a number.

3. Select a separator from the Separator list box that will go
between the name and number of duplicated tags.

4. Select a number from 1 to 4 from the Number of Digits list box.
This sets the number of characters to the right of the separator.

5. Highlight the value in the Number of Duplicates text box and
type a number.

The number of duplicates is also displayed in a Duplications text box
on the toolbar. The value in the Duplications text box may be
highlighted and changed without entering the Duplication dialog.

Use this tool or command to locate any tag or tags in the Tag Editor
by name. Other tag attributes cannot be used in the Find dialog.

Important:  If the active View is BCD/Integer, the Find command
cannot locate tags with bit addresses.

1. Click the Find tool to open the Find dialog.

Or choose Find on the Edit menu.

2. Type the name of the tag and press ENTER. The Find command
locates tag names containing the sequence of characters.

The command is not case sensitive. For example, if you enter
switch, the Find command locates: switch, Switch, SWITCH,
Switch_5, Limit_switch, LimitSwitch, etc.

3. Select the appropriate button to move among the occurrences of
the tag name.

Click: To Move To:

the first occurrence in the current view

the previous occurrence

the next occurrence

the last occurrence in the current view

4. When done, select the Exit  or Cancel button, or press ESC on the
keyboard.

Finding Tags
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Tags may be sorted on any field or any number of fields in a
user-selected order. When tags are rearranged in the table so that
similar tags are together, they may be edited more easily.

1. Choose Sort from the View menu to open the Sort dialog.

2. Specify which field(s) to sort by:

• Double-click on a field name in the Column box to add it to the
Sort Order box.

• Or highlight a field and then select Add.

The Tag Editor moves the field name to the Sort Order box on
the right. You can specify any number of fields in your sort. The
default (no fields in the Sort Order box) is: Sort by Tag Name.

3. When all fields for this sort are entered, select OK .

The Tag Editor sorts the tags and displays them in the Table View.

The fields are sorted in the order in which they are added to the Sort
Order  box. To change the order:

1. Highlight a field or fields in the Sort Order box.

2. Select Remove to delete them.

3. Highlight a field or fields in the Column box.

4. Select Add to append them at the end of the list in the Sort Order
box.

Or select Cancel and start over.

Sorting Tags
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Tags may be printed if the personal computer is connected to a
printer and the correct drivers are installed. See the manual for the
printer and the Windows manual. 74

!
ATTENTION:    Make sure your printer is connected
and online.

Important:  If a row is being edited, signalled by a “pencil” in the
Status Column (the first column on the left), the Print
command is not active. Select a different row (which
stores the edited row) before calling up the Print dialog.

To print tags:

1. Click the Print tool to open the Print dialog.

Or choose Print from the Project menu.

Opens Print Setup dialog

Opens Page Setup dialog

Name of current printer.

Note: The name of the current printer is displayed. To change to a
different printer, see the next section. The printer used in this
session will be the default printer next time this dialog is opened.

2. Under Print What , specify whether to print All Rows in the
current tag view or only selected rows.

See Page 8–9 for details on how to select contiguous or
noncontiguous rows.

3. Select the Print The Cover Page box to print the cover page.
Information for the cover page is entered automatically: it
includes product, project and view name, date and time.

The product is: Allen-Bradley Tag Editor.

4. If the Current Printer  default printer should be changed, select
the Printer Setup button to open the Print Setup dialog.

5. If the setup should be checked or edited, select the Page Setup
button to open the Page Setup dialog.

6. Select OK .

Printing Tags

Table View only
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Other information

• The column width of the printed output is based on the column
width in the Tag Editor.

• The Tag Editor prints as many columns as fit on the width of the
page (minus the margins). If a column does not fit, it is printed on
the next page.

The Tag Editor does not print a column that is less than one
character wide, that is, an empty column.

• If a row does not fit on the page, it is printed on the next page
(each row is one text line high).

To set up the printer:

1. Select the Printer Setup button in the Print dialog to open the
standard Windows Print Setup dialog.

The dialog entries are based on the computer’s system
configuration and installation options.

2. Select the default or another printer and specify its settings.

!
ATTENTION:    Check the Microsoft Windows user
manual to make sure the settings are correct for the
type of printer.

3. Select the Options button to open a dialog to fine-tune the
specific printer. This dialog is different for each type of printer.

4. Select OK  to return to the Print dialog.

If the printer is not listed:

1. Check for hardware compatibility between the printer and one of
the printers listed.

2. Check if your printer has an emulation mode that is compatible
with one of the printers listed.

3. It may be necessary to install a printer driver for your printer.
Refer to the Windows User’s Guide.
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To set up the page:

1. Select the Page Setup button in the Print dialog to open the Page
Setup dialog.

Or choose Page Setup from the Project menu.

2. Enter a number to specify each page Margin  (Top, Bottom, Left,
Right). Default is 0.5” for each margin.

3. Select the Show Gridlines box if the Table View gridlines should
be printed.

4. Select the box, Use Maximum Width for Each Column, if each
field should be the maximum width allowed for it.

Deselect the box if the printed output should be based on the
contents of the columns. The number of characters that fit in a
column may be different from the printed output depending on
the fonts available.

5. Set up Header Lines 1 and 2 as required. Each line can be up to
255 characters long. See Header shortcuts below.

6. Select OK , then select OK  in the Print dialog.
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Entering Header Information

Do this to enter Header text: For example:

Most text prints as typed.

To print this:

type This is the header.

 This is the header.

Type one of the following character
sequences to save time: 1 2

&D = current date 3

&N = page number 3 
&T = current time
&V = view name
&P = project name
&B = space (use this to print a blank line)
&A = product name: 

Allen-Bradley Tag Editor

To print this:

type &D &P

To print a blank line, type &B.
To print an &, type &&.
A character sequence that is not defined
is printed as is.  For example, if you enter
&Z, then &Z is printed.

 2/2/95 Project 1

1 Character sequences are not case sensitive.
2 If the expanded text is larger than 255 characters, the printed output may be distorted or cut off.
3 These values are based on the computer’s Control Panel settings. See the Microsoft Windows user

manual for information about the Control Panel.

Aligning the Headers

Left justified text is the default alignment.

• For centered text: type &|  before the text or character sequence.

• For right justified text: type &|&|  before the text or character
sequence.

For example, if you want to print this:

type &P&|&N&|&D

Project 1 2 2/3/95

text after this
character sequence

is centered

text after this second
character sequence is
right  justified

Important: If alignment is specified in part of a header line, make
sure the text does not overlap. For instance, if left
justified text runs to the center of the page, it will
overlap centered text.
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If the Status column or Tag Name column for a specific tag is
selected, the Tools menu gives a list of available tools. From the list
select the tool needed.

In some cases, the Tools menu commands may depend on what
software is installed the the computer system.

List Editor  is the same as the Summary command on the View
menu: it brings up a new Tag Editor Table View.

Form Editor  is the same as the Form command on the View menu:
it brings up the Tag Form dialog for the selected tag.

Import  and Export  access the Tag Import/Export Utility.

Supported file formats

The Tag Import/Export utility copies SLC and PLC-5 tag
information from a supported file format to a MessageBuilder
software project and vice versa. The supported ASCII file formats
are:

File Format Description

Advanced Programming Software
(APS)

The ASCII documentation file produced by the
APSIE utility, for the SLC processor only. 
See the APS Import/Export Utility user manual,
publication 1747-NM006.

Comma Separated Value (CSV)
format

This format is used by certain software packages,
such as Excel. 
See the user manual for the software.

Advanced Interface (AI) series
software

The WINtelligent series version of the CSV format.

Tag Import/Export Utility
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Importing tags

Note: The Import function does not import:

• files created without keywords

• files created with annotations.

1. Choose Import from the Tools menu to open the Import Tags
dialog.

2.  Select an input format (APS ASCII, AI, or CSV).

When you import from APS ASCII format :

The Import function automatically translates special characters in
address comments (AC) used by APS software:

• backslash (\) is changed to carriage return (<cr>)
• double quotation marks (””) are changed to single (”)
• tilde preceding a backslash (∼\) is changed to a backslash (\).

3. Type a source file in the File box.

Or select Browse to search for a source file.

4. Under Destination, select a project and the logic controller used
by the project.

5. Select OK .

The Reading Source File dialog opens, followed by the Importing
Tags to Project dialog. Each of these dialogs displays the
percentage complete.
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When the Import function has finished importing the tags, the
Summary Report dialog opens.

• Select View Report to check it over.

• Select Save Report to save it to a file. A report must be saved
before it can be printed.

• Select OK  to return to the Tag Editor Table View.

To handle data collisions

If two or more tags have the same name, this dialog opens.

Important: The Import function does not check for duplicate
addresses, only duplicate names.

Click: The Import utility will:

Ignore conflicting tags. The tags in the project
remain, and the conflicting ones in the Import source
file are discarded.

Rename conflicting tags. The Import function adds
an extension to duplicate tags

_# (where # is 1, 2 or 3)
After three tags of the same name are renamed, any
more imported tags of that name are discarded.

Update the tags in the project with the data from the
imported tags.

Exit the Import/Export utility and return to the Tag
Editor.
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Exporting tags

1. Choose Export from the Tools menu to open the Export Tags
dialog.

2. Select an output format (APS ASCII, AI, or CSV).

!
ATTENTION:    The Export function automatically
adjusts tag names and descriptions to fit the new
format. If this will cause problems, edit the tags and
their names before opening the Export tool.

• When you export to an APS ASCII file:

– If the tag name is longer than 10 characters, the Export
function truncates the name.

– If the description is longer than 50 characters, the Export
function truncates the description.

– If special characters in the description are equivalent to those
used by APS, the Export function translates them:
carriage return (<cr>) to backslash (\)
quotation mark (”) to double quotation marks (””)
backslash (\) to tilde-backslash (∼\).

– If the tag name contains other special characters, the Export
function deletes them.

• When you export to an AI  file:

– If the tag name is longer than 15 characters, the Export
function truncates the name.

– If the description is longer than 75 characters, the Export
function truncates the description.

• When you export to a CSV file:

– If the comment (description) field contains quotation marks,
commas or carriage returns, the Export function puts quotation
marks around the comment field.

– If the comment field contains embedded quotation marks, the
Export function changes them to double quotation marks (””).
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3. Under Source, select a project and the logic controller associated
with it.

4. Under Destination, type a destination file in the File box or select
Browse to search for a destination file.

5. Select OK .

The Exporting Tags From Project dialog opens, followed by the
Writing Destination File dialog. Each of these dialogs display the
percentage complete.

When the Export function has finished exporting the tags, the
Summary Report dialog opens.

• Select View Report to check it over.

• Select Save Report to save it to a file. A report must be saved
before it can be printed.

• Select OK  to return to the Tag Editor Table View.

Examining the Results of an Import/Export

To examine detailed results of an import or export, select the View
Report button from the Summary Report dialog. For example, if a
file has been imported, View Report produces this dialog:
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Interpreting Import/Export error messages 75

This error: Means that: What to do:

device error - no
device specified

a device has not been specified Select OK, then select or enter a device.

device error -
device does not
exist

the specified device has not been defined

Select No to select or enter another device.

Select Yes to create a new device. This dialog box opens:

1. Select the type of device.

2. Enter the device address.

3. Select OK.

device error -
device not an SLC
processor1

a file imported from APS format requires an
SLC processor, which was not defined

Select OK, then select an SLC device.

parse error1

the selected source file was:

• corrupted

• unsupported type, or a type other than
    the type selected

• manually edited, with
   uncorrected mistakes

Select OK to abort the Tag Import/Export utility.
Fix the bad file if necessary. Choose Import from the Tools menu again and
select the same or another file to be imported.

file error - the file
does not exist1

the selected source file does not exist Select OK. Select another source file or cancel.

file error - the file
already exists2

the selected destination file is already in
the project

Select Yes to replace the file with the imported file.
Select No to cancel the import.

project error the selected project does not exist Select OK. Select another project or cancel.

1Import only
2Export only
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This chapter covers the following topics:

• About projects

• Managing projects

• Managing devices in projects

• Loading/replacing tags or devices in projects

• Restoring a project.

Each MessageBuilder application (MBA file) is associated with a
project. The project stores: 76

• tag definitions

• device information (devices are MessageView terminals and logic
controllers).

Tags and devices are specific to the type of communications, so a
project must be equally specific. Different applications can share a
project as long as they all use the same type of communications.

For example, a remote I/O application requires a MessageView
terminal with a Remote I/O port, and either:

• a valid PLC controller and tags with PLC formatted addresses, or

• a SLC with SN scanner and tags with SLC formatted addresses.

Each project is created as a separate subdirectory in the
C:\AB\PROJECTS directory. The project stores tag definitions and
device information for an application or applications.

Use the Project Management dialog to:

• change the project associated with an application

• copy, rename or delete projects and devices.

About Projects
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Use the Project tab in the Project Management dialog to work with
projects. You can: 77

• view the current project for an open application

• change the current project for an application

• create a new project

• rename a project

• make a copy of an existing project

• delete a project.

To manipulate projects:

1. Choose Project Management from the Application menu to open
the Project Management dialog.

The New Project box is used when
creating, renaming or copying a project.

2. Select the Projects tab.

The Projects tab shows the project that is currently used by the
opened application, and a list of existing projects.

If no application is open, the Current Project  field is blank.

3. Perform a task as defined on the next page.

4. Select the Done button to close the dialog and return to the
Message Editor Table View (if an application is open) or the
MessageBuilder window (if no application is open).

Managing Projects
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To change the project associated with an application  78

Note:  If an application’s project must be changed, the application
must be open. Any other task on this dialog does not require an
open application.

1. Select a project name from the Current Project  list box.

2. Select the Done button.

3. A dialog asks for confirmation of the change. Select Yes to
change the project or No to keep the current project.

To rename a project

1. Select the New Project Name box and type a unique name up to
32 characters long.

It cannot start with a number, or contain spaces.

2. Highlight the name to be changed in the Existing Projects box.

3. Select the Rename button.

4. A dialog asks for confirmation of the rename. Select Yes to
rename the project or No to cancel the rename.

The Existing Projects box now contains the new name, not the old
one.

To delete a project

1. Highlight a name or names in the Existing Projects box.

2. Select the Delete button.

3. A dialog with the name of the project asks for confirmation that it
should be deleted. Select Yes to delete it, or No to retain it.

If more than one project is to be deleted, choose either the Yes
button for each project or the Yes to All button.

The deleted project and all its tags are removed permanently.

!
ATTENTION:    Do not use DOS or Windows delete
commands to delete projects.

Important:   If a project is deleted accidentally, see the section on
Restoring a Project on Page 9–9.
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To create a new project  79

1. Select the New Project Name box and type a unique name up to
32 characters long.

It cannot start with a number, or contain spaces.

2. Select the New button.

The Existing Projects box now lists the new name.

To copy a project

1. Select the New Project Name box and type a unique name up to
32 characters long.

It cannot start with a number, or contain spaces.

2. Highlight the name of the project to be copied in the Existing
Projects box.

3. Select the Copy button.

If the project has an application open it cannot be copied. A
dialog appears:

4. A dialog asks for confirmation of the copy.  Select Yes to copy
the project or No to cancel the copy.

The Existing Projects box now lists two copies of the same project
under different names.
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The Devices tab in the Project Management dialog lets you: 80

• view MessageView terminal devices and PLC/SLC devices that
are currently defined for a project

• rename a device

• make a copy of an existing device

• delete a device.

!
ATTENTION:    Do not use the Devices tab of the
Project Management dialog to create a new device.
Device parameters cannot be specified here.

Use other dialogs to add devices to a project:

• MessageView terminal devices are added to a project when an
application is first created using the New Application dialog.

• Controller devices are added to a project using the Comms. Setup
button on the Terminal Setup dialog.

To manipulate devices:

1. Choose Project Management from the Application menu to open
the Project Management dialog. 

The New Device Name box is used when
deleting, copying or renaming devices.

2. Select the Devices tab, if not selected.

The Devices tab lists all devices that are defined for the current
project.

3. Perform a task as defined on the next page.

4. Select the Done button to close the dialog.

Note: An application does not have to be open when devices in its
project are manipulated.

Managing Devices in
Projects
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To delete a device

1. Highlight a name or names in the Existing Devices box.

2. Select the Delete button.

3. A dialog with the name of the device asks for confirmation that it
should be deleted. Select Yes to delete it or No to retain it.

If more than one device is to be deleted, choose either the Yes
button for each device or the Yes to All button.

The device is permanently removed from the project, and all
occurrences of the device name are removed from the application(s)
in the project.

To copy a device

1. Select the New Device Name box and type a unique name up to
32 characters long.

It cannot start with a number, or contain spaces.

2. Highlight in the Existing Devices box the name of the device to
be copied.

3. Select the Copy button.

4. A dialog asks for confirmation of the copy.  Select Yes to copy
the device or No to cancel the copy.

The Existing Devices box now has two copies of the same device
under different names.

To rename a device

1. Select the New Device Name box and type a unique name up to
32 characters long.

It cannot start with a number, or contain spaces.

2. Highlight the name to be changed in the Existing Devices box.

3. Select the Rename button.

4. A dialog asks for confirmation of the rename. Select Yes to
rename the device or No to cancel the rename.

The Existing Devices box now has the new name, not the old one.
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To edit devices in a different project than the current one

If an application is open, the project associated with it is listed in the
Current Project  box. However a different project can be selected
and its devices edited.

Select a project name in the Current Project  list box. The Existing
Devices box lists all devices in the selected project.

When reopening an application, it is possible that the devices or tags
in the application are not in the project or are different from the
devices or tags in the project.  This section shows how to:

• load unknown devices or tags in a project

• replace devices or tags in a project.

If application devices or tags are not in its project:

MessageBuilder displays the following dialog if the application you
are opening contains devices (terminal/controller) or tags that are not
stored in the project.

MessageBuilder must be told what to do.  The options are:

Select: To:

Add the named device or tag to the project database.

Ignore the device or tag, do not add it to the database.

Add all unknown devices or tags to the database.

Ignore all unknown devices or tags, and open the application.

Do not open the application.

If Yes or No was chosen, the dialog reappears with the next
application tag or device not found in the project.

Loading/Replacing Tags or
Devices in a Project
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If No or Add None was selected, the following caution appears:

Select OK  to accept the warning. The application opens as usual.

If application devices or tags are different than those in its
project: 81

MessageBuilder displays the following dialog if the application you
are opening contains different devices (terminal/controller) or tags
than those of the same name stored in the application’s project:

Discrepancies that may exist between the application and project:

• The application and project reference the same device name but
the device types are different.

• A tag in the application has the same name as a device in the
project. For example, the application contains a tag named
GRIPPER and the project contains a MessageView terminal
named GRIPPER.

• A device in the application has the same name as a tag in the
project. For example, the application contains a device named
MOTOR and the project contains a tag named MOTOR.
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For each discrepancy, MessageBuilder must be told what to do.  The
options are:

Select: To:

Replace the project device or tag with the application
device or tag.

Ignore the device or tag, do not replace it to the
database.

Replace all project devices or tags with the
application devices or tags.

Ignore all unresolved devices or tags, and open the
application.

Close the application.

If Yes or No was chosen, the dialog reappears with the next different
application tag or device.

If No or Replace None is selected, a dialog warns that the
application may not validate because of the differences.

If a project is deleted accidentally, an application associated with it
may be used to recreate the project. 82

1. Open the application. This dialog appears:

2. Select Yes. The project is recreated with all the device and tag
data required by the application.

Restoring a Project
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This chapter covers the following topics:

• Overview of terminal setup

• Changing the terminal type

• Remote I/O communications

• Block transfers

• RS-232 main port communications

• Setting advanced terminal options

• Setting format for time and date

• Defining control tags

• Defining status tags

• Auxiliary port setup.

The Terminal Setup tool or the Terminal Setup command on the
Application menu opens the Terminal Setup dialog. This dialog
defines both operating parameters and runtime communication
parameters. 

Terminal Name
was defined
when the
application was
created.

Overview of Terminal
Setup
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The Terminal Setup dialog uses tabs to organize its tasks by function.

Tab Function

Setup change terminal type of MessageView device

define runtime communication parameters between
the terminal and controlling device (accessed via
Comms. Setup button)

Advanced set a variety of terminal options

Time/Date
specify how the time and date will display in the
terminal

Control Tags

define tags for:
Message Trigger (bit and value)
Return Message Number
Acknowledge 
Acknowledge Handshake
Acknowledge Return Number
Function Key Return Number

Status Tags define tags for HE Stack Status

Aux. Port define Auxiliary Port (RS-232) device parameters

Note: The control buttons at the bottom of this set of tabbed dialogs
apply to all tabs. OK  saves parameters on all tabs, Cancel does not
save any parameter.

Terminal Port dialogs

MessageBuilder software has two dialogs where communication
parameters for a terminal port may be set up. 

Terminal Ports Where they are configured

Remote I/O and RS-232
Catalog Nos. 2706-M1D1, -M1N1, -M1F1.

Remote I/O in the dialog accessed by the
Comms. Setup button. See Page 10–4.
RS-232 in the Aux. Port tab. See Page
10–9.

RS-232 only
Catalog Nos. 2706-M1D, -M1N, -M1F.

RS-232 in the dialog accessed by the
Comms. Setup button. See Page 10–27.

The Comms. Setup button dialog is used to configure the
communications between the MessageView terminal and the
controlling device. This configuration is commonly called
Controlling Communications.

The Aux. Port tab dialog is used to configure the communications
between the MessageView terminal and an input or output device
that is not a controlling device. This configuration is commonly
called Auxiliary Device Communication.
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To change the type of MessageView terminal assigned to an existing
application:

1. Choose Terminal Setup from the Application menu.

The Setup Tab shows the information that was associated with
the terminal name when the application was first created.

2. Change the Terminal Type to the type of terminal that the
application will be designed for.

3. Select an existing Terminal Name that matches the new terminal
type from the list box

Or highlight the entry in the box and type in a new name.

4. If you typed a new name, select a Catalog number and firmware
Version; only the choices that fit the selected terminal type are
displayed.

5. The Ports list box displays the ports available on the terminal you
defined. Select OK .

Special considerations

Each application is designed for a certain type of MessageView
terminal.

If the selected terminal type and the application type do not match, a
dialog asks if the application should be changed.

Select Yes to convert the application.

• Select No to keep the application as it is, even though it may not
pass validation.

• Select Cancel to keep the original terminal type.

Changing the Terminal
Type
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If messages in the application before conversion consisted of
embedded Function keys or Entry variables, and the new designated
terminal type does not support these functions, the conversion
process will display an error dialog box.

The error dialog box reports the message numbers of any
incompatible messages in the application.

If the terminal is changed
from:

To: Remove:

MessageView 421F MessageView 421N
Function keys
LEDs

MessageView 421F MessageView 421D
Function keys
LEDs
Entry Variables

MessageView 421N MessageView 421D Entry Variables

MessageView 421N MessageView 421F none

MessageView 421D
MessageView 421N
MessageView 421F

none
none

Note: The conversion will not take place (aborts) if these
incompatibilities exist. Each of the messages reported in the error
dialog must be edited individually before the application can be
converted.

This section shows how to define runtime parameters for a
MessageView terminal and a PLC or SLC, that will communicate
over a Remote I/O (RIO) link. 

The MessageView terminal operates as a single rack on the network.
Its RIO communication parameters are set to match those of the
logic controller it will exchange data with, while the application is
running.

MessageView terminals with RIO daughterboards are Catalog Nos.
2706-M1D1, -M1N1, and -M1F1.

Remote I/O
Communications
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PLC Controller MessageView 421 Terminal

RIO Port

Remote I/O Network

SLC Controller with 1747-SN Scanner

or

This table lists the controller types and options supported by
MessageView terminals with RIO daughterboard.

Controller/Scanner Type Lowest Rack Highest Rack
Supports

Block
Transfer?

IBM PC 6008-SI
VME 6008-SV
DEC QBUS 6008-SQ

0 7 Yes

PLC 5/11 3 3 Yes

PLC 5/15
PLC 5/20

3 Yes

PLC 5/25
PLC 5/30

1 7 Yes

PLC 5/40 1 7octal Yes

PLC 5/60
PLC 5/80

1 7octal Yes

SLC 1747-SN Series A 0 3 No

SLC 1747–SN Series B 0 3 Yes

Other 1771-SN Subsystem 1 7 Yes



10–6 Terminal and Communication Setup

Publication 2706-817

To configure Remote I/O communications:

1. In the Terminal Setup dialog, verify the terminal type selected in
the Catalog and Version field.

2. Select the Comms. Setup button to open the Communications
Setup dialog.

When the selected terminal in the Terminal Setup dialog has a
RIO port, the Comms. Setup button opens a dialog to configure
this port.

Terminal Name from
Setup dialog.

Must match
Node Name
in Tag Editor.

Determined by
Terminal Name

Note: The Rack setting limits are determined by PLC/Scanner type.

To set up the logic controller:

1. Select a logic controller name from the Name list box.
MessageBuilder software validates the settings for the selected
controller/scanner.

Or highlight the name in the Name box and type a unique name
for the selected logic controller.

2. Select the type of logic controller from the Type list box. See the
list on Page 10–5.

If a name already exists, the controller type will be entered
automatically as defined by that name.

☞ The terminal type was defined 
when the application was 
created.

☞ To copy, rename or delete
a controller or terminal in a 
project, use the Devices tab in 
the Project Management dialog.
See page 9–5.
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To set up the terminal port:

Use: To:

Rack
Use only rack numbers supported by the controller
or scanner.

Module Group
Specify the module groups used by the terminal in
the rack; they must be contiguous.

Last Chassis
Check this box if these module groups have the
highest numbers assigned in the rack.

Baud Rate

Specify the baud rate used on the RIO link. The
options are:
 57.6 K 10,000 feet 
115.2 K  5,000 feet 
230.4 K  2,500 feet

Block Transfer Discussed in detail in the next section.

3. Select OK  to save the Remote I/O settings and return to Terminal
Setup dialog.

Use block transfers on a Remote I/O link to transfer a large block of
data between the MessageView 421 terminal and the logic controller.
See the section starting on Page 5–17.

Create up to 10 block transfer channels, numbered 1 to 10. Each
channel is associated with a block transfer read or write instruction
(BTR or BTW) in the controller ladder logic.

To define block transfers:

1. Select the Block Transfer button in the Communication Setup
dialog.

Note: If the controller/scanner does not support block transfer,
the Block Transfer button is dimmed and inactive.

Block Transfers
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2. Enter the parameters for each block transfer to be used.

Use: To:

Enabled Enable or disable the block transfer.

Address
Specify the starting address of the block transfer in a
native SLC or PLC (Remote I/O) link.

Mode Select Read or Write.

Length
Select the number of words (1 to 64) required by the
block transfer. 
A length of 63 is reserved for Pass-Through.

3. Select OK  to return to the Communication Setup dialog.

Note: Pass-Through Enable and Block Transfer Timeout are future
enhancements. Ignore them in this dialog.

Example

In this example, two block transfer assignments are specified.

N77:2

N7:0

!
ATTENTION:    When block transfer is used, be
certain that if the Return Message Number global
attribute is selected:
The Acknowledge bit tag is assigned to the same block
as the Acknowledge Return Message Number tag.
Function Key write tags are assigned to the same block
as the Function Key Return Message Number tag.
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A MessageView terminal’s RS-232 port may be used as: 

• A MessageBuilder communications link port (all terminals)

• an ASCII Trigger controlling port (Catalog Nos. 2706-M1D,
-M1N, -M1F)

• a slave device port (Catalog No. 2706-M1D)

• an Auxiliary Device port (Catalog Nos. 2706-M1D1, -M1N1,
-M1F1)

MessageBuilder communications link port

The RS-232 port on all MessageView 421 terminals is used in one of
its configurations as the link between the terminal and
MessageBuilder Configuration software. The RS-232 port
parameters for this link are fixed (not user configurable). See Page
5–2 for the DF1 parameters.

The section starting on Page 11–6 explains uploading to and
downloading from the MessageBuilder software. You can configure
the terminal to default to MessageBuilder configuration parameters
on power–up, see Page 10–16.

ASCII Trigger controlling port or Slave Device port

This section shows how to define runtime parameters for a terminal
controlled by an ASCII Triggering device and a terminal as a slave
device. Both devices communicate via an ASCII serial port, the main
RS-232 port.

To configure the RS-232 communications for ASCII Triggering
and Slave Device:

1. In the Terminal Setup dialog, verify the terminal type selected in
the Catalog and Version field.

RS-232 Main Port
Communications
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2. Select the Comms. Setup button to open the Communications
Setup dialog.

When the selected terminal in the Terminal Setup dialog has only
an RS-232 port, the Comms. Setup button opens a dialog to
configure this port.

3. Select the radio button for either ASCII Triggered or Slave
Device.

4. Set the parameter values as needed.

Parameter Names Default Parameters Options

Node Number
(The node address of
the MessageView
terminal.)

1
1 to 127.

Baud Rate 9600
300, 600, 1200, 2400, 9600, 19,200,
38,400 bps

H/W Handshake Disabled Enabled, Disabled

Parity None None, Odd, Even

Data Bits 8 7, 8

Stop Bits 1 1, 2

Note: For information on the Hardware Handshake parameter,
see Page 4–29.

5. Select OK  to save the RS-232 settings and return to Terminal
Setup dialog.

Note: The RS-232 communication parameters may be changed by
the terminal operator via the Front Panel Editor.

Note: The application may be Password enabled to prevent the
terminal operator from changing the settings and disrupting
communications. See Page 10–18.

Note: Since the same RS-232 port on the terminal is used for
communications with an ASCII Triggering device or a master
device, and also with MessageBuilder programming software, the
terminal must be set to the correct port configuration before proper
communications can be established. See the discussion on Page 5–3.
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MessageView terminal as a slave device

When a MessageView terminal is set up as a slave device, it is
considered to be a slave in a master/slave relationship. The slave
device terminal receives commands from a slaving (master) device,
but does not initiate communications itself. See Page 4–18 for a
discussion of slave devices.

Because of the architecture of the MessageView 421D Slave Device
terminal (Catalog No. 2706-M1D), an application with the
communication parameters and a blank message needs to reside in
the terminal’s memory. All MessageView 421D terminals (Catalog
No. 2706-M1D) are shipped with an application residing in memory
for this purpose.

Consult the Slave Device section of the MessageView terminal user
manual for more details.

Auxiliary Device port

The MessageView terminal configured with a daughterboard
communications card (Remote I/O) can use the RS-232 port as an
auxiliary port for communications to:

• an ASCII Input device

• a slave device (the MessageView terminal is a master device)

The Auxiliary port parameters are configured under the Aux. Port
tab in the Terminal Setup dialog. See the section starting on Page
10–27 to configure the auxiliary port.

Note: Since the same RS-232 port on the terminal is used for
communications with an ASCII Triggering device or a slave device,
and also with MessageBuilder programming software, the terminal
must be set to the correct port configuration before proper
communications can be established. See the discussion on Page 5–3.
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The Advanced tab in the Terminal Setup dialog allows the
application designer to define a variety of global configuration
parameters for the MessageView terminal. 

To set or modify advanced terminal options:

1. Select the Advanced tab from the Terminal Setup dialog.

2. Modify the settings as needed.

3. Select the OK  button to save all the settings from the Terminal
Setup dialog and return to the main Message Editor Table View.

• Or select another tab and continue setting up the terminal for the
application.

• Or select the Cancel button to return to the Message Editor Table
View without saving any Terminal Setup settings.

Return Message Number to PLC

If this option is enabled, the message number of the displayed
message is sent to the controller, provided its global Return Message
Number tag is defined. The controller may be a logic controller or an
ASCII Triggering device.

The three classes of messages may have Return Number tags:

• messages with the Ack attribute enabled

• messages with Function Keys enabled

• messages of all other kinds.

Note: If the Return Message Number to PLC attribute is enabled,
then one or more of the three Return Number tags in the Control
Tags tab must be defined. See Page 10–21.

If the controller is an ASCII Triggering device, the Return Message
Number is sent back as part of the Ctrl-N message. See Page 5–12.

Setting Advanced Terminal
Options
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!
ATTENTION:    When this global attribute is selected,
be certain that if block transfer is used:
The Acknowledge bit tag is assigned to the same block
as the Return Message Number tag.
Function Key write tags are assigned to the same block
as the Return Message Number tag,

The Function key Return Message Number is sent to the controller
twice:

• when the message is displayed

• when the Function key is pressed and released.

If the controlling device is an ASCII Triggering device the Function
key Return Message Number is sent back as part of the Ctrl-F
command. See Page 5–11.

The Acknowledge Return Message Number is sent to the controller
twice:

• when the message is displayed

• when the ACK  key is pressed and released.

If the controlling device is an ASCII Triggering device the
Acknowledge Return Message Number is sent back as part of the
Ctrl-K command. See Page 5–11

If the Return Message Number option is disabled, messages that
require operator input may need individual notification and
handshake tags.

Note: A message with the Hidden Message attribute set will not
return its number to the controlling device, since it is not displayed.

Enable Message Queue

The Message Queue in the MessageView 421 terminal stores
value-triggered messages until the line(s) in which they will be
displayed is available. Bit-triggered messages are not queued.

• If this option is enabled, up to 64 messages can be queued on a
First In – First Out basis. They are displayed in turn as terminal
display lines become available.

With this option enabled, make sure to define a Value Trigger tag
in the Control Tags tab dialog. See Page 10–23.

• If this option is disabled, a message is displayed only if the line
assigned to it is available when it is triggered.
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Send Values at Power-Up

If this option is enabled, the terminal sends variable data to the
controller after power is cycled or the terminal is reset.

Note: This option is always enabled for Remote I/O
communications.

If the Send Values at Power-Up option is enabled, select one of the
radio buttons under the Values at Power-Up option:

Select To

Preset Values
send the initial values set in the tags for the
variables.

Last Values
send the runtime values at the moment when the
terminal was reset or lost power.

If the Send Values at Power-Up option is disabled, the terminal
does not send any data to the controller at power-up.

The terminal operator can use the Front Panel Editor to change the
Values at Power-Up selection.

Note: The Send Values at Power-Up and Values at Power-Up
features are not supported in ASCII Trigger applications.

Enable Debug Mode

Debug Mode is used to check the application in a MessageView
terminal. In Debug Mode, as each message is triggered its message
number is displayed on the terminal instead of message text. If this
option is enabled, then the application will run in Debug Mode.

The terminal operator can use the Front Panel Editor to
enable/disable the Debug Mode.

Enable Simulate feature

The Simulate feature may be used to test an application in a
MessageView terminal. In this mode the terminal displays messages
but has no input from a controlling device. No communications error
messages appear on the display.

The terminal operator can use the Front Panel Editor to
enable/disable the Simulate feature.

When both Debug Mode and the Simulate feature are disabled, the
terminal runs the application in normal Run Mode.
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Flash Rate

Flash Rate determines the speed at which a character, word or
message flashes on the terminal display. The rates are:

Rate Selected Speed (Approximate)

None
Even if the Flash attribute is used, it will not
have any effect.

Low Once a second (1 sec. on/off)

Med Twice a second (0.5 sec. on/off)

High Ten times a second (0.1 sec. on/off)

The terminal operator can use the Front Panel Editor to change the
Flash Rate.

Note: A MessageView terminal as a slave device uses this parameter
to flash messages transmitted to it from the master device, with an
embedded Ctrl-F.

Local Language

Local Language specifies the language in which the MessageView
terminal’s Front Panel Editor menus, and internal warning and error
messages from the firmware, appear in the MessageView terminal
display. Select a language from the list box.

The terminal operator can use the Front Panel Editor to change the
Language selection.

Important: Application messages will always use the language in
which they were written, even if the Local Language is
different.

Brightness

Brightness determines the terminal display light level. Select a level
from the list: 12, 25, 38, 50, 60,75, 87 or 100%. Default is 75%.

The terminal operator can use the Front Panel Editor to change the
Brightness selection.

See Page 4–6 for the ASCII Triggering device command for a
Special Message that changes display brightness.
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Port Power-Up

This option determines how the RS-232 port is configured at
Power-Up. 

• The MessageBuilder option configures the terminal to power-up
with the communication parameters defined to communicate with
a computer where MessageBuilder software resides, for instance
to upload the Historic Event Stack

• The Auxiliary option configures the terminal to power-up with an
ASCII Triggering device or the communication device defined in
the Aux. tab dialog.

The terminal operator can use the Front Panel Editor to toggle this
option.

Note: This option may affect downloading an application, if the
MessageView terminal is configured to the Auxiliary Device when
an attempt is made at communicating with a computer. To correct
this situation, change the port configuration of the receiving
MessageView terminal via the Front Panel Editor. See the section on
Page 5–3 that discusses switching RS-232 settings.

Handshake Timeout

Handshaking is an option used to confirm that the information has
been received by the controller, whether a logic controller or an
ASCII Triggering device. If the terminal does not receive the
handshake within a certain time, a Timeout message appears on the
display. See the discussion on handshaking on Page 4–26.

Set the Timeout time by selecting a value from the Handshake
Timeout spin control. The range is 0 to 60 seconds, default is 4
seconds.
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Trigger Priority

Two or more messages may be triggered at the same time and
contend for the same display line(s). See the section on triggering
that starts on Page 4–9.

• If the messages are value-triggered, priority is determined by
which Message Number is entered into the Value Trigger address
first.

• If the messages are bit-triggered, priority is determined by the
lowest set bit in the Bit Trigger tag.

• If one message is value-triggered and one is bit-triggered, priority
is determined by this option, the Trigger Priority global attribute:

– if Bit is selected, the message with a bit trigger is displayed
and the one with the value trigger is queued (if the Message
Queue is enabled)

– if Value is selected, the message with a value trigger is
displayed and the one with the bit trigger waits. If the bit is
still set when the value triggered message is terminated, its
message is displayed.

Note: Bit triggering cannot be used by an ASCII Triggering device,
so this option must be set to value trigger.

Startup Message

Enable this option if a certain message should be displayed whenever
the terminal powers up.

• Select the message number in the spin control.

• Or highlight the current number and type the selected number.

Background Message 

Enable this option if a certain message is to be displayed after 2
seconds in which no active message is displayed.

• Select the message number in the spin control.

• Or highlight the current number and type the selected number.

Note: ASCII Triggering applications do not support Startup or
Background Messages with embedded display variables.

The terminal operator can use the Front Panel Editor to change the
Startup and Background Messages.
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Password 

A password for the MessageView terminal is optional. It protects the
MessageView terminal from an unauthorized person making changes
to the system configuration using the Front Panel Editor. The
terminal operator does not need a password to run the application.

Note: MessageView 421D terminals do not support the password
option.

Select the check box to enable the password option. Then highlight
the text in the box and type a 4-digit number as the password.

A password applies as long as the current application resides in the
MessageView terminal. Other applications that run at different times
in the same terminal may have the same or a different password, or
none.

A terminal operator who knows the password can use the Front
Panel Editor to disable and enable the password feature, provided it
is enabled and defined in the application. If it is not defined, the
operator cannot enable it.

The Time/Date tab in the Terminal Setup dialog specifies how the
time and date are displayed on the MessageView terminal. For
example:

Date Formats Time Formats

Month/Day/Year
7/3/95 07/03/95

7/3/19953/7/95
Day/Month/Year

Year/Month/Day
95/7/3

With Leading Zeroes

With 2-Digit Year Prefix

7*3*95

With User
Defined Separator

12-Hour Format
2:56

2:56 PM CST

02:5614:56
24-Hour Format

With Seconds
14:56:29

With Time Zone & Time

With Leading Zeroes

14*56*29

With User
Defined Separator

Standard Designations

Setting Format for Time
and Date
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To select the time or date format used by the terminal:

1. Select the Time/Date tab from the Terminal Setup dialog.

2. Set the Date Format and the Time Format as required.

3. Select the OK  button to save all the settings from the Terminal
Setup dialog and return to the main Message Editor Table View.

Or select another tab and continue setting up the terminal for the
application.

Or select the Cancel button to return to the Message Editor Table
View without saving any Terminal Setup settings.



10–20 Terminal and Communication Setup

Publication 2706-817

Use the Date Format area to set the options for the date format.  The
Sample area (lower right) displays the format as it is selected.

Option: Used to:

Order
Select the order of the month (M), day (D) and year (Y). 
Default is MDY.

Separator
Specify the symbol to separate the month, day and year. Any
character may be used.
Default is the slash (/).

Leading Zero
Specify that the day and month always have two digits. 
If this option is enabled, February 2 displays as 02/07.
Default is leading zeros not  displayed: 2/7.

Year
Specify whether the year is displayed as two or four digits. For
example the year 1996 can be displayed as 96 or 1996.

Use the Time Format area to set the options for the time format.
The Sample area (lower right) displays the format as it is selected.

Option: Used to:

12-Hour/24 Hour

Display the time in numbers representing hours:
Select 12-Hour to reset time to 00:00 after 11:59. 
Select 24-Hour to reset time to 00:00 after 23:59.
The text boxes to the right display editable suffixes.

Separator
Specify a character to separate hours, minutes and seconds.
Default is the colon (:).

Leading Zero
Display the hours before ten with a leading zero.
If this option is enabled, 3:15 displays as 03:15.
Default is leading zero not displayed: 3:15.

Display Seconds
Specify whether seconds are displayed.
Default is to display seconds.

Set the time and date in the MessageView terminal using the RTC
Download command. See Page 11–9.

The terminal operator can use the Front Panel Editor to change the
Time and Date in the Real Time Clock. The format can be changed
only by using MessageBuilder software.

See Page 4–6 for the ASCII Triggering device command for the
Special Messages that get or set the Real Time Clock time.
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The terminal uses control tags to specify addresses for global
attributes.

1. Select the Control Tags tab from the Terminal Setup dialog.

2. Assign tags as needed.

3. Select the OK  button to save all the settings from the Terminal
Setup dialog and return to the main Message Editor Table View.

Or select another tab and continue setting up the terminal for the
application.

 Or select the Cancel button to return to the Message Editor Table
View without saving any Terminal Setup settings.

Note: If the Return Message Number attribute is enabled in the
Advanced tab, then one or more of the three Return Number tags in
this tab must be defined.

Message Tags

The Value Trigger tag address contains the message number of the
most recently triggered message. The terminal scans the integer
value and displays or queues the message that has that message
number. This tag is required if the Message Queue was enabled in
the Advanced tab dialog. 

The only valid data type for this tag is unsigned integer.

Note: In an ASCII Trigger application, only a tag name is required
for the value trigger. Node name and address may be left blank. See
Page 5–8 for the Ctrl-T command used to trigger a message.

Defining Control Tags
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The Bit Trigger tag is the base address for a table that contains up to
1024 bits (64 words). Specific messages are assigned one bit as their
bit trigger. The terminal scans the bit table and triggers the message
whose bit corresponds to the lowest set bit in the table.

This tag is required if at least one message in the application has a bit
trigger assigned and enabled.

The only valid data type for this tag is unsigned integer.

Note: An ASCII Triggering device does not support bit triggers.

The Return Number tag is the address where the terminal writes the
message number of the most recent active message on the display,
provided:

• the message has no function keys enabled, and

• Acknowledge is not enabled, and

• the Return Message Number attribute is enabled in the Advanced
tab dialog.

The only valid data type for this tag is unsigned integer.

Note: If the controller is an ASCII Triggering device, the Return
Message Number is sent back as part of the Ctrl-N message. See
Page 5–12.

To enter these global Message Tags:

• select the name of a tag from the list box, or

• type a new tag name and select the Edit Tag button to define the
tag.

To edit the Message Tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:



10–23Terminal and Communication Setup

Publication 2706-817

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

Note: In an ASCII Trigger application, only a tag name is required
for message tags. Node name and address may be left blank.

Acknowledge Tags

The Acknowledge tag is the address where the terminal writes a 1
when its ACK  key is pressed in response to a message with the
Acknowledge attribute enabled.

The only valid data type for this tag is bit.

Note: If the controller is an ASCII Triggering device, the
Acknowledgement is sent back as part of the Ctrl-K message. See
Page 5–11.

The Handshake tag is the address where the terminal scans for a 1
to confirm that the ACK  key press was acquired by the logic
controller. If this tag is not defined, Acknowledge handshaking is
disabled.

The only valid data type for this tag is bit.

Note: An ASCII Triggering device does not support handshaking for
an Acknowledgeable message.

The Acknowledge Return Number tag is the address where the
terminal writes the message number of the most recent active
message on the display if:

• the message has the Ack attribute enabled, and

• the Return Message Number attribute is enabled in the Advanced
tab dialog.

The only valid data type for this tag is unsigned integer.

Note: If the controller is an ASCII Triggering device, the Return
Message Number is sent back as part of the Ctrl-K message. See
Page 5–11.

To enter these global acknowledge tags:

• select the name of a tag from the list box, or

• type a new tag name and select the Edit Tag button to define the
tag.



10–24 Terminal and Communication Setup

Publication 2706-817

To edit the Acknowledge Tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

Note: In an ASCII Trigger application, only a tag name is required
for acknowledge tags. Node name and address may be left blank.

Function Key Tag

The Return Number tag is the address where the terminal writes the
message number of the most recent active message on the display if:

• the message has Function key(s) enabled, and

• the Return Message Number attribute is enabled in the Advanced
tab dialog.

The only valid data type for this tag is unsigned integer.

Note: If the controller is an ASCII Triggering device, the Return
Function Key Message Number is sent back as part of the Ctrl-F
message. See Page 5–11.

To enter the global Function key tag:

• select the name of a tag from the list box, or

• type a new tag name and select the Edit Tag button to define the
tag.
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To edit the Function Key Tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

Note: In an ASCII Trigger application, only a tag name is required
for Function key tags. Node name and address may be left blank.

The HE Stack Status tags provide an indication to the logic
controller when the stack is nearly or completely full. The Historical
Event Stack holds about 4000 alphanumeric text messages. See Page
4–19 for a discussion of the Historical Event Stack.

1. Select the Status Tags tab from the Terminal Setup dialog.

Defining Status Tags
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2. Select the name of a tag from the list box for one or all of these
tags.

• 100% is the address where the terminal writes a 1 when the stack
is full.

• 95% is the address where the terminal writes a 1 when the stack
is 95% full.

• 85% is the address where the terminal writes a 1 when the stack
is 85% full.

The only valid data type for these tags is bit.

Once set, these status bits remain On until the condition has been
cleared. Warning messages are displayed on the terminal for the
corresponding conditions. The 100% warning message requires the
operator to acknowledge the condition.

Note: An ASCII Trigger application supports the HE Stack Status
tags. However the terminal returns the actual status number: 85, 95
or 100 to the controlling device, as part of the Ctrl-H command. See
Page 5–12 for the HE Stack report the terminal sends to the ASCII
Triggering device.

To enter these global status tags:

• select the name of a tag from the list box, or

• type a new tag name and select the Edit Tag button to define the
tag.

To edit a Status Tag attributes:

1. Put the insertion pointer in the tag box.

2. Select the Edit Tag button to bring up the Tag Form dialog:

3. Edit the tag’s attributes (see the section starting on Page 8–2).

4. Select OK .

Note: In an ASCII Trigger application, only a tag name is required
for HE Stack tags. Node name and address may be left blank.
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A terminal with a daughterboard (Catalog Nos. 2706-M1D1, -M1N1
or -M1F1) has both a Remote I/O (RIO) port and an RS-232 port.
The RS-232 port may be configured to communicate with other
devices, using the Aux. Port tab. For a terminal without a RIO port,
see Page 10–9. 

For details on RS-232 port configuration, see the section starting on
Page 5–3.

While the application is running, a terminal with a daughterboard
and the appropriate firmware can communicate with a logic
controller and with either:

• an ASCII Input device, see a list on Page 5–6.

• one or more slave devices as a slaving (master) device. Slave
devices are listed on Page 5–6.

To configure the RS-232 Auxiliary Port:

1. In the Terminal Setup dialog, verify the terminal Catalog and
Version field.

2. Select the Aux. Port tab.

When the selected terminal in the Terminal Setup dialog has only
an RS-232 port, this tab does not open.

3. Use the list box to select one of the following:

– Slave Port
– ASCII Input

Auxiliary Port Setup
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4. Set the parameter values as needed.

Parameters Default Options

Baud Rate 9600
300, 600, 1200, 2400, 9600, 19,200,
38,400 bps

Data Bits 8 7, 8

Parity None None, Odd, Even

Stop Bits 1 1, 2

H/W Handshake Disabled Enabled, Disabled

Inter-Packet Delay 200 ms
50, 100, 150, 200, 250, 300, 350,
400, 450, 500 ms

For information on the Hardware Handshake parameter, see Page
4–29.

Note: The Inter-Packet Delay parameter is intended to allow a
Dataliner DL10, DL20 or DL50 time to process each message
packet before the next packet is sent from the master. The worst
case for the Dataliner family is 300 ms. 

If the port is configured for an ASCII Input device, this option
does not apply.

5. Select OK  to save the RS-232 settings and return to the Terminal
Setup dialog.
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This chapter covers the following topics:

• Helpful hints

• Validating applications

• Transfer utilities

• Downloading an application to a terminal

• Downloading to a DOS file

• Downloading time/date to Real Time Clock

• Uploading an application from a terminal

• Uploading the Historical Event Stack

• Using the MessageView File Transfer Utility

• Terminal upgrade.

• MessageBuilder applications are normally saved to MBA files.
The MBA file is translated and saved as an MVA file during the
download process, whether to a MessageView terminal or to a
DOS file.

• Applications are validated (checked for errors) during the
download process. It is also helpful to validate applications as
part of the creation process, and correct any errors before trying
to download.

• An application can be downloaded only to a terminal it is
designed for. However MessageBuilder software can reconfigure
an application for another type of terminal. See Page 10–3.

• Transferring applications between a computer and MessageView
Terminal using an RS-232 connection requires the
INTERCHANGE DF1 driver. This driver was installed as part of
the MessageBuilder software installation.

• See the MessageView Operator Terminals user manual on how to
connect the computer and with a MessageView 421 terminal’s
RS–232 port.

Helpful Hints
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MessageBuilder automatically validates an application before
downloading it. When it has been downloaded, the MessageView
terminal verifies the application before running it.  103

In validating, each message, each tag, and the application as a whole
is checked. See Appendix D for a list of Exceptions messages.

The Preferences dialog may be set up to validate each message as it
is created. See Page 7–13. Or the application designer may validate
the entire application at any time.

To validate an application:

Choose Validate from the Application menu.

• If the application passes validation, the following dialog opens.

• If the application does not pass validation, the Exceptions dialog
opens with a list of all errors found. Correct the errors and then
validate again.

Sends validation
messages to a
printer or file.

Defines printer
settings.

While correcting errors, select the Exceptions command in the
Window menu to access the Exceptions dialog.

Press: To:

close the dialog.

send validation messages to a printer or file.

define printer settings.

Validating Applications
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Printing Validation Messages

To send validation messages to a printer:

• A printer must be connected to your computer.

• The computer must recognize the printer as a valid printer.

See your Microsoft Windows User’s Guide for details on installing
printers.

To set up the printer:

1. Select the Printer Setup button in the Exceptions dialog to open
the standard Windows Print Setup dialog.

2. If the default printer is not the one in use, select a printer from the
Specific Printer list box.

If it is not listed, see below.

3. Set appropriate attributes for the printer.

4. Select the Options button to enter options specific to the printer.
The Options dialog is different for each type of printer.

5. When done, select the OK  button.

6. Select the Print  button from the Exceptions dialog to print the
validation messages.

7. Select Close to return to the Message Editor Table View.

If the printer connected to the computer is not listed:

1. Check for hardware compatibility between the printer and one of
the printers listed.

2. Check if the printer has an emulation mode that is compatible
with one of the printers listed.

3. It may be necessary to install a printer driver for the printer. Refer
to the Microsoft Windows User’s Guide.
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Sending Validation Messages to a File

To send validation messages to a file, it is necessary to: 

• add the Generic/Text Only printer to the Installed Printers list

• assign the printer to a FILE: port.

For details on how to add Generic/Text Only on FILE: to the
Installed Printers list on your computer, see the Microsoft Windows
User’s Guide. This printer driver allows you to print text but not
graphics.

To send validation messages to a file:

1. Select the Printer Setup button in the Exceptions dialog to open
the standard Windows Print Setup dialog.

2. Select Generic/Text Only on FILE: from the list of Specific
Printers. If it is not listed, it must be installed first.

3. Select OK  to exit the Printer Setup dialog.

4. Select the Print  button in the Exceptions dialog to open the Print
to File dialog.

5. Enter the name of the file in which to save the validation
messages.

6. Select OK  to output messages to the file.

If the file name already exists, a dialog gives the option of
overwriting it or entering another file name.

Select Cancel at any time to abort the printing.

7. Select Close to return to the Message Editor Table View.
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Use one of these methods to transfer applications to/from a
MessageView terminal:

• MessageBuilder Application menu.

• MessageView File Transfer utility.

MessageBuilder Application Menu

Most application transfers are initiated from the Application menu of
the MessageBuilder software. Choose the Download or Upload
command from the Application menu for application transfers.

Use the Download command to download an application to either a:

• MessageView terminal using the INTERCHANGE DF1 driver
and an RS-232 serial connection.

• DOS file in MVA format (the terminal uses .MVA file type).

Use the Upload command to upload an application from a
MessageView terminal using the INTERCHANGE DF1 driver and
an RS-232 connection.

Other file transfer options available from the Application menu
include:

• RTC Download for downloading the computer’s time and date to
the Real Time Clock (RTC) in the terminal.

• HE Stack Upload for uploading the Historical Event Stack file to
the computer in CSV format.

MessageView File Transfer Utility

Use the MessageView File Transfer Utility (WINMFT.EXE) to
transfer applications when MessageBuilder is not running. This
utility is available as an icon in the MessageBuilder group. See
Page 11–15.

Use tools or File menu commands to:

• download an application to a MessageView terminal from an
MVA file

• upload an application from a MessageView terminal to an MVA
file

• verify an application on the computer in the same way it is
verified in the MessageView 421 terminal

• download the computer’s time and date to the Real Time Clock
(RTC) in the terminal

• upload the terminal’s Historical Event Stack file to a CSV file.

Transfer Utilities
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An application may be downloaded to a MessageView terminal using
the Application menu Download command.

Before downloading an application: 104

• DF1 INTERCHANGE communication driver must be installed
and loaded on the computer. See Page 2–3.

• Driver communication parameters must be checked using the
Workstation Setup command on the File menu. See Page 2–7.

• Cable connections must be correct. See the MessageView
Terminal User Manual (Publication 2706-816) for details.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

To download an application to a MessageView terminal:

1. Open the application to be downloaded.

2. Select the Download tool to open the Download Application
dialog.

Or choose Download from the Application menu.

Appears only if DF1
INTERCHANGE
driver installed

Shows drivers
currently loaded.

3. Under Destination, select Operator Terminal.

Downloading an
Application to a Terminal
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4. In the File Name box, enter the name of an MVA file in which to
save the translated application. The MVA file is downloaded to
the terminal.

Default is the first 8 characters of the application name and the
.MVA extension.

5. Select the Download only if different from current application
check box to download the application only if it does not match
the application currently loaded in the terminal.

The default is to download the application even if a match exists.

6. Select the Setup button to specify which port to use if more than
one of the computer’s COM ports is configured with a DF1
driver. The DF1 Setup dialog lists the available INTERCHANGE
ports. Select the appropriate port and close the dialog.

7. Select OK  from the Download Application dialog.

The application is validated and translated to an MVA file.

8. If errors or warnings are detected, the Exceptions dialog opens
and displays them.

• Errors must be corrected before the download can proceed.

• Warnings should be corrected, but the download will proceed if
they are not corrected.

9. The download begins. The terminal enters Programming mode
and erases the current application. MessageBuilder software
displays the progress of the download.

When the download is complete, the terminal resets, runs its
self-tests, verifies and starts the application.
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Note: The terminal erases its current application to prepare for a new
application to be downloaded. If the download is cancelled after this
erasure, the terminal’s powerup diagnostics will report that the
terminal has no valid application.

Note: Error messages may appear during this download. See
Appendix E for a list of error messages and how to correct the
problems.

An application may be downloaded to a file in the DOS
environment. An application downloaded to a DOS file is translated
from the MessageBuilder application file type (*.MBA) to the
MessageView 421 terminal file type (*.MVA).  105

The MessageView File Transfer Utility may be used to transfer any
MVA file between a computer and a MessageView terminal. See
page 11–15.

To download an application to a DOS file:

1. Open the application to be downloaded.

2. Select the Download tool to open the Application Download
dialog.

Or choose Download from the Application menu.

3. Under Destination, select DOS File.

Downloading to a DOS file
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4. In the File Name box, enter the path and name of an MVA file in
which to save the file on disk.

Or select Browse to search for a specific MVA file that will be
overwritten with this new application.

5. Select OK  from the Download Application dialog. The
application is validated, translated and saved to a DOS file.

Note: If errors or warnings are detected, the Exceptions dialog opens
and displays them:

• Errors must be corrected before the download can proceed.

• Warnings should be corrected, but the download will proceed
even if they are not corrected.

6. A dialog appears when the application has been successfully
translated. Select OK  to return to the Message Editor Table View.

Note: Error messages may appear during this download. See
Appendix E for a list of error messages and how to correct the
problems.

The computer’s date and time may be downloaded to the Real Time
Clock (RTC) in the MessageView terminal.

Before downloading the RTC file: 106

• DF1 INTERCHANGE communication driver must be installed
and loaded on the computer. See Page 2–3.

• Driver communication parameters must be checked using the
Workstation Setup command on the File menu. See Page 2–7.

• Cable connections must be correct. See the MessageView
Terminal User Manual (Publication 2706-816) for details.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

To download the computer’s real time clock to a terminal:

Note: An application file does not have to be open when this
command is used.

1. Choose RTC Download from the Application menu to open the
Download Date & Time dialog.

Downloading Date/Time 
to Real Time Clock
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Appears only if DF1
INTERCHANGE
driver installed

Shows drivers
currently loaded.

2. Under Destination, verify that Operator Terminal is selected.
This is the only option available.

3. Select OK . The terminal remains in run mode. Its real time clock
is updated in the background.

When the download is complete, you are returned to the Message
Editor Table View.

Note: Error messages may appear during this download. See
Appendix E for a list of error messages and how to correct the
problems.

The application may be uploaded from the terminal if it needs to be
revised. The upload saves the application to both an MVA file and an
MBA file. Open the MBA file in MessageBuilder for editing.  107

Before uploading an application: 108

• DF1 INTERCHANGE communication driver must be installed
and loaded on the computer. See Page 2–3.

• Driver communication parameters must be checked using the
Workstation Setup command on the File menu. See Page 2–7.

• Cable connections must be correct. See the MessageView
Terminal User Manual (Publication 2706-816) for details.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

Uploading an Application 
from a Terminal



11–11Validating Applications and Transferring Files

Publication 2706-817

To upload an application from a MessageView terminal:

1. Choose Upload from the Application menu.

Shows drivers
currently loaded.

Appears only if DF1
INTERCHANGE
driver installed

2. Under Source, verify that Operator Terminal is selected. This is
the only option available.

3. In the File Name box, enter an MBA file name in which to save
the uploaded application

Or select Browse to search for an existing file which will be
overwritten by the uploaded application file.

4. Select the Setup button to specify which port to use if more than
one of the computer’s COM ports is configured with a DF1
driver. The DF1 Setup dialog lists the available INTERCHANGE
ports. Select the appropriate port and close the dialog.

5. Select OK .

The upload begins. MessageBuilder software displays the
progress of the upload.
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6. A dialog opens asking for the name of the MBA file in which to
save the uploaded application. The default file name is that of the
uploaded application. Enter a file name and path, then select OK .

If the MBA file already exists, a dialog asks if the file should be
overwritten.

7. A dialog verifies that the application file was saved to the
specified MBA file. Select OK  to return to the MessageBuilder
workspace.

C:\AB\MBWIN\SMP-SD.MBA

Note: Error messages may appear during this upload. See Appendix
E for a list of error messages and how to correct the problems.
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The Historical Event Stack file is a log of messages maintained by
the MessageView terminal. It may be uploaded to the computer using
MessageBuilder menu commands. 109

The file is a text file in CSV (Comma Separated Value) format.
Many commercially available software packages, such as text
editors, spreadsheets or databases are able to view, print, analyze or
otherwise manipulate the HE stack data.

Before uploading the HE Stack:

• DF1 INTERCHANGE communication driver must be installed
and loaded on the computer. See Page 2–3.

• Driver communication parameters must be checked using the
Workstation Setup command on the File menu. See Page 2–7.

• Cable connections must be correct. See the MessageView
Terminal User Manual (Publication 2706-816) for details.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

To upload the HE Stack from a MessageView terminal:

Note: An application file does not have to be open when this
command is used.

1. Choose HE Stack Upload from the Application menu.

Shows drivers
currently loaded.

Appears only if DF1
INTERCHANGE
driver installed

2. Under Source, verify that Operator Terminal is selected. This is
the only option available.

3. In the File Name box, enter a file name (8 characters maximum)
with the .CSV extension in which to save the HE stack
information.

Or select Browse to search for an existing file which will be
overwritten by the uploaded file.

Uploading the 
Historical Event Stack
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4. Select Clear Historical Event Stack after successful upload if
you want the HE Stack file in the terminal to be cleared.

Note: If the HE Stack file becomes full, a warning message
informs the terminal operator that it is full. After this message is
acknowledged, the operator may use the Front Panel Editor to
clear the file. If the file is not cleared the oldest messages are
overwritten as new messages are added.

5. If more than one of the computer COM ports is configured with a
DF1 driver, specify which port to use. Select the Setup button.
The DF1 Setup dialog opens with the available INTERCHANGE
ports. Select a port and close the dialog.

6. Select OK  to start the upload. MessageBuilder displays its
progress. The terminal remains in run mode during the upload.

Note: If the HE Stack file in the terminal is empty, the message
“Terminal has no file available” appears in the Status bar.

When the upload is complete, you are returned to the Message Editor
Table View.

Note: Error messages may appear during this upload. See Appendix
E for a list of error messages and how to correct the problems.
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Use the MessageView File Transfer Utility to transfer applications
between a terminal and a computer running Windows. This Utility
was installed as part of the MessageBuilder software installation.
 110

Important:  Applications transferred using this utility must be in
MVA format; that is, they must have .MVA file
extension.

To create an MVA file for downloading, you must download the
MBA application to a DOS file from the Application menu of
MessageBuilder. See Page 11–8. Applications uploaded from a
terminal are already in MVA format.

Before using the MessageView File Transfer Utility:

• DF1 INTERCHANGE communication driver must be loaded and
configured on the computer.

• Cable connections must be correct.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

To start the MessageView File Transfer Utility:

• Double-click the MessageView File Transfer Utility icon in the
MessageBuilder program group to open the utility workspace.

• Or select WINMFT.EXE in the Windows File Manager.

Using the MessageView 
File Transfer Utility
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In the MessageView File Transfer Utility, applications and data may
be downloaded/ uploaded either from the Toolbar or from the File
menu.

Click: or Choose: To:

Application Upload
Upload an application from a MessageView
terminal to an MVA file.

The MVA file can be opened as an MBA file in
MessageBuilder for editing.

Application Download
Download an MVA file to a MessageView
terminal.

To create an MVA file, download the
application to a DOS file. See Page 11–8.

Application Verify
Compare the application in the terminal with
the application to be downloaded, to
determine if they are the same or different.

HE Stack Upload
Upload the Historical Event Stack from a
MessageView terminal.

RTC Download
Download the date and time from the
computer to the MessageView terminal’s Real
Time Clock.

Exit Exit the MessageView File Transfer Utility.

Note: All Download and Upload dialogs are identical to the dialogs
accessed from the Application menu in MessageBuilder software.
The only dialog that is different is the Application Verify dialog.

Error messages

Error messages may appear while the File Transfer Utility is
downloading or uploading files. See Appendix E for a list of error
messages and how to correct the problems.
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Verifying an Application when using the File Transfer Utility

Use the Verify command to compare an application with the
application loaded in a specific terminal. You might want to
download an application only if it is different from the one installed.
The verification process checks whether the applications match.

Note: This Verify command is different from the Validate command
which is part of the Application Download from MessageBuilder
software. See the Glossary.

To verify an application:

1. Click the Verify tool.

Or choose Application Verify from the File menu.

Shows drivers
currently loaded.

Appears only if DF1
INTERCHANGE
driver installed

2. Under Source, Operator Terminal is the only option available.

3. In the File Name box, enter the name of an MVA file that you
want to verify.

Or select Browse to search for an existing MVA file.

4. Select OK  to open the Application Verification dialog.

When done, the dialog shows whether the applications match or not.
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Allen-Bradley may send a new version of MessageView terminal
firmware to registered users. For most efficient terminal operation,
upgrade the firmware in each of your terminals as soon as possible.

Before upgrading the terminal: 111

• DF1 INTERCHANGE communication driver must be installed
and loaded on the computer, see Page 2–3.

• Driver communication parameters must be checked using the
Workstation Setup command on the File menu. See Page 2–7.

• Cable connections must be correct. See the MessageView
Terminal User Manual (Publication 2706-816) for details.

• The MessageView terminal must have its RS-232 port set to
MessageBuilder communication parameters. See Page 5–3 for
an example of how to switch settings.

To install a firmware upgrade in a MessageView terminal:

1. Choose Upgrade Terminal on the File menu. A dialog warns that
the current application will be erased from the terminal.

2. Select Yes. Downloading begins. MessageBuilder software
displays the progress of the download.

Note: The application resident in the terminal was erased as soon
as the Firmware Download started. Even if the download is
cancelled, the application is gone. If the terminal is switched to
Run mode, its startup self-tests will report that there is no valid
application.

3. Download an application, see Page 11–6.

Terminal Upgrade
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This chapter covers the following topics:

• Types of reports

• Creating and printing a report

• Changing the report setup

• Previewing a report

• Setting up a printer

• Sending a report to a file.

MessageBuilder lets you specify the types of information to include
in a report.

Report Options Description

Description
Includes the first page of the application description
as entered in the Application Description dialog.

Messages Lists all messages in the application.

Message Attributes
Lists attributes of all messages in the application.
Messages are listed in order of their message
numbers.

Terminal Setup
Lists runtime communications and setup parameters
for MessageView terminals.

Tag Attributes Lists all tag definitions in the application.

Function Keys
Lists all function keys used in the application and
their attributes.

LED Indicators
Lists all function key LEDs used in the application
and their attributes.

Types of Reports
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Use the Reports command to create a customized report
documenting all or specific aspects of an application. Reports are
useful for tracking application updates and changes. 112

To set up a report:

1. Choose Reports from the File  menu to open the Report Setup
dialog.

2. Select the application components to include in the report by
selecting the appropriate check boxes under Application . To
remove a component, clear the box.

3. Indicate which messages will be included in the report.

• Select All  to include all messages.

• Select From to include a range of messages. Enter the range of
message numbers in the From and To boxes.

4. Select the Graphic Images check box to include ISA graphics
embedded in messages in the report. To clear this option, select
the box again.

5. From the Topics list box, specify whether you want to include
messages assigned to a specific topic or all messages. The default
is All.

Press this button: To:

Print
Send report to a printer or file. Select Cancel at
any time to abort printing of the report.

Cancel Exit dialog without printing the report.

Report Setup Change page headers and title page of the report.

Print Setup Define printer settings for the report.

Preview Preview how the report will look.

Save Settings Save current report settings as the default.
Otherwise the dialog reverts to the original
settings when closed.

Creating and Printing 
a Report
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Specify the page headers and the title page of a report.

To change the page headers and title page:

1. Select the Report Setup button from the Report Setup dialog to
open another Report Setup dialog.

2. By default, all options are selected. If some are not needed, select
the appropriate check boxes in each area. To enable an option,
select the box again.

Select: To Print:

Application Name The name of the application.

Time
Time of printout in 24-hour format:
Hour/Minute/Second.

Date
Date of printout:
Month/Day/Year.

Page Number Consecutive page numbers. Title page is 1.

User Defined Text Up to 80 characters including spaces.

3. When done, select the OK  button.

The next page shows where each option appears in the page header
and title page of a report.

Changing the Report
Setup



12–4 Creating Reports

Publication 2706-817

The title page is the first page printed in a report.

MessageBuilder Application Report

ACTT4:ACTT4.MBA

Application Version:9 – Last Saved 11/20/95 08:51:54

11/20/95  12:03:15

[User Defined Title Text]

Project : Application Name

Date and Time when 

User Defined text

Report was Generated

Version and Save 
Information

Header information appears on every page of a report except the title
page.

10/09/95  12:03:15
                                     ACTT4                   Page 2

Application Name

Date and Time when

User Defined text

Page Number

Report was Generated

[User Defined Page Text]
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The Preview option lets you view a report before printing it or
sending it to a file. You can then make the necessary adjustments
before printing it.

To preview a report:

1. Select the Preview button in the Report Setup dialog .

The Preview workspace opens showing the title page of the
report.

2. Select one of the following buttons at the top of the workspace.

Press this button: To:

Print
Open a Print dialog allowing you to print all or
specific pages of the report.

Next Page View the next page of the report.

Previous Page View the previous page of the report.

One Page View the report one page at a time.

Two Page View the report two pages at a time, side by side.

Zoom In
Increase the magnification of the view so the
report looks larger. You can increase the
magnification several times.

Zoom Out
Decrease the magnification of the view so the
report looks smaller.  You can decrease the
magnification several times.

Close
Exit the Preview workspace and return to the
Report Setup dialog.

Previewing a Report
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To print a report:

• A printer must be connected to your computer.

• The computer must recognize the printer as a valid printer.

See your Microsoft Windows User’s Guide for details on installing
printers.

To set up the printer:

1. Select the Printer Setup button in the Report Setup dialog to
open the standard Windows Print Setup dialog.

2. If the default printer is not the one in use, select a printer from the
Specific Printer list box.

If it is not listed, see below.

3. Set appropriate attributes for the printer.

4. Select the Options button to fine-tune the printer.  The Options
dialog is different for each type of printer.

5. When done, select the OK  button.

6. Select the Print  button from the Reports Setup dialog to print the
report.

7. Select Close to return to the Message Editor Table View.

If the printer connected to the computer is not listed:

1. Check for hardware compatibility between the printer and one of
the printers listed.

2. Check if your printer has an emulation mode that is compatible
with one of the printers listed.

3. It may be necessary to install a printer driver for your printer.
Refer to the Windows User’s Guide.

Setting up a Printer
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To send a report to a file, is is necessary to:

• add the Generic/Text Only printer to the Installed Printers list

• connect the printer to a FILE: port.

For details on how to add Generic/Text Only on FILE: to the
Installed Printers list on your computer, see the Microsoft Windows
User’s Guide. This printer driver allows you to print text but not
graphics.

To send a report to a file:

1. Select the Printer Setup button in the Report Setup dialog to
open the standard Windows Print Setup dialog.

2. Select Generic/Text Only on FILE: from the list of Specific
Printers. If it is not listed, it must be installed first.

3. Select OK  to exit the Printer Setup dialog.

4. Select the Print  button in the Report Setup dialog to open the
Print to File dialog.

5. Enter the name of the file in which to save the report.

The default directory is C:\AB\MBWIN\.

6. Select OK  to print the report to a file.

If the file name already exists, a dialog gives the option of
overwriting it or of entering another file name.

Select Cancel at any time to abort the printing.

7. Select Close to return to the Message Editor Table View.

Sending a Report to a File
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Use commands on the File menu to handle application files.

New...

Opens a dialog for creating a new application file for a specific
MessageView terminal.

Open...
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Close

Closes the current application file.

Save

Saves the application file and replaces the previous version stored on
disk. 

Save As...

Saves a copy of the application file with all its changes under a new
name. The original file remains intact. 

Reports...

Opens a dialog to generate a customized report for an application
using the default or user defined format. Reports can be printed or
saved to a file. 

Workstation Setup ...

Accesses the INTERCHANGE Configuration Utility to configure
serial communications required for transferring files to and from a
MessageView 421 terminal.

Upgrade Terminal...

Opens a dialog to load updated firmware in a MessageView terminal.

1 XXX.MBA

The four applications opened most recently are listed here for
convenient access. 1 is the most recent or current application.

File Menu
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Exit

Quits MessageBuilder and returns to the Windows desktop. If an
application is open, a dialog asks if it should be saved first.

Use commands on the Edit menu to manage messages and their
attributes.

Undo

Reverses the most recent edit operation: cut, copy, paste, delete.

Redo

Reverses the previous Undo operation(s).

Cut

Removes a selected text string from the Message Edit box, or
removes a selected message from the application. Anything cut is put
on the clipboard, where it remains until something else is copied or
cut, or until Windows is closed.

Copy

Copies a selected text string from the Message Edit box, or copies a
selected message from the application. Anything copied is put on the
clipboard, where it remains until something else is copied or cut, or
until Windows is closed.

Paste...

Copies a text string from the clipboard to the cursor position in the
Message Edit box, or a message to the application. Whatever is on
the clipboard may be pasted as often as needed.

Delete Message

Removes selected message(s) from the application.

Insert Message

Creates a new message above the currently selected message.

New Message

Appends a new message after the last message.

Edit Menu



Menus and Commands Summary A–3

Publication 2706-817

Find...

Opens a dialog to locate any message in the application by message
number, topic, text, or trigger.

Replace...

Opens a dialog to replace a text string with another text string, in any
or all of the messages in which the text string is found.

Sort...

Opens a dialog to sort all messages in the application by message
number, topic, text, or trigger.

Renumber...

Opens a dialog to set the number of the first message and renumber
in sequence all messages that follow.

Topics...

Opens a dialog to define a text string for each topic used in the
application.

Use commands on the View menu to toggle window bars and the
toolbox on or off. Click the menu name to toggle the command. A
check mark (�) next to a command means the command is active. 

Tool Bar

Toggles the toolbar on or off.

Status Bar

Toggles the status bar on or off. 

Zoom

Opens a dialog to enlarge or reduce the size of the Message Editor
Terminal View.

View Menu
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Use commands on the Format menu to change the appearance of
message text, and to enter display and entry variables.

Text Size � Quarter 
Half 
Full

Sets the size of the text in the message. 

Align � Left 
Center

Toggles between centered and left justified. 

Flash

Toggles between flashing and non-flashing for the highlighted text in
the Edit Box.

Inverse Video

Toggles between inverse video and normal text for the highlighted
text in the Edit Box.

Time Display

Enters a placeholder in the message that will display the current time
in the MessageView terminal.

Date Display

Enters a placeholder in the message that will display the current date
in the MessageView terminal.

Numeric Variable Display...

Enters a placeholder in the message that will display a numeric
variable in the MessageView terminal.

ASCII Variable Display...

Enters a placeholder in the message that will display a variable that
contains ASCII characters in the MessageView terminal.

Numeric Variable Entry...

Enters a placeholder in the message that allows the terminal operator
to input a numeric value. 

Format Menu
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ASCII Variable Entry...

Enters a placeholder in the message that allows an ASCII Input
device to send alphanumeric characters to the terminal. Valid only in
applications designed for terminals with a Remote I/O daughterboard
and firmware that supports ASCII Input.

ASCII Control Char...

Enters an ASCII Control Character in the message.

Graphic...

Enters an ISA graphical symbol in the message.

Edit Variable...

When a variable in the message is selected, opens the dialog for that
type of variable.

Enable Function Key...

When the application is designed for a MessageView 421F terminal,
allows specific function keys to be enabled in the message.

Use commands on the Application menu to validate, download and
upload an application, edit function key and special message
attributes, and set runtime parameters for the MessageView terminal.

Tag Editor...

Opens the Tag Editor to view, add or edit tag information for an
application. Tag information is specific to the communication
protocol that the application will use. 

Project Management...

Opens the Project Management dialog to manipulate (display, create,
copy, rename, delete) projects and to manipulate (create, copy,
rename, delete) devices in projects. 

Description...

Opens a dialog to enter an application description and change the
application name. Also shows when the last version of the
application was saved. 

Validate..

Checks the entire application for potential problems. This command
allows the designer to make necessary corrections before
downloading is attempted.

Application Menu
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Download...

Downloads an application to a MessageView terminal or a DOS file.
Download to a terminal uses DF1 point to point protocol through a
connection at the RS-232 COM port.

Upload...

Uploads an application from a MessageView terminal. 

RTC Download...

Sends the computer’s time and date to the terminal to update its Real
Time Clock.

HE Stack Upload...

Uploads the Historical Event Stack file from the terminal to a file in
CSV format.

Terminal Setup...

Sets runtime communication and operating parameters for the
MessageView terminal.

Special Messages...

Assigns bit triggers or other tags to special messages used in the
application.

Function Keys...

If the application is designed for a MessageView 421F terminal, sets
the function key attributes.

LED Indicators...

If the application is designed for a MessageView 421F terminal,
assigns the LED indicator tags.

Preferences...

Allows the user to specify whether messages should be validated
individually when they are created or edited, and what colors should
be used in the Message Edit box to distinguish Flashing Text and
Embedded Text.
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Use commands on the Window menu to arrange application message
tables and icons to suit, and to toggle between table and terminal
view of messages.

The bottom of the Window menu displays a list of open views of the
current application file. A check mark (�) next to a window name
means the window is active.

Cascade

Arranges open windows in the workspace so that they overlap each
other, with the title bar of each screen remaining visible.

Tile

Arranges open windows in a vertical row in the workspace.

Arrange Icons

When some of the open windows are minimized to icons, spaces
them evenly along the bottom of the workspace so they do not
overlap.

New Window

Opens a new Message Editor Table View dialog.

Exceptions...

Opens the Exceptions dialog which displays errors detected during
application validation. Use this dialog as a reference while correcting
errors.

Table View

Brings focus to the Message Editor Table View.

Terminal View

Brings focus to the Message Editor Terminal View with the current
message displayed.

1 Project: Application.MBA

A list of all applications and all views currently open in the
workspace. The active window is checked.

Window Menu
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Use commands on the Help menu to access the MessageBuilder
Online Help utility.

Contents...

Displays an index to online Help.

Search for Help On...

Provides a list of Help topics available online.

How To Use Help...

Provides a short tutorial and other information about using
MessageBuilder Help.

About MessageBuilder...

Displays copyright and release information about MessageBuilder.
Use the version number and serial number on this screen if you need
to call Allen-Bradley for help. 

Use commands on the Project menu to print the Tag Editor or
selected parts of it.

Print...

Selects which tags to print and sets up the page and the printer.

Page Setup...

Sets up the format for printing tags.

Exit

Exits the Tag Editor.

Use commands on the Edit menu to edit tags and their attributes
(fields).

Cut

Removes a selected field or fields from the tag, or removes a
selected tag or tags from the Tag Editor. Anything cut is put on the
clipboard. 

Copy

Copies a selected field from a tag, or copies a selected tag from the
Tag Editor. Anything copied is put on the clipboard.

Help Menu

Project Menu (Tag Editor)

Edit Menu (Tag Editor)
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Paste Row, Paste Field

Places a field from the clipboard at the cursor position, or places a
tag at the position above the cursor. Whatever is on the clipboard
may be pasted as often as needed.

Delete

Removes the selected tag(s) from the Tag Editor.

Insert

Creates a new blank tag above the currently selected tag.

Find...

Locates a tag or tags with a specified name.

Duplicate Once

Duplicates the selected tag once and places the new tag above the
selected tag. 

Duplicate Several

Duplicates the selected tag several times and places the new tags
above the selected tag. The number of duplicates is set in the
Duplications box on the Toolbar or using the Duplication command
on the Options menu.

Use commands on the View menu to rearrange the tags and toggle
the tool and status bars.

Tool Bar

Toggles the Tag Editor tool bar on or off. 

Status Bar

Toggles the Tag Editor status bar on or off. 

Sort...

Sorts tags by any field or fields.

Form...

Opens the Tag Form for the selected tag.

Summary

Opens the Tag Editor Table View.

View Menu (Tag Editor)
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1 BCD/Integer

Filters the tags to display all tags with value data type.

Use commands on the Options menu to set Tag Editor options.

Duplication...

Sets the options for number of duplicates to be created with the
Duplicate Several command on the Edit menu, and sets the format
for names of duplicated tags.

Address Validation

Toggles address validation on and off.

Use commands on the Tools menu to import or export tags from a
file in a different format.

List Editor

Opens a new Tag Editor Table View.

Form Editor

Opens the Tag Form for the selected tag.

Import

Opens a dialog for importing tags from files in different formats.

Export

Opens a dialog for exporting tags to files in different formats.

Use commands on the Window menu to arrange Tag Editor windows
and icons to suit, or to close all windows.

The bottom of the Window menu displays a list of open Tag Editor
windows. A check mark (�) next to a window name means the
window is active.

New

Opens a new window with the Tag Editor Table View.

Refresh

Updates the Table View to reflect changes made in a Form View.

Options Menu (Tag Editor)

Tools Menu (Tag Editor)

Window Menu (Tag Editor)
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Cascade

Arranges open Tag Editor views so that they overlap each other, with
the title bar of each screen remaining visible.

Tile Horizontal

Arranges open windows in a horizontal row in the workspace.

Tile Vertical

Arranges open windows in a vertical row in the workspace.

Arrange Icons

Spaces icons evenly along the bottom of the workspace so they do
not overlap.

Close All

Closes all the Tag Editor windows.

1 Project: View

A list of all views currently open in the Tag Editor. The active view
is checked.

Use commands on the Help menu to access the Tag Editor Online
Help utility.

Contents

Displays an index to online Help.

About...

Displays copyright and release information about the Tag Editor.

Help Menu (Tag Editor)
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This appendix contains a brief description of all MessageBuilder
tools on the Standard Toolbar, Message Edit Toolbar and Tag Editor
Toolbar. Certain tools cannot be applied in some fields of the dialog;
the icons are greyed out when those fields are selected.

File Tools

New File

Creates a new application file.

Open File

Opens an existing application file.

Save File

Saves an application file to disk.

Edit Text Tools

Cut

Cuts the selected text string or an entire message from the Edit box
and places it on the clipboard.

Copy

Copies the selected text string or an entire message from the Edit box
to the clipboard.

Paste

Pastes the contents of the clipboard at the cursor position in the Edit
box. If text is highlighted, the pasted text replaces it.

Undo

Reverses the last edit operation in a message.

Redo

Reverses an Undo.

Standard Toolbar
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Windows Tools

Terminal View

Displays the front face of the MessageView terminal that the
application is designed for.

Table View

Displays the main MessageBuilder Table View dialog.

Application Tools

Terminal Setup

Opens the Terminal Setup dialog, to configure the MessageView 421
terminal.

Download

Opens the Download Application dialog.

View Tools

Zoom In

Increases the Terminal View to the next higher magnification. May
be repeated twice.

Zoom Out

Reduces the Terminal View to the next lower magnification. May be
repeated twice.

Help Tools

Help Contents

Displays an index to Help topics.

Help Question

Changes the cursor arrow to a question mark. Click the question
mark on an item to get context-sensitive online help.



Tool Summary B–3

Publication 2706-817

Message Edit Tools

Insert Message

Inserts a new message with default text before the current
highlighted message.

Append Message

Appends a new message with default text after the last message in
the list. 

Delete Message

Permanently deletes the highlighted message from the Message List. 

Cancel Changes

Removes any changes in the Edit box since the last Store Message.

Store Message

Copies the message in the Edit box to the highlighted row in the
Message List.

Message Edit box

Displays the text of the highlighted message so it can be edited.

Formatting Tools

Flash

Sets highlighted text, graphics or variables to flash on/off when the
message is displayed by the MessageView terminal.  

Inverse Video

Sets highlighted text, graphics or variables in reversed video. 

Embedded Variable

Opens a menu to insert a variable, ASCII control character or
graphic in a message at the cursor position. If a variable is selected,
opens the dialog to edit that type of variable.

Enable Function Key

Opens the Enable Function Key dialog to specify which function
keys are enabled for the current message.

Left Justify

Aligns a message at the left side of the display. Toggles with Center. 

Message Editor Toolbar
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Center

Centers a message in the display. Toggles with Left Justify.

Many of the Tag Editor tools are the same as in the Message Editor
dialog. Certain tools cannot be applied in some fields of the dialog;
the icons are greyed out when those fields are selected.

Print

Opens the Print dialog, with Printer and Page Setup dialogs
available.

Cut

Cuts the selected field or row and places it on the clipboard. 

Copy

Copies the selected field or row to the clipboard.

Paste

Pastes the contents of the clipboard at the cursor position.

Insert Tag

Inserts a blank tag above the cursor position, no matter what field the
cursor is in. 

Delete Tag

Removes the highlighted tag. If only a field is selected, the icon is
greyed out. 

Find Tag

Opens a dialog from which each tag of a specified name can be
found.

Duplicate Tag Once

Duplicates the selected tag once and places the new tag above the
selected tag.

Duplicate Tag Several Times

Duplicates the selected tag several times and places the new tags
above the selected tag. The number of duplicates is set using the
Duplications box in the tool bar.

Tag Editor Toolbar
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Form View

Opens the Form View dialog for the selected tag.

Table View

Opens a copy of the Tag Editor Table View.

Duplications

A text box which displays the number of duplicate tags the Duplicate
Several command or icon will create. 
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ISA symbols are a standard set of graphics that illustrate various
types of manufacturing tools. They are illustrated and named in the
Select Graphics dialog box.  113

Use them to help the operator visualize the operation controlled by
specific messages.

 1: Horizontal Valve with Actuator

 2: Horizontal Valve with Throttling Actuator

 3: Horizontal Valve with Manual Actuator

 4: Vertical Valve with Actuator

 5: Vertical Valve with Throttling Actuator

 6: Vertical Valve with Manual Actuator

 7: Butterfly Valve

 8: Check Valve

 9: Relief Valve

10: Liquid Filter

11: Vacuum Filter

12: Motor

13: Transformer

14: Vessel

15: Reactor

16: Storage Bin

17: Distillation Tower

18: Pressure Storage Vessel

19: Weight Hopper

ISA Symbols



Tool Summary B–7

Publication 2706-817

20: Pump

21: Turbine

22: Blower

23: Compressor

24: Agitator

25: Conveyor

26: Screw Conveyor

27: Inline Mixer

28: Rotary Feeder

29: Exchanger

30: Furnace

31: Rotary Kiln

32: Cyclone Separator
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This appendix lists messages that may appear while creating or
editing an application. Messages are listed alphabetically.

For messages that may appear during validation, see Appendix D.
For messages that may appear during a download, see Appendix E.
For messages that may appear during a tag import or export, see
Page 8–22.

Message Meaning What to do

AB Utilities error creating project
The project could not be created. Cause
could be a full disk or a write-protected
network partition.

Check available disk space.
Verify the computer’s write privileges if it is on
a network.

AB Utilities failed to initialize
MessageBuilder could not initialize Utilities
during startup because SHARE.EXE is not
running.

MessageBuilder installation should add
SHARE.EXE to the AUTOEXEC.BAT file. See
the RELEASE.TXT file in C:\AB for more
details.

Cannot delete project associated with current
application.

The project belonging to the current
application cannot be deleted.

Reassign the current application to another
project, then delete the project.

Cannot find desired terminal in Terminal
catalog.

The CATALOG.DAT file is missing or
corrupted. This file stores the terminal type
that is selected when creating a new
application or changing the application to fit a
different terminal type.

Contact A-B technical support.

Cannot find or cannot load the Application File
Transfer Utility.

The WINMFT.EXE executable failed to load.
Verify that WINMFT.EXE is in the same
directory as MBWIN.EXE. If it is not there,
reload the file from the installation disk.

Cannot initialize print device. Printer could not be initialized. Check the Print Setup settings and try again.

Cannot load the data for tag: [tag name]. Internal error.
Check tag information. Contact A-B technical
support if error continues.

Cannot locate tag: [tag name]. Internal error.
Check tag information. Contact A-B technical
support if error continues.

Cannot parse address for tag: [tag name]. Internal error.
Check tag information. Contact A-B technical
support if error continues.

Cannot perform terminal conversion. The
following message(s) have function keys
enabled: Message(s): [number], [number] ...

The application is being converted to a
Terminal that does not have Function Keys.
One or more messages has Function Keys
Enabled.

Remove all the messages that have Function
Keys enabled from the Application.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Cannot perform terminal conversion. The
following message(s) have Numeric Variable
Entry fields: Message(s): [number], [number]
...

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Attempting to convert an application from a
421N or 421F terminal to a 421D terminal.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Remove Numeric Entry variables from all
messages listed.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Cannot perform terminal conversion. The
following message(s) have ASCII Variable
Entry  fields: Message(s): [number], [number]
...

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Attempting to convert an application from a
terminal with a daughterboard to one without
a daughterboard.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Remove ASCII Entry variables from all
messages listed.
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Message What to doMeaning

Cannot print line.
Failed to send a text string. This may be a
printer error. The printout is terminated.

Check the Print Setup settings, Print Spooler
settings and the printer.

Cannot print text string.
Failed to send a text string. This may be a
printer error. The printout is terminated.

Check the Print Setup settings, Print Spooler
settings and the printer.

Cannot read the Terminal Catalog datafile.

The CATALOG.DAT file is missing or
corrupted. This file stores the terminal type
that is selected when creating a new
application or changing the application to fit a
different terminal type.

Call A-B technical support.

Data format unknown for tag: [tag name]. Internal error.
Check tag information. 
If error persists, call A-B support.

Enter tag name before pressing Edit Tag
button.

A tag must be named before it can be edited. Enter tag name.

Environment variable ABIC_CONFIG not
defined.

The DOS environment variable
ABIC_CONFIG is required for the
INTERCHANGE comm. drivers to work
properly. It is not defined.

Edit the AUTOEXEC.BAT FILE to add the
ABIC_CONFIG variable to specify the location
of the INTERCHANGE comm. drivers and the
configuration utility, or reinstall
MessageBuilder software.

File Error – Cannot find ISPCORE.DLL.
MessageBuilder software would not start
because the default path C:\AB\BIN is missing
from AUTOEXEC.BAT file.

Check the AUTOEXEC.BAT file for the path.

Firmware Version is the same - no need to
load new.

The firmware in the Terminal is the same as
the firmware in the Terminal Upgrade
database.

No action is necessary.

Font file name not found in MBWIN.INI -
Corrupt or missing INI file.

Essential MessageBuilder startup information
cannot be acquired. The MBWIN.INI is corrupt
or missing.

Check the \windows\system\ directory for a
valid MBWIN.INI file. Reinstall
MessageBuilder software.

Incompatible AB Utilities version.
MessageBuilder software detected an
incorrect version of the Utilities software on
startup.

Reinstall the AB Utilities disk, or call
Allen-Bradley for support.

Insufficient available Windows resources to
run this application. Try closing some other
applications and try again.

Too many applications are running. Close all running applications and try again.

INTERCHANGE Configuration Utility not
found at [DOS path]. Check ABIC_CONFIG
environment variable.

The InterChange Configuration Utility can not
be found at the DOS path location that is
specified by the variable ABIC_CONFIG.

Check that CFGIC.EXE exists at a location
that is consistent with the path specified by
ABIC_CONFIG. Reinstall MessageBuilder
software.

Low resource memory. Low memory error.
Close other applications and try again. 
If error persists, exit Windows, reboot the
computer, try again.

Low resource memory.
Unable to open additional windows.

Low memory error.
Close other applications and try again.
If error persists, exit Windows, reboot the
computer, try again.

MessageBuilder version [nn.nn] is not
compatible with the version of CMSERV.DLL
that is currently in memory. MessageBuilder
will exit.

Conflict between MessageBuilder and
PanelBuilder DLL files.

Exit PanelBuilder to unload the DLL and then
restart MessageBuilder before restarting
PanelBuilder.

MessageBuilder version [nn.nn] is not
compatible with the version of CTKRIO.DLL
that is currently in memory. MessageBuilder
will exit.

Conflict between MessageBuilder and
PanelBuilder DLL files.

Exit PanelBuilder to unload the DLL and then
restart MessageBuilder before restarting
PanelBuilder.
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Message What to doMeaning

MessageBuilder version [nn.nn] is not
compatible with the version of WPFTDLL.DLL
that is currently in memory. MessageBuilder
will exit.

Conflict between MessageBuilder and
PanelBuilder DLL files.

Exit PanelBuilder to unload the DLL and then
restart MessageBuilder before restarting
PanelBuilder.

No default printer.
Use Control Panel to install and select a
default printer.

A default printer has not been configured.
See the Windows user manual for details on
how to install and select printers.

Not enough resource memory to open dialog. Low memory error.
Close other applications and try again. If error
persists, exit Windows, reboot, and try again.

Out of memory.
Close other applications and try again.
Otherwise select Cancel to quit.

Attempt to allocate additional memory has
failed.

Close other Windows applications and try
again. If this is unsuccessful, MessageBuilder
exits.

Print manager failed. Error received from print manager (spooler). Check print spooler for possible errors.

Printer setup failed. Error occurred during printer setup.
Check validity of the print driver. Reload driver
is necessary.

Project does not exist. There is no project of that name. Select another project name.

Project exists. Entered a project name that already exists.
Enter another project name, or use the
existing project.

The input file is not a MessageBuilder
application file. Please select a new data file.

The file is not a MessageBuilder Application
file and is not compatible with
MessageBuilder.

Enter a different file name and retry.
MessageBuilder Application files typically
have the extension MBA or MVA.
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This appendix lists messages that may appear while validating an
application, whether on command or automatically before
downloading. Messages are listed alphabetically.

For messages that may appear during creation or editing of an
application, see Appendix C. 
For messages that may appear during a download, see Appendix E.
For messages that may appear during a tag import or export, see
Page 8–22.

Message Meaning What to do

[Terminal Setup] Terminal selected in Terminal
Setup does not match Application Type.

The selected catalog number does not match
that of the application.

Change the catalog number using the
Terminal Setup dialog to change the MV Type
and Catalog and Version controls to match
that of the application, or press OK to the
Terminal Setup dialog to convert the
application to match the selected terminal
type.

Background message [number] doesn’t exist.
The assigned Background message is not
defined.

Define the Background message or disable
background message with the Terminal
Setup/Advanced dialog.

Bit Trigger Number [number] duplicated
[number] times.

The bit trigger numbers for all messages in an
application are not unique.

Use the Bit Trigger control on the Message
Editor Table View to change the bit number or
delete the offending message to insure that
bit trigger numbers are unique.

Bit Trigger Priority mismatch with undefined
Bit Triggered Messages.

Bit triggering is assigned priority over Value
triggering yet there are no Bit Trigger enabled
messages in the Application.

Use the Trigger Priority control on the
Terminal Setup/Advanced dialog to change
the priority to Value.

Bit Trigger Tag missing or tag not assigned.
The application has one or more messages
that has bit triggers enabled; however the Bit
Trigger Tag is undefined for the Application.

Change all message to value triggers or use
the Terminal Setup/Control Tags dialog to
define a Bit Trigger for the Application.

Chain-To-Message number greater than the
maximum allowed.

The message is chained to a non-existent
message.

Use Chain control on the Message Editor
Table View to disable the chain or alter the
“To” message number to select a different
existing message.ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Checking Msg [number] for unsupported
features.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁDisplay variable storage size is greater than

100 characters. Reduce the tag sizes of
display variables.

The combined tag array sizes for the
embedded ASCII Variable Display variables in
the message exceed 100 characters.

Use the tag editor to reduce the array size of
the tags assigned to the embedded ASCII
Variable Display variables in the message.

Duplicate Message Number within
Application.

The message number for all messages in an
Application are not unique.

Renumber or delete the offending message to
insure that message numbers are unique.

Duplicate RTC Date Variables within
message.

The message has more than one embedded
Date variable. One is permitted per message.

Remove all but one Date variable.

Duplicate RTC Time Variables within
message.

The message has more than one embedded
Time variable. One is permitted per message.

Remove all but one Time variable.
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Message What to doMeaning

Embedded ASCII Character 13 is not allowed.
The embedded ASCII Character of value 13
is not allowed for slaving messages.

Remove or change the value of the
embedded ASCII character 13 by selecting
the embedded ASCII character in the
message and pressing the Delete key, or
selecting the Format/Edit Variable Dialog.

Embedded ASCII Entry Tag array size must
be greater than ASCII Entry variable field
width.

The assigned tag array size is smaller than
the display field width. Operator input cannot
be completed without a large character array
defined.

Use the tag editor to change the tag array
size.

Embedded Carriage-Return not allowed with
“Full” size text.

The message with “Full” attribute can not
contain embedded Carriage-Return.

Use the Message Editor Table view to change
the text size or remove the embedded
Carriage-Return from the message.

Embedded Display Variables are not allowed
in Chained message [number], chained from
message [number].

Applications can not support embedded
displayable variables in a chained-to
message.

Resolve the conflict by chaining to a different
message or removing the embedded display
variables in the chained-”To” message.

Embedded Display Variables are not allowed
in the Background message.

The Background Message assigned that has
embedded display variables is not allowed.

Change or disable the Background Message
in the Terminal Setup/Advanced dialog or
remove the embedded display variables from
the message.

Embedded Display Variables are not allowed
in the Startup message.

The Startup Message assigned that has
embedded display variables is not allowed.

Change or disable the Startup Message in the
Terminal Setup/Advanced dialog or remove
the embedded display variables from the
message.

Embedded Entry Write Tag used but not
defined.

The tag is undefined in the project database. Use the tag editor to define the tag.

Embedded Graphic 13 is not allowed in slave
messages.

The embedded Graphic symbol number 13 is
not allowed for slaving messages.

Remove or change the value of the
embedded Graphic number 13 by selecting
the embedded Graphic in the message and
pressing the Delete key or selecting the
Format/Edit Variable Dialog.

Embedded-Carriage-Return not allowed
without All attribute set.

Embedded Carriage-Return requires “All”
attribute enabled.

Use the Message Editor Table view to change
the Line attribute to “ALL” or remove the
embedded Carriage-Return from the
message.ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Error: Msg [number] Numeric Variable Entry is
not supported by terminal type.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

The terminal is a 421D type.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Remove Numeric Entry variables from the
messages listed. Or if practical change the
application to a different terminal type.

Error: “Return Message Number to PLC”
checked in the Advanced dialog requires Msg
Tags Return Number, Ack Tags Return
Number or FKey Tag Return Number be
defined.

An appropriate return message number tag
must be defined if Return Message Number
to PLC option is selected.

Remove the Return Message Number to PLC
option in the Terminal Setup/Advanced dialog
or define a return message number tag in the
Terminal Setup/Control Tags dialog.

Field width of Entry is larger than the width of
the display.

An entry is not allowed to be wider than the
displayable area.

Reduce the embedded Variable Entry Field
width or increase the display width by making
the message Text Size Half or Quarter.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Function Key Write Tag missing or tag not
assigned.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

The Function Key Write Tag is undefined for
one or more Function Keys that are enabled
in the Application.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Use the Function Key dialog to define a Write
Tag for each Function Key that is enabled in
the Application.

Graphic does not display properly on the end
of the line.

The defined message cannot be displayed
properly.

Reformat the message by deleting
characters, or enable the scrolling attribute.
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If “Enable Message Queue” is checked Value
Trigger Tag must be defined.

The Message Queue option was selected but
only Value Triggered messages can utilize the
Message Queue.

Disable the Enable Message Queue option in
the Terminal Setup/Advanced dialog or define
a value trigger tag in the Terminal Setup/
Control Tags dialog.

Invalid Ack attribute for message with
Embedded Entry Variables.

Not more than one operator action can be
required per message.

Resolve the conflicting attributes. Disable the
Ack attribute for a message with entry
variables.

Invalid Ack attribute with Hidden Message
attribute assignment.

A hidden message can not support any
operator actions.

Resolve the conflicting attributes. Disable the
Ack attribute for a hidden message.

Invalid Ack Time attribute with Ack attribute
assignment.

Ack Time is enabled for a message that is not
Ack enabled.

Resolve the conflicting attributes. Disable the
Ack Time attribute for a non-Ack message.

Invalid Ack Time attribute with Hidden
Message attribute assignment.

Hidden messages can not be acknowledged.
Resolve the conflicting attributes. Disable the
Ack Time or Hidden Message attribute for
message.

Invalid Any line attribute with hidden and
slave attributes.

A message with Line attribute “Any” can not
be hidden and slaved.

Resolve the conflicting attributes. Disable the
Hidden or Slave message attribute or change
the Line message attribute.

Invalid Auto Clear attribute with Wait Time
zero and Scroll attribute not assigned.

The message is invisible.
Disable selection of the Auto Clear attribute or
increase the Wait Time.

Invalid Block Transfer Table - Block [number]
has an invalid direction.

The enabled block transfer block must have a
direction.

Use the Communication Setup Block Transfer
dialog to define the direction.

Invalid Block Transfer Table - Block [number]
has an invalid length.

The block transfer length is illegal.
Use the Communication Setup Block Transfer
dialog to define the proper length.

Invalid center attribute with HE stack and
hidden attributes and no slave enabled
attribute.

Message that are only Historical Event
Stacked can not be centered.

Resolve the conflicting attributes. Disable the
Center Message attribute for messages that
are only Historical Event Stacked.

Invalid embedded ASCII char without slave
enable attribute.

Embedded ASCII characters are defined in a
message without the Slave Attribute enabled.

Select Slave Enable attribute or delete the
Embedded ASCII characters.

Invalid embedded ASCII character with no
other displayable characters in message.

The message defined is invisible on the
terminal.

Define the message with displayable
characters.

Invalid embedded carriage return character
with no other displayable characters in
message.

The message defined is invisible on the
terminal.

Define displayable characters for the
message.

Invalid Enable Function keys attribute for
message with Embedded Entry Variables.

Not more than one operator action can be
required per message.

Resolve the conflicting attributes. Disable the
function keys or delete the Embedded entry
variables.

Invalid Enable Function keys attribute for
message with Acknowledge attribute.

Not more than one operator action can be
required per message.

Resolve the conflicting attributes. Disable the
Ack attribute for a message with Function
Keys enabled.

Invalid Enable Function keys attribute for
message with Ack Time attribute.

Not more than one operator action can be
required per message.

Resolve the conflicting attributes. Disable the
Ack Time attribute for a message with
Function Keys enabled.

Invalid Enable Function keys attribute for
message with Hidden Message attribute
assignment.

A hidden message can not support any
operator actions.

Resolve the conflicting attributes. Disable the
Hidden Message attribute for a message with
Function Keys enabled.

Invalid hidden attribute without slave, or HE
stack.

A hidden message must be slaved and/or
Historical Event Stacked.

Resolve the conflicting attributes. Enable the
HE Stack or Slave Enable message attribute.

Invalid Hidden Message attribute with
Embedded Entries.

A hidden message can not support any
operator actions.

Resolve the conflicting attributes. Disable the
Hidden Message attribute for a message with
Embedded Entry variables.
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Invalid Line attribute for Full Text Size
attribute assignment.

A message with Full Text Size must start on
Line 1 since it occupies 4 lines.

Resolve the conflicting attributes to achieve
compatibility between Text Size and starting
Line.

Invalid Line attribute for Half Text Size
attribute assignment.

A message with Half Text Size can not start
on line 4 since it occupies 2 lines.

Resolve the conflicting attributes to achieve
compatibility between Text Size and starting
Line.

Invalid Line attribute for message with
Embedded Graphics.

A message with graphical symbols can not
start on line 4 since it occupies 2 lines.

Resolve the conflicting attributes to achieve
compatibility between Text Size and starting
Line.

Invalid message character length. A message can not exceed 100 characters.
Reduce the number of characters in the
message.

Invalid Message length; must be greater than
zero.

A message can not be entirely empty. It must
have a length.

Delete the empty message or edit the
message to make its length non-zero.

Invalid Message Number.
The Message number must be between 1 and
9900 inclusive.

Use the Message control on the Message
Editor Table View to change the number to a
legal message number between 1 and 9900
inclusive.

Invalid Scroll attribute with ALL Line attribute
assignment.

A message that uses all lines can  not be
scrolled.

Change the Line attribute to not be ALL or
disable the Scroll attribute option for the
message.

Invalid Scroll attribute with center attribute.
A message that is centered can not be
scrolled.

Disable the Scroll attribute option or disable
the Center attribute option for the message.

Invalid Scroll attribute with HE stack and
Hidden Message attributes.

Messages that are only Historical Event
Stacked can not be scrolled.

Resolve the conflicting attributes. Disable the
Scroll Message attribute for messages that
are only Historical Event Stacked.

Invalid Tag [name] references device [name]
as Node Name. This is not the Logic
Controller selected in Terminal Setup -
Comms. Setup.

The Node Name assigned to this tag does not
match the assigned PLC/Scanner Name.

Use the tag editor to change the Node Name
for this tag or change the PLC/Scanner Name
in Terminal Setup/Comms. Setup dialog.

Invalid Tag - Acknowledge Tag [name] isn’t a
valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The Acknowledge Tag in Terminal Setup/
Control Tags address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Acknowledge Tag [name] must
be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Control Tag
dialog to select an appropriate tag.

Invalid Tag - Acknowledge Tag [name] must
be of type Input or BTR.

The Acknowledge Tag in Terminal Setup/
Control Tags is controlled by the Terminal and
is read by the PLC. The tag must be in the
Input image or be in a BTR (Block Transfer
Read).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as R.

Invalid Tag - Acknowledge Tag [name]
overlaps Discrete I/O Rack Control/Status
byte.

The Acknowledge Tag in Terminal Setup/
Control Tags is assigned the same address
as the Block Transfer Control/Status Byte (the
lowest byte in the discrete I/O rack).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to disable block transfers if
they are not being used.

Invalid Tag - Acknowledge Tag [name]. The tag definition is incorrect.
Use the tag editor to correct the PLC address
for the Ack tag.

Invalid Tag - Acknowledge-Handshake Tag
[name] must be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Control Tag
dialog to select an appropriate tag.
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Invalid Tag - Acknowledge-Handshake Tag
[name] isn’t a valid address in the terminal’s
assigned Discrete Rack or Block Transfer
channels.

The Acknowledge-Handshake Tag in Terminal
Setup/Control Tags address is not in the
discrete I/O image of the rack or in the block
transfer(s) configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Acknowledge-Handshake Tag
[name] must be of type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Acknowledge-Handshake Tag
[name] overlaps Discrete I/O Rack
Control/Status byte.

The Acknowledge-Handshake Tag in Terminal
Setup/Control Tags is assigned the same
address as the Block Transfer Control/Status
Byte (the lowest byte in the discrete I/O rack).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to disable block transfers if
they are not being used.

Invalid Tag - Acknowledge-Handshake Tag
[name].

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Bit Trigger Tag [name]. Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Bit Trigger Tag [name] isn’t a
valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Bit Trigger Tag [name] must be of
type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Bit Trigger Tag [name] must be of
type Unsigned Integer.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Bit Trigger Tag [name] overlaps
Discrete I/O Rack Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to disable block transfers if
they are not being used.

Invalid Tag - Bit Trigger Tag [name] will not fit
in the Block Transfer Table (Max Bit Trigger =
[number]) or tag is not defined in the Table.

The tag will not fit within the valid range in the
discrete I/O image of the rack or in the block
transfer(s) configured for the Terminal.

Redefine the block transfer address or reduce
the total number of bit triggered messages.

Invalid Tag - Block [number] for Tag [name].
Address defined in the block transfer is
incorrect.

Use the Communication Setup Block Transfer
dialog to define the proper address.

Invalid Tag - Brightness Level Tag [name]
must be of type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Block Transfer dialog to put the tag into
a BTW.

Invalid Tag - Brightness Level Tag [name]
must be of type Unsigned Integer.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Brightness Level Tag [name] isn’t
a valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Communication Setup Block Transfer
dialog to put the tag into a Block Transfer.

Invalid Tag - Brightness Level Tag [name]
overlaps Discrete I/O Rack Control/Status
byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to disable block transfers if
they are not being used.

Invalid Tag - Day Read Tag [name] must be of
type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.
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Invalid Tag - Day Write Tag [name] must be of
type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - Function Key F[number]
Handshake Tag [name] must be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Function Keys dialog to
select or add an appropriate tag.

Invalid Tag - Function Key F[number]
Handshake Tag [name] not defined.

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Function Key F[number] Write
Tag [name] must be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Function Keys dialog to
select or add an appropriate tag.

Invalid Tag - Function Key F[number] Write
Tag [name] not defined.

Tag is undefined in the project database.
Use the tag editor to define the tag, or use the
Function Keys dialog to select or add an
appropriate tag.

Invalid Tag - HE100% Full Tag [name] must
be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - HE80% Full Tag [name] must be
of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - HE95% Full Tag [name] must be
of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - Hour Read Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.

Invalid Tag - Hour Write Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - LED #[number] Tag [name] must
be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Application/LED Indicators
dialog to select an appropriate tag.

Invalid Tag - LED #[number] Tag [name] must
be of type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Block Transfer dialog to
put the tag into a Block Transfer that has its
mode assigned as W.

Invalid Tag - LED #[number] Tag [name]
overlaps Discrete I/O Rack Control/Status
byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - LED #[number] Tag [name] Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - LED #[number] Tag [name] isn’t
a valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Message Return Number Tag
[name] must be of type Unsigned Integer.

The Message Return Number tag in Terminal
Setup/Control Tags is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.
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Invalid Tag - Minute Read Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.

Invalid Tag - Minute Write Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - Month Read Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.

Invalid Tag - Month Write Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - Msg #[number] Embedded Entry
Notify Tag [name] must be of type Input or
BTR.

The tag is controlled by the Terminal and is
read by the PLC. The tag must be in the Input
image or be in a BTR (Block Transfer Read).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as R.

Invalid Tag - Msg #[number] Bit Trigger
Number [number] greater than 1023.

The bit trigger number is required to be within
the range of 0 to 1023.

Change the bit trigger number.

Invalid Tag - Msg #[number] Embedded ASCII
Display Read Tag [name] must be of type
Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag [name] must be of type Character
Array.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Control Tag
dialog to select an appropriate tag.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag [name].

The tag definition is incorrect.
Use the tag editor to correct the PLC address
for the tag.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag used but not defined.

The tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag [name] array size must be
between 1 and 32.

The assigned tag must have an array size
between the values of 1 and 32.

Use the tag editor to change the tag array
size.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag [name] isn’t a valid address in the
terminal’s assigned Discrete Rack or Block
Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Communication Setup Block Transfer
dialog to put the tag into a Block Transfer.

Invalid Tag - Msg #[number] Embedded ASCII
Display Tag [name] overlaps Discrete I/O
Rack Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to disable block transfers if
they are not being used.

Invalid Tag - Msg #[number] Embedded ASCII
Entry Tag [name] array size must be between
2 and 33.

The assigned tag array size is outside the
valid range.

Use the tag editor to change the tag array
size.

Invalid Tag - Msg #[number] Embedded ASCII
Entry Tag array size must be greater than
ASCII Entry variable field width.

The assigned tag array size is smaller than
the display field width. Operator input cannot
be completed without a large character array
defined.

Use the tag editor to change the tag array
size.
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Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag [name] Bit address specified
but tag isn’t Bit data type.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Numeric Entry dialog to
select or add an appropriate tag.

Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag [name] must be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag defined without Embedded
Entry Notification Tag.

Tag is undefined in the project database.
Use the tag editor to change the data type of
the tag, or use the Numeric Entry dialog to
select or add an appropriate tag.

Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag [name] must be of type
Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag [name] isn’t a valid address in
the terminal’s assigned Discrete Rack or
Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Communication Setup Block Transfer
dialog to put the tag into a Block Transfer.

Invalid Tag - Msg #[number] Embedded Entry
Handshake Tag [name] overlaps Discrete I/O
Rack Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - Msg #[number] Embedded Entry
Notification Tag defined without Embedded
Entry Handshake Tag.

The tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] Embedded Entry
Notify Tag [name] isn’t a valid address in the
terminal’s assigned Discrete Rack or Block
Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Msg #[number] Embedded Entry
Notify Tag [name] must be of type Bit.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - Msg #[number] Embedded Entry
Notify Tag [name] overlaps Discrete I/O Rack
Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] Bit address specified but tag
isn’t Bit data type.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Initial Value exceeds the
allowed value for this tag type.

The assigned tag initial value is outside of the
valid range.

Use the tag editor to change the tag initial
value.

Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Max Data Entry Limit
exceeds the allowed value for this tag type.

The assigned tag maximum Data Entry Limit
is invalid.

Use the tag editor to change the Maximum
entry value.

Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Max Entry value must be
greater than Min Entry value.

The assigned tag minimum Data Entry Limit is
greater than the maximum Data Entry Limit.

Use the tag editor to change the Maximum or
Minimum entry values.

Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Maximum Data Entry
exceeds data limits (-2147483647 to
+2147483647).

The assigned tag maximum entry is greater
than the maximum value allowed.

Use the tag editor to change the Maximum
Data Entry value.
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Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Min Data Entry Limit is
smaller than the allowed value for this tag
type.

The assigned tag minimum Data Entry Limit is
invalid.

Use the tag editor to change the Minimum
entry value.

Invalid Tag – Msg #[number] Embedded Entry
Write Tag [name] Minimum Data Entry
exceeds data limits (-2147483647 to
+2147483647).

The assigned tag minimum entry is less than
the minimum value allowed.

Use the tag editor to change the Minimum
Data Entry value.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] Scale value of 0 or not in
range (�.0001 to �9999.0).

The tag scaling factors are outside the valid
range.

Use the tag editor to change the tag scale.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name].

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] used but not defined.

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] has wrong type.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] initial value must be an
integer.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] isn’t a valid address in the
terminal’s assigned Discrete Rack or Block
Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Communication Setup Block Transfer
dialog to put the tag into a Block Transfer.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] Max value not valid or not in
range.

The assigned tag maximum value is invalid.
Use the tag editor to change the Maximum
entry value.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] Min value not valid or not in
range.

The assigned tag minimum value is invalid.
Use the tag editor to change the Minimum
entry value.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] must be of type Input or
BTR.

The tag is controlled by the Terminal and is
read by the PLC. The tag must be in the Input
image or be in a BTR (Block Transfer Read).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as R.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] offset not in range.

The tag offset value is outside the range of
–32768 and +32767.

Use the tag editor to change the tag offset.

Invalid Tag - Msg #[number] Embedded Entry
Write Tag [name] overlaps Discrete I/O Rack
Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name].

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] has wrong type.

The Embedded Numeric Display Tag must be
a signed integer, unsigned integer, or bit data
type.

Use the tag editor to change the data type of
the tag, or select the embedded variable in
the message and select the appropriate tag
using the Format/Edit Variable dialog.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] isn’t a valid
address in the terminal’s assigned Discrete
Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.
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Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] Scale value of 0
is not valid.

Scale value of zero is not allowed.
Use the tag editor to change the tag Scale to
be non-zero.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] must be of type
Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] isn’t a valid
address in the terminal’s assigned Discrete
Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] overlaps
Discrete I/O Rack Control/Status byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - Msg #[number] Embedded
Numeric Entry Write Tag [name] Tag minimum
absolute value is too large for Numeric Entry
field width.

The Minimum Data Entry Limit assigned to
the tag will not fit within the Numeric Variable
Entry Field Width.

Use the tag editor to change the Minimum
Data Entry or select the embedded variable in
the message and change the Field Width
using the Format/Edit Variable dialog.

Invalid Tag - Msg #[number] Embedded
Numeric Display Tag [name] Bit address
specified but tag isn’t Bit data type.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.

Invalid Tag - Msg #[number] Tag [name]
references device [name] as Node Name.
This is not the Logic Controller selected in
Terminal Setup - Comms. Setup.

The Node Name assigned to this tag used in
this message does not match the assigned
PLC/Scanner Name.

Use the tag editor to change the Node name
for this tag or change the PLC/Scanner Name
in the Terminal Setup/Comms. Setup dialog.

Invalid Tag - Msg #[number] Tag [name]
references no device. Tag Node Name must
match the Logic Controller selected in
Terminal Setup - Comms. Setup.

There is no Node Name assigned to the tag
used in this message.

Use the tag editor to change the Node Name
for this tag.

Invalid Tag - Msg #[number] Undefined
Embedded Numeric Display Tag.

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Msg #[number] with Embedded
Entry Handshake Tag [name].

Tag is undefined in the project database.
Use the tag editor to change the data type of
the tag, or use the Numeric Entry dialog to
select or add an appropriate tag.

Invalid Tag - Msg #[number] with Embedded
Entry Notify Tag [name].

Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Return Number for Ack Tag
[name] must be of type Unsigned Integer.

The Acknowledge Return Number tag in
Terminal Setup/Control Tags is the wrong
data type.

Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - Return Number for FKey Tag
[name] must be of type Unsigned Integer.

The Function Key Return Number tag in
Terminal Setup/Control Tags is the wrong
data type.

Use the tag editor to change the data type of
the tag, or use the Terminal Setup Status
Tags dialog to select an appropriate tag.

Invalid Tag - Second Read Tag [name] must
be of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.

Invalid Tag - Second Write Tag [name] must
be of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - Tag [name] Bit address specified
but tag isn’t Bit data type.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag.
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Invalid Tag - Value Trigger Tag [name] isn’t a
valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - Value Trigger Tag [name] must
be of type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - Value Trigger Tag [name] must
be of type Unsigned Integer.

The assigned tag is the wrong data type.
Use the tag editor to change the data type of
the tag, or use the Terminal Setup/Control
Tags dialog to select an appropriate tag.

Invalid Tag - Value Trigger Tag [name]
overlaps Discrete I/O Rack Control/Status
byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - Value Trigger Tag [name]. Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Year Read Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Read Tags dialog to select an
appropriate tag.

Invalid Tag - Year Write Tag [name] must be
of type Unsigned Integer.

The assigned tag is the wrong data type.

Use the tag editor to change the data type of
the tag, or use the Application/Special
Messages/Write Tags dialog to select an
appropriate tag.

Invalid Tag - Bit Trigger Tag not defined. Tag is undefined in the project database. Use the tag editor to define the tag.

Invalid Tag - Tag [name] references no
device. Tag Node Name must match the
Logic Controller selected in Terminal Setup -
Comms. Setup.

The tag node name is not assigned.
Use the tag editor to define the tag node
name.

Invalid Tag - [tag description] Tag [name]
overlaps Discrete I/O Rack Control/Status
byte.

The tag is assigned the same address as the
Block Transfer Control/Status Byte (the lowest
byte in the discrete I/O rack).

Use the tag editor to enter a different address
for the tag or use the Terminal Setup/Comms.
Setup/Block Transfer dialog to disable block
transfers if they are not being used.

Invalid Tag - [tag description] Tag [name] isn’t
a valid address in the terminal’s assigned
Discrete Rack or Block Transfer channels.

The tag address is not in the discrete I/O
image of the rack or in the block transfer(s)
configured for the Terminal.

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer.

Invalid Tag - [tag description] Tag [name] must
be of type Input or BTR.

The tag is controlled by the Terminal and is
read by the PLC. The tag must be in the Input
image or be in a BTR (Block Transfer Read).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as R.

Invalid Tag - [tag description] Tag [name] must
be of type Output or BTW.

The tag is controlled by the PLC and is read
by the Terminal. The tag must be in the
Output image or be in a BTW (Block Transfer
Write).

Use the tag editor to change the tag address
or the Terminal Setup/Comms. Setup/Block
Transfer dialog to put the tag into a Block
Transfer that has its mode assigned as W.

Invalid Tag - [tag description] Tag [name]
references no device. Tag Node Name must
match the Logic Controller selected in
Terminal Setup - Comms. Setup.

There is no Node Name assigned to the tag.
Use the tag editor to define the Node Name
for this tag.

Invalid Text Size attribute assignment for
message with Embedded Graphics.

The Text Size of a message with embedded
graphical symbols must be Half; i.e. the size
of a graphic is fixed at 2 display lines.

Use Half Text Size to display graphical
symbols.
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Maximum allowable Embedded Entry
Variables per message exceeded.

The message has more than ten embedded
variables.

Reduce the total number of embedded
variables to 10 or less.

Message [number] Chain-to message number
cannot be 0.

The message is chained to a non-existent
message.

Use Chain control on the Message Editor
Table view to disable the chain or alter the
“To” message number to select a different
existing message.

Message number [number] chained to invalid
message number.

The message is chained to a non-existent
message.

Use Chain control on the Message Editor
Table view to disable the chain or alter the
“To” message number to select a different
existing message.

Message number [number] circular chain. The message is chained to itself.

Use Chain control on the Message Editor
Table view to disable the chain or alter the
“To” message number to select a different
existing message.

Message number [number] doesn’t have a
valid trigger source or isn’t chained to from
another message.

The message can not be triggered with the
defined application.

Define a Value Trigger tag in the Terminal
Setup/Control Tags dialog, select Bit Trigger
Enable for this message, or select Chain
Enable in another message to this message.

Message number [number] duplicated
[number] times.

The message numbers for all messages in an
application are not unique.

Renumber or delete the offending message to
insure that message numbers are unique.

Msg #[number] Slave message enabled
without Slave Device selected in Aux. Port
terminal setup.

The message has the Slave Enable attribute
set when Slave Device is not selected.

Disable the Slave Enable attribute for the
message or select Slave Device as the Aux.
Port Device in the Terminal Setup/Aux. Port
dialog.

Msg #[number] ASCII Variable Entry is not
supported by terminal type.

Embedded ASCII Entry variables are not
allowed for ASCII trigger application.

Use the Terminal Setup/Comms. Setup dialog
to convert the terminal type, or delete the
embedded ASCII entry variables in the
message.

Msg #[number] Numeric Variable Entry is not
supported by terminal type.

Applications can not support embedded
Numeric Entry in the message.

Resolve the conflict by removing the
embedded Numeric Entry Variable(s).

PLC/Scanner not assigned.
The PLC/Scanner with which the terminal
communicates is not defined.

Use the Terminal Setup Communication
Setup dialog to configure the PLC/Scanner
type and name.

RIO rack information not defined.
The Remote I/O rack information is not
defined.

Use the Terminal Setup Communication
Setup dialog to configure the Remote I/O rack
information.

Slave message address is greater than the
maximum allowed address.

The Slave Address can not be greater than
127.

Change the value of the Slave Address
between 1 and 127 inclusive.

Slave message address is less than the
minimum allowed address.

The Slave Address can not be less than 1.
Change the value of the Slave Address
between 1 and 127 inclusive.

Slave message address of 13 is not allowed.
The Slave Address of 13 assigned to the
message is not allowed.

Change the value of the Slave Address to
some other value than 13.

Startup Message [number] doesn’t exist.
The Startup Message is assigned to an
undefined message number.

Change or disable the Startup Message in the
Terminal Setup/Advanced dialog or create a
message with the assigned message number.

Tag not assigned or data type mismatch. Tag is undefined in the project database. Use the tag editor to define the tag.

Unable to create RIO Block Array.
The RIO communication port setup is
incomplete.

Use the Terminal Setup/Comms. Setup dialog
or the Communication Setup Block Transfer
dialog to define the RIO port information.

Validation Tags: Device not found in project
database.

The PLC or Terminal device name is not in
the project database.

Use the Terminal Setup/Comms. Setup dialog
or the Terminal Setup dialog to define the
device.
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Validation Tags: PLC/Scanner
communications port not defined.

The PLC/Scanner with which the terminal
communicates is not defined.

Use the Terminal Setup Communication
Setup dialog to configure the PLC/Scanner
type and name.

Value Trigger Priority mismatch with
undefined Value Triggered Messages.

There is no Value Trigger tag defined for the
application; however the Trigger Priority is set
to Value.

Use the Trigger Priority control on the
Terminal Setup/Advanced dialog to change
the priority to Bit, or use the Terminal
Setup/Control Tags dialog to define a Value
Trigger tag.

With line attribute “All” message won’t fit on
display.

The All Line message contains more
displayable characters than the display can
show.

Reformat the message with fewer characters
or change the text size.
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This appendix lists error messages that may appear during a
download or upload operation. Messages are listed alphabetically.

For messages that may appear during creation or editing of an
application, see Appendix C. 
For messages that may appear during validation, see Appendix D.
For messages that may appear during a tag import or export, see
Page 8–22.

Error Message Meaning What to do

Address overlaps Block Transfer Control Byte.
A tag is assigned the same address as the
Block Transfer Control Byte, the lowest
accessible byte in the discrete I/O rack.

Enter a different address for the tag in the Tag
Editor. Or if BTs are not used, disable block
transfers in the Block Transfer dialog.

Application (Data) file CRC is incorrect.
The computed CRC of the MVA file does not
match the CRC stored in the program.

The file is corrupted. Specify a valid MVA file.

Application file length does not match file
header record.

The MVA file has a different file length
recorded than the length of the file. 
This typically occurs when a file is being
downloaded which was truncated by an
aborted upload.

Specify a valid MVA file.

Application matches file in terminal, no
download is necessary.

The CRC of the MVA file is identical to the
CRC or the application in the terminal.

No action is necessary.

Application type does not match terminal type.
Re-configure in Terminal Setup.

The application is configured for a
communication protocol that does not match
the terminal port.

From the Setup tab in Terminal Setup, select
a terminal type that matches the application.
Or convert the application to match the
terminal type, then update the tags
appropriately.

Block Transfer Channel Number: [Num] –
Length is invalid.

The block transfer length is defined as 0 or
exceeds the maximum of 64.

In the Block Transfer dialog, correct the
invalid length of a block transfer.

Cannot continue, terminal is BUSY.
     – – – – – – – – OR – – – – – – – – 
Cannot continue, terminal is not in RUN
mode.

The terminal is in a mode that will not support
file transfers.

Wait until the terminal is in RUN mode, then
retry the file transfer.

Cannot continue, terminal is in PROGRAM
mode.

The terminal is transferring a file to or from
another computer.

Wait until the terminal completes the other
transfer, then retry the operation.

Cannot perform file transfer operation, no
INTERCHANGE communication drivers are
currently running.

INTERCHANGE drivers are not loaded on the
computer.

Exit Windows. Configure the appropriate
INTERCHANGE drivers and load them as
described in Chapter 2.

Data file CRC is incorrect.
The CRC of the historical event data file did
not match the CRC sent by the MessageView
terminal.

Retry the historical event stack upload
operation.

Data file length is incorrect.
The historical event data file did not match the
length sent by the MessageView terminal.

Retry the historical event stack upload
operation.

Error while scanning for application file CRC
MessageBuilder software could not read the
MVA file to verify the CRC.

Specify a valid MVA file.

Note: CRC is Cyclic Redundancy Check, a check for errors in files.
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Error while scanning for data file CRC.
The historical event data file could not be
read to verify its data.

Retry the historical event stack upload
operation.

INTERCHANGE command failure. Remote
station did not acknowledge command.

MessageBuilder software aborted the transfer
because it did not receive a response to a
command.

Verify that the MessageView terminal is
connected to the computer and startup self
tests are normal. Retry operation.

RNA: Error $COOA placing device #n online
INTERCHANGE could not start the driver
associated with port #n of the computer.

Check the driver configuration in CFG-KT.INI.
It may be set for a different baud rate than the
physical network.

Terminal Aborted File Transfer: File is NOT
compatible with terminal.

The type of MessageView application file that
is being downloaded is not compatible with
the selected terminal device.

Generate a new application file specifying the
correct terminal type.

Terminal Aborted File Transfer: File is too
large for terminal.

The application file that is being downloaded
will not fit in the terminal’s memory.

Reduce the size of the application.

Terminal Aborted File Transfer: Terminal has
no file available.

An upload attempt failed because the terminal
did not have an application loaded in memory.

Download an application to the terminal.

Terminal has no file available.
The requested file for upload does not exist.
This typically occurs when the HE Stack is
empty, that is, it is cleared.

Do not attempt to upload an empty HE Stack
file.

Note: CRC is Cyclic Redundancy Check, a check for errors in files.
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In this table, a dot in the MessageView 421 Terminals column means
that the attribute may be changed by the terminal operator using the
Front Panel Editor.

A dot in the MessageBuilder Software column means that the
attribute may be changed by the application designer in the Terminal
Setup dialogs.

Parameter name Description
(Default)
Range

MessageView
421 Terminals

MessageBuilder
Software

Ack Bit Hold Time
After a message is acknowledged, the
Acknowledge bit is set high for 50 msec. This
time cannot be changed

50 msec

BackGround Message
When no message is triggered, this message
displays

(none)
1 to 9900 • •

Center
Whether the message should be centered in
the display •

Debug Mode Operation
Messages are displayed in the terminal but
not active

(Disable)
Enable • •

Display Brightness How bright the display should be
(75%)

12, 25, 38, 50,60, 87,
100%

• •

Flash Whether characters should be flashing •
Flash Rate What the flash rate should be • •

Handshake Time-Out

How long the terminal should wait for a
response from the logic controller before
notifying the operator that the logic controller
is not responding. A timeout of 0 means that
no response is required

(4 sec.)
0 to 3, 5 to 60 sec. •

Inverse Whether characters should be in inverse video •

Language Which language the terminal should use
(English)

German, French, Italian,
Spanish

• •

Message Queue Enabled
Should there be a Message Queue to store
value triggered messages until they can be
displayed

(1)
64 •

Password – Entry Enter a password
(none)

any four digits • •

Password – Modify Create or change a password
(none)

any four digits •

Port Powerup
To power communication parameters for the
computer with MessageBuilder software
(OLP)

(Aux)
OLP • •
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Parameter name
MessageBuilder

Software
MessageView
421 Terminals

(Default)
Range

Description

Return Msg Num
When a message is displayed, whether its
message number should be sent to the
controller

(No)
Yes •

RIO Baud Rate Setting up Remote I/O communications port
(57.6K)

115.2K, 230.4K
View Only •

RIO Block Transfer
Whether block transfer (default) or discrete I/O
should be used

(Disabled)
Enabled

View Only •

RIO Last Chassis Is this the last chassis on the logic controller?
(No)
Yes

View Only •

RIO Module
The starting module for MessageView
addresses

(0)
1 to 3

View Only •

RIO Pass-Through
Whether the controller should pass
data/applications through to the computer on
another network

(Disabled)
Enabled

View Only n/a

RIO Rack Number Setting up Remote I/O communications port
(4octal)

0 to 3, 5 to 76octal
View Only •

RIO Rack Size Setting up Remote I/O communications port 1/4, 1/2, 3/4, Full View Only •

RS-232 Data Bits
Setting up the motherboard communications
port

(8)
7 • •

RS-232 Hardware
Handshake

Setting up the motherboard communications
port

(Enable)
Disable • •

RS-232 Parity
Setting up the motherboard communications
port

(None)
Odd, Even • •

RS-232 Stop Bits
Setting up the motherboard communications
port

(1)
2 • •

RS-232 Baud Rate
Setting up the motherboard communications
port

(19200)
300, 1200, 2400, 9600,

38,400
• •

Send Values at Power-Up
Whether to send data to PLC following loss of
communications and at powerup;
RIO has this always enabled

(Disable)
Enable • •

Simulate Mode
Allow a demonstration using a MessageView
terminal not connected to a logic controller or
any devices

(Disable)
Enable • •

Startup Msg The message to be displayed at powerup
(none)

1 to 9900 • •

Trigger Priority
Whether a bit trigger or a value trigger has
higher priority

(bit)
value •

Values at Power-Up
Send data type as Preset or as in the Last
active communications state

(Preset)
Last • •
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The time and date are also set globally.

Parameter name Description
(Default)
Range

MessageView
421 Terminals

MessageBuilder
Software

Date Day The current day of the month
(1)

2 to 31 • •

Date Format Order Setting the order of items in the date
(M/D/Y)

D/M/Y, Y/M/D •

Date Format Year Display How to display the year
(1995)

95 •

Date Format Lead Zero
Whether February 2 should be 2/2 (default) or
02/02

(Disable)
Enable •

Date Format Separators The symbol to separate day, month and year
(/)

any single character •

Date Month The current month of the year
(1)

2 to 12 • •

Date Year The current year
(1995)

1996 to 2094 • •

Time Format Format separators for time display
(:)

any single character •

Time Format Lead Zero Whether 9:03 (default) is displayed as 09:03
(Disable)
Enable •

Time Format Seconds
Included

Whether seconds should be displayed
(default)

(Enable)
Disable •

Time Hour The current hour
(0)

1 to 12/0 to 24 • •

Time Hour Format 12-hour or 24-hour format
(12)
24 •

Time Hour Notation –
Selection

The suffix to be displayed after the time, e.g.
PM CST; this is only selection, not entry of 10
characters

(AM)
PM, 

any 10 characters
•

Time Minutes The current minutes after the hour
(0)

1 to 59 • •

Time Seconds The current seconds after the minute
(0)

1 to 59 • •
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Read tags are controlled by the PLC. For Remote I/O, read tags are
Output or BTW.

Tag Type Purpose Range

Acknowledge Handshake Bit
A bit that when set informs the terminal that the Acknowledge bit
and Acknowledge Return Number have been acquired by the
controller. Use of the Acknowledge Handshake is optional.+

0, 1

ASCII Display Character Array

A string of ASCII characters that is scanned whenever a message
with an embedded ASCII Variable Display is triggered. An ASCII
Display tag is required for every embedded ASCII Variable Display
in the application.

An array of
characters.

ASCII Entry Handshake Bit
A bit that when set informs the terminal that the ASCII Variable
Entry and Message Return Number have been acquired by the
controller. Use of the Numeric Entry Handshake is optional.

0, 1

Bit trigger Unsigned Integer

The first word of a bit sequence for triggering messages by their
bit number. The bit sequence is up to 64 words long. The terminal
continuously scans the bit sequence whenever one or more
bit-triggered messages exist in the application.

Bit position
0-1023

(Latched) Function Key Handshake Bit
A bit that when set returns a Latched Function Key to the
de-energized state. Every Latched Function Key in the application
requires a corresponding Handshake tag.

0, 1

LED Indicator Bit

A bit that controls an LED indicator on the 2706-M1F1 terminal.
One bit is optionally assigned to each LED indicator in the
application. The terminal continuously scans the LED indicator
tags whenever they are assigned.

0, 1

Numeric Display
Signed Integer,

Unsigned
Integer, or BCD

A numeric value that is scanned, formatted and displayed
whenever a message with an embedded Numeric Variable Display
is triggered. A Numeric Display tag is required for every embedded
Numeric Variable Display in the application.

Depends on
the type.

Numeric Entry Handshake Bit
A bit that when set informs the terminal that the Numeric Variable
Entry and Message Return Number have been acquired by the
controller. Use of the Numeric Entry Handshake is optional.

0, 1

Special Message 9905: Year Unsigned Integer
A value for setting the year of the Real-Time Clock in the terminal.
The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-2035

Special Message 9905: Month Unsigned Integer
A value for setting the month of the Real-Time Clock in the
terminal. The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-12

Special Message 9905: Day Unsigned Integer
A value for setting the day of the Real-Time Clock in the terminal.
The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-31

Special Message 9905: Hour Unsigned Integer
A value for setting the hour of the Real-Time Clock in the terminal.
The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-23

Special Message 9905: Minute Unsigned Integer
A value for setting the minute of the Real-Time Clock in the
terminal. The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-59



Tags and Data TypesG–2

Publication 2706-817

Tag RangePurposeType

Special Message 9905: Second Unsigned Integer
A value for setting the second of the Real-Time Clock in the
terminal. The value is acquired when Special Message 9905 (Set
Time/Date) is triggered.

0-59

Special Message 9908: Set
Brightness

Unsigned Integer

A value for setting the level of brightness of the terminal display.
Bit Brightness Bit Brightness
0 12% 4 60%
1 25% 5 75%
2 38% 6 87%
3 50% 7 100%

0–7

Value trigger Unsigned Integer
A value for triggering messages by their message number. The
terminal continuously scans for a new (changed) trigger value.

1-9900

Write  tags are controlled by the terminal. For Remote I/O, write tags
are Input or BTR.

Tag Type Purpose Range

Message Return number Unsigned Integer
A value that indicates the message number of the last-triggered
message on display when the message does not require
Acknowledge nor have Function Keys enabled.

1-9900

Acknowledge Bit
A bit that when set informs the logic controller that the Ack key is
pressed for a message that requires Acknowledgement by the
operator.

0, 1

Acknowledge Return Number Unsigned Integer
A value that indicates the message number of the last–triggered
message on display when the message requires
Acknowledgement by the operator.

1-9900

Function Key Bit
A bit that when set indicates that a Function Key has been
pressed. The behavior of this bit is determined by the type of
Function Key and how it is configured.

0, 1

Function Key Return Number Unsigned Integer
A value that indicates the message Number of the last-triggered
message on display when the message has one or more Function
Keys enabled.

1-9900

Numeric Entry
Signed Integer,

Unsigned
Integer, or BCD

A numeric value that indicates the operator entered value
whenever a message with an embedded Numeric Variable Entry is
on display. A Numeric Entry tag is required for every embedded
Numeric Variable Entry in the application.

Depends on
the type.

Numeric Entry Notification Bit
A bit that when set informs the controller that the Numeric Variable
Entry is changed and ready to be acquired by the controller.

0, 1

ASCII Entry Character Array
Alphanumeric characters entered by an ASCII Input device. An
ASCII Entry tag is required for every embedded ASCII Variable
Entry in the application.

Depends on
the ASCII

Input device

ASCII Entry Notification Bit
A bit that when set informs the controller that the ASCII Variable
Entry is changed and ready to be acquired by the controller.

0, 1

HE Stack Status 85% Bit A bit that when set indicates that the HE Stack is 85% full. 0, 1

HE Stack Status 95% Bit A bit that when set indicates that the HE Stack is 95% full. 0, 1

HE Stack Status 100% Bit A bit that when set indicates that the HE Stack is 100% full. 0, 1

Special Message 9906: Year Unsigned Integer
A value that indicates the year of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-65535
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Tag RangePurposeType

Special Message 9906: Month Unsigned Integer
A value that indicates the month of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-12

Special Message 9906: Day Unsigned Integer
A value that indicates the day of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-31

Special Message 9906: Hour Unsigned Integer
A value that indicates the hour of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-23

Special Message 9906: Minute Unsigned Integer
A value that indicates the minute of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-59

Special Message 9906: Second Unsigned Integer
A value that indicates the second of the Real-Time Clock in the
terminal. The value is available when Special Message 9906 (Get
Time/Date) is triggered.

0-59

Special Message 9907: Battery Test Bit
A bit that when set indicates that the battery is functional.
0 = Fails, 1 = Pass

0, 1
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This appendix contains a worksheet to help in planning an
application. Variables cannot be assigned to memory addresses that
overlap, and the only way to make sure they do not overlap is to
write them all down.

Make copies as needed and use them to enter addresses for each tag
in the application. Depending on what your application requires, you
may need one or more worksheets for each of the following:

• ������

• Discrete I/O

• ���	
 �������� ���


• Block Transfer Write

Or you may prefer to have a separate worksheet for each block
transfer (maximum of 10).

Note: If the application requires block transfer, be sure to mark off
the Status and Control bytes on the Discrete I/O worksheet(s). See
Page5–17.

In the  Worksheet:

Each row represents one word of memory.

A signed or unsigned integer or a BCD type variable must be
assigned to one word.

Bits may be assigned to any available bit address.
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Word
Address→
Tag Name ↓

Decimal
Octal

15
17

14
16

13
15

12
14

11
13

10
12

9
11

8
10

7
7

6
6

5
5

4
4

3
3

2
2

1
1

0
0

Word
Address→
Tag Name ↓

Decimal
Octal

15
17

14
16

13
15

12
14

11
13

10
12

9
11

8
10

7
7

6
6

5
5

4
4

3
3

2
2

1
1

0
0

Word
Address→
Tag Name ↓

Decimal
Octal

15
17

14
16

13
15

12
14

11
13

10
12

9
11

8
10

7
7

6
6

5
5

4
4

3
3

2
2

1
1

0
0

Word
Address→
Tag Name ↓

Decimal
Octal

15
17

14
16

13
15

12
14

11
13

10
12

9
11

8
10

7
7

6
6

5
5

4
4

3
3

2
2

1
1

0
0
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This appendix includes all the ASCII and Extended ASCII characters
you can enter in a message.

• The first 31 characters are used as ASCII Control Code
characters. They are used to embed control codes in messages
sent to slaves.

• Characters numbered 032 to 0127 are usually typed in from the
computer keyboard.

• Characters numbered 0128 to 0255 are Extended ASCII
characters. The 850 version of the Extended ASCII character list
is designed for use with European languages.

To enter an ASCII character in a message:

1. Place the insertion bar in the Edit Box where the ASCII character
is to go.

2. Hold down the ALT  key while entering the number in the keypad.

The corresponding character appears at the insertion point.

To enter an ASCII Control Character in a message to be sent to
a slave device:

1. Place the insertion bar in the Edit Box where the ASCII Control
Code should be embedded.

2. Click the Embedded Variable icon, or open the Format menu.

3. Select ASCII Control Char to open the ASCII Control Character
dialog.

4. Use the scroll bar to locate the number you want.

5. Highlight it and select OK.

A placeholder ~ for the character appears in the Edit Box at the
insertion point. A Control Code character determines how the
message is displayed by the slave device(s).
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ASCII Character Set With Control Codes 

Dec. Oct. Hex. Char
Control
Code

Dec. Oct. Hex. Char Dec. Oct. Hex. Char Dec. Oct. Hex. Char

0 0 0 NUL Ctrl-@ 032 40 20 064 100 40 096 140 60 �

1 1 1 SOH Ctrl-A 033 41 21 ! 065 101 41 A 097 141 61 a

2 2 2 STX Ctrl-B 034 42 22 “ 066 102 42 B 098 142 62 b

3 3 3 ETX Ctrl-C 035 43 23 # 067 103 43 C 099 143 63 c

4 4 4 EOT Ctrl-D 036 44 24 $ 068 104 44 D 0100 144 64 d

5 5 5 ENQ Ctrl-E 037 45 25 % 069 105 45 E 0101 145 65 e

6 6 6 ACK Ctrl-F 038 46 26 & 070 106 46 F 0102 146 66 f

7 7 7 BEL Ctrl-G 039 47 27 � 071 107 47 G 0103 147 67 g

8 10 8 BS Ctrl-H 040 50 28 ( 072 110 48 H 0104 150 68 h

9 11 9 HT Ctrl-I 041 51 29 ) 073 111 49 I 0105 151 69 i

10 12 A LF Ctrl-J 042 52 2A * 074 112 4A J 0106 152 6A j

11 13 B VT Ctrl-K 043 53 2B + 075 113 4B K 0107 153 6B k

12 14 C FF Ctrl-L 044 54 2C , 076 114 4C L 0108 154 6C l

13 15 D CR Ctrl-M 045 55 2D – 077 115 4D M 0109 155 6D m

14 16 E SO Ctrl-N 046 56 2E . 078 116 4E N 0110 156 6E n

15 17 F SI Ctrl-O 047 57 2F / 079 117 4F O 0111 157 6F o

16 20 10 DLE Ctrl-P 048 60 30 0 080 120 50 P 0112 160 70 p

17 21 11 DC1 Ctrl-Q 049 61 31 1 081 121 51 Q 0113 161 71 q

18 22 12 DC2 Ctrl-R 050 62 32 2 082 122 52 R 0114 162 72 r

19 23 13 DC3 Ctrl-S 051 63 33 3 083 123 53 S 0115 163 73 s

20 24 14 DC4 Ctrl-T 052 64 34 4 084 124 54 T 0116 164 74 t

21 25 15 NAK Ctrl-U 053 65 35 5 085 125 55 U 0117 165 75 u

22 26 16 SYN Ctrl-V 054 66 36 6 086 126 56 V 0118 166 76 v

23 27 17 ETB Ctrl-W 055 67 37 7 087 127 57 W 0119 167 77 w

24 30 18 CAN Ctrl-X 056 70 38 8 088 130 58 X 0120 170 78 x

25 31 19 EM Ctrl-Y 057 71 39 9 089 131 59 Y 0121 171 79 y

26 32 1A SUB Ctrl-Z 058 72 3A : 090 132 5A Z 0122 172 7A z

27 33 1B ESC Ctrl-[ 059 73 3B ; 091 133 5B [ 0123 173 7B {

28 34 1C FS Ctrl-\ 060 74 3C < 092 134 5C \ 0124 174 7C

29 35 1D GS Ctrl–] 061 75 3D = 093 135 5D ] 0125 175 7D }

30 36 1E RS Ctrl-^ 062 76 3E > 094 136 5E ^ 0126 176 7E ~

31 37 1F US Ctrl-_ 063 77 3F ? 095 137 5F _ 0127 177 7F
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Extended ASCII Character Set (850, Multilingual Latin I)

Dec. Oct. Hex. Char Dec. Oct. Hex. Char Dec. Oct. Hex. Char Dec. Oct. Hex. Char

0128 200 80 Ç 0160 240 A0 á 0192 300 C0 0224 340 E0 Ó

0129 201 81 ü 0161 241 A1 í 0193 301 C1 0225 341 E1 ß

0130 202 82 é 0162 242 A2 ó 0194 302 C2 0226 342 E2 Ô

0131 203 83 â 0163 243 A3 ú 0195 303 C3 0227 343 E3 Ò

0132 204 84 ä 0164 244 A4 ñ 0196 304 C4 0228 344 E4 õ

0133 205 85 à 0165 245 A5 Ñ 0197 305 C5 0229 345 E5 Õ

0134 206 86 å 0166 246 A6 � 0198 306 C6 ã 0230 346 E6 µ
0135 207 87 ç 0167 247 A7 � 0199 307 C7 Ã 0231 347 E7 �

0136 210 88 ê 0168 250 A8 ¿ 0200 310 C8 0232 350 E8 


0137 211 89 ë 0169 251 A9  0201 311 C9 0233 351 E9 Ú

0138 212 8A è 0170 252 AA 0202 312 CA 0234 352 EA Û

0139 213 8B ï 0171 253 AB � 0203 313 CB 0235 353 EB Ù

0140 214 8C î 0172 254 AC � 0204 314 CC 0236 354 EC 	

0141 215 8D ì 0173 255 AD ¡ 0205 315 CD 0237 355 ED �

0142 216 8E Ä 0174 256 AE � 0206 316 CE 0238 356 EE

0143 217 8F Å 0175 257 AF � 0207 317 CF 0239 357 EF �

0144 220 90 É 0176 260 B0 0208 320 D0 δ 0240 360 F0

0145 221 91 æ 0177 261 B1 0209 321 D1 D 0241 361 F1 �

0146 222 92 Æ 0178 262 B2 0210 322 D2 Ê 0242 362 F2 =

0147 223 93 ô 0179 263 B3 0211 323 D3 Ë 0243 363 F3 �

0148 224 94 ö 0180 264 B4 0212 324 D4 È 0244 364 F4 �

0149 225 95 ò 0181 265 B5 Á 0213 325 D5 0245 365 F5 �

0150 226 96 û 0182 266 B6 Â 0214 326 D6 Í 0246 366 F6 �

0151 227 97 ù 0183 267 B7 À 0215 327 D7 Î 0247 367 F7

0152 230 98 ÿ 0184 270 B8  0216 330 D8 Ï 0248 370 F8 �

0153 231 99 Ö 0185 271 B9 0217 331 D9 0249 371 F9

0154 232 9A Ü 0186 272 BA 0218 332 DA 0250 372 FA

0155 233 9B ø 0187 273 BB 0219 333 DB 0251 373 FB �

0156 234 9C £ 0188 274 BC 0220 334 DC 0252 374 FC �

0157 235 9D Ø 0189 275 BD ¢ 0221 335 DD 0253 375 FD �

0158 236 9E � 0190 276 BE ¥ 0222 336 DE Ì 0254 376 FE

0159 237 9F ƒ 0191 277 BF 0223 337 DF 0255 377 FF
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Note: A word or words in bold face in an entry has its own entry in
this Glossary.

 A – 

 Active Window – The window that is currently selected. Only one
window can be active at a time, though a number of Table Views of
one or several Applications may be open. The title bar of the active
window is highlighted to differentiate it from other open windows,
and its name is checked in the Window menu. All Tools, Menus,
Attributes  and the Edit Box apply only to the active window. Any
open Dialogs must be closed before another window can be
activated.

 Address – A label identifying a memory location in the Controller.
The link between the address and the Variable or other item that
uses that address is specified by a Tag. See also Node Address.

 AI Software – The WINtelligent series version of CSV format
software.

 Application – A logical arrangement of Messages, Tags, and
configuration Parameters for a specific type of MessageView
terminal in a system with a specific type of Controller . The
application runs in a MessageView terminal to control a specific
process.

 Application File – The form in which an application is stored in the
computer or used by a MessageView terminal. Files created and
saved by MessageBuilder are in an MBA format (*.MBA file type).
They are changed to MVA format (*.MVA file type) before being
downloaded to a MessageView terminal.

 APS Software – Acronym for Advanced Programming Software.
The APS Import/Export Utility uses this software, which works with
the SLC logic controller only.

 ASCII – A code defining all the alphanumeric characters, including
punctuation, so they may be used by a computer. A number of
Enhanced ASCII codes are available, which have accented
characters, mathematical and graphical symbols, and so forth.
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 ASCII Input Device – A bar code scanner or other device that
sends alphanumeric data to a MessageView terminal. A terminal
with two ports and firmware that supports ASCII Input may have its
RS-232 port connected to an ASCII Input device. Data input by such
a device is stored as alphanumeric characters in an ASCII entry or
display  variable.

 ASCII Triggering Device – A device that can trigger messages in a
MessageView terminal via a serial communications link. It reads and
writes data through the terminal’s RS-232 port.

 Attribute – In MessageBuilder software, information that
determines how a Message will appear on the MessageView
terminal (e.g., text size), how it interacts with other messages (e.g.
chained), and how it is used by the terminal (e.g. logged in the HE
Stack).

 Auxiliary Device – A device connected to the RS-232 port of a
MessageView terminal that is being controlled through its Remote
I/O  port by a Logic Controller. An auxiliary device may be an
ASCII Input device such as an AdaptaScan reader, or a Slave
Device such as a Dataliner DL50.

 B – 

 Background Message – A message that is displayed by a
MessageView terminal when no other message has been active for 2
seconds.

Baud  – The rate at which data transmission occurs. One baud equals
one Bit  per second.

Bit  – The smallest unit of information in the binary numbering
system. A bit contains either 0 or 1.

 Bitmap – A Graphic image stored as a pattern of dots (or pixels).

 Bit Trigger – A Bit  location that may be assigned to a Message.
When the Logic Controller  sets its bit to 1, the corresponding
message is triggered. An ASCII Triggering application does not
support bit triggers. See also Value Trigger.

Block Transfer  – One of the two methods of data transfer used by a
Remote I/O port on a MessageView terminal. See also Direct I/O .

 Byte – A sequence of 8 consecutive Bits that are treated as a single
value.
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 C – 

 Cascade – A way of arranging open windows in the workspace so
that they overlap each other, with the title bar of each visible. See
also Tile.

Choose – Highlight an item by using the mouse or a key
combination. A command (such as the OK button in a dialog) can
then select or invoke that item. Tools, menu items and certain
commands may be selected and chosen in a single mouse click. See
also Select.

 Click – Press and release the left mouse button quickly.

 Command – An item in a Menu that that carries out an action when
it is selected.

 Command Button – A labelled rectangle in a dialog that carries out
an action when selected. Its label that describes the action to carry
out (Close, Cancel). Choosing a command button followed by
ellipsis (Options...) opens another dialog.

 Control Tag – A tag that specifies the Controller’s memory address
for a specific Global attribute.

 Controller – A device that controls a MessageView terminal by
Triggering  messages and providing data for display variables. See
Logic Controller, ASCII Triggering Device.

 Copy – To put a duplicate of the selected item onto the clipboard so
that you can transfer it to another location.

 CSV Format – This format is used by Excel and some other
software packages. The HE Stack is uploaded in CSV format.

 Cursor Point – The flashing vertical line in the Edit Box where
text, graphics or variables are added to the message.

 Cut – To move the selected item onto the clipboard, from which it
can be placed somewhere else. See also Delete.

 D – 

 Daughterboard – A communications card installed in a
MessageView terminal. It provides a Remote I/O port for the
terminal.

 Delete – To remove the selected item permanently. See also Cut.
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 Device – Any of a number of mechanical units, such as Logic
Controllers, ASCII Input  devices and computers that may be
connected to a MessageView terminal. A MessageView terminal is
itself a device.

 DF1 – An Allen-Bradley communications protocol used to transfer
an application or other data between a computer and a MessageView
terminal’s RS-232 port.

 Dialog – A window that opens to request information. Dialogs have
options you must choose before MessageBuilder software can carry
out a command.

 Direct I/O – One of the two methods of data transfer used by a
Remote I/O port on a MessageView terminal. See also Block
Transfer.

 Double-Click – Press and release the left mouse button twice
quickly, without moving the mouse.

 Drag – Highlight text by pressing and holding down the left mouse
button while moving the mouse.

 Download – The process of transferring data from a computer to a
MessageView terminal, or storing an application as a DOS file.
Specific download commands load an Application  in the terminal,
change the date or time in the RTC, or update Firmware .

 Driver – A personal computer’s ports are configured by a set of
communication parameters collectively called a driver, installed by
INTERCHANGE software. A MessageView terminal’s Ports are
configured as part of its application.

 E – 

 Edit Box – The place where the active Message highlighted in the
Message List is edited. Only one message is edited at a time. The
message in the Edit Box may have its text entered and edited, its
Attributes  assigned, Variables and Graphics embedded, and (in
Applications designed for MessageView 421F terminals) Function
Keys enabled.

 Exceptions Dialog – A list of all the warning and error messages
generated during a Validate operation.

 Export – The process of changing Tags automatically from
MessageBuilder format to a different format.
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 F – 

 File Transfer Utility – Software that supports transfer of an MVA
file between a computer that does not have MessageBuilder
running, and a MessageView terminal. It can also download the
RTC clock and upload the HE Stack file. In Microsoft Windows it
appears as an icon in the MessageBuilder group.

 Firmware – Software that allows the MessageView terminal to run
an Application . Several versions of firmware are available,
depending on how the terminal is to be used. Firmware can be
upgraded using software disks from Allen-Bradley and the
MessageBuilder Download command.

 Flashing – A Message or part of a message that is emphasized by
being turned on and off regularly on the MessageView terminal
display.

 Function Keys – A set of keys labeled F1 to F16 (only on the
MessageView 421F terminal) that may be enabled for a Message.
When a displayed message has a function key or keys enabled, the
terminal operator can use the key(s) to initiate a procedure. Function
keys are disabled unless they are specifically enabled for a message
being displayed.

 G – 

 Global – An Attribute  or Parameter that is defined once, and may
then be used as often as needed in the application.

 Graphic – One of 32 standard ISA Bitmaps representing motors,
valves and other objects used in manufacture.

 Greyed – A command that is unavailable or disabled at the moment
is represented by a greyed icon, menu item or button. For instance,
most of the commands on the Format menu can be used only when
the cursor point is in the Edit Box. When it is elsewhere in
MessageBuilder, these commands are greyed out.

 H – 

 Handshake – Acknowledgement that data has been received by
another device, such as a Logic Controller.

 HE Stack – Acronym for the Historical Event Stack. A file in the
MessageView terminal in which messages are logged as they are
Triggered, with a time/date stamp. It may be viewed by the terminal
operator, or uploaded into a computer for analysis.
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 I – 

 Import – The process of changing Tags automatically from a
different format into MessageBuilder format.

 Inverse Video – A Message or part of a message that is emphasized
by having its colors reversed in the MessageView terminal display.

 ISA – Acronym for Instrumentation Society of America.
MessageBuilder software includes a set of standard ISA Bitmap
Graphic symbols that can be embedded in a message.

 J – 

 Jog Feature – One aspect of the Auto Clear attribute. When Auto
Clear is disabled for a Message that has embedded Function Keys,
jog feature is enabled. If the jog feature is disabled, the message is
terminated after one of its function keys is pressed. If the jog feature
is enabled, the message remains active until the terminal display is
cleared or the terminal is reset.

 K – 

 Keypad – A set of keys on the MessageView terminal that the
terminal operator uses to input data, acknowledge messages and
access the Front Panel Editor. See also Numeric Keypad and
Function Keys.

 L – 

 LED – Acronym for Light Emitting Diode. A MessageView 421F
terminal has a red LED beside each of the 16 Function Keys. These
LEDs may or may not reflect the condition of the function key,
depending on how they are set up in the Application .

 Logic Controller – A device used to replace relay logic used for
sequencing, timing, and counting. Instead of physical wiring devices
such as relays, push buttons and limit switches, a logic controller
tests the state of inputs and sets outputs according to stored
programs. Also called programmable controller. See also SLC; PLC.

 M – 

 Master Device – A device which controls one or more Slave
Devices. It sends Messages to be displayed by its slaves, and
controls the appearance of the message in the slave display. A
MessageView terminal with a Daughterboard and Firmware  that
supports Slave Port can address up to 127 slave devices through its
RS-232 port.

 MBA Format – See Application File.
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 Menu – A list of related commands in MessageBuilder software.
Menu names appear in a menu bar under the title bar at the top of the
Message Editor Table View.

 Message – The basic unit of a MessageBuilder Application . It
contains any or all of the following: text, embedded Variables,
Graphics and, enabled Function Keys. Each message has
Attributes  and a Value Trigger, and it may also have a Bit Trigger .
It is edited in the Edit Box.

 MessageBuilder Software – A Microsoft Windows based program
used to develop an Application  that can run in a MessageView
terminal.

 Message Editor – The main window for Application  design. See
also Table View; Terminal View.

 Message List – Messages are entered in the Message List at the
bottom of the Message Editor Table View as they are created. They
may be returned to the Edit Box for editing. Messages in the
Message List may be rearranged in a number of ways as needed.

 MessageView Terminal – An Allen-Bradley Device which runs a
MessageBuilder Application  and controls a process. The terminal
provides an operator display interface to a Controller  and often to
other devices when the application is executing. Terminals differ in
their Keypad options and their Firmware . Thus an Application must
be designed for the capabilities of one type of terminal.

 MFT – Acronym for the MessageBuilder File Transfer Utility .

 MVA Format – See Application File.

 N – 

 Node – A point on a network to which a device can be connected.
The MessageView terminal may be at a node on a Remote I/O
network or an ASCII Triggering Device network.

 Node Address – A unique integer assigned to each node on a
network. Data transfer between devices on a network requires a
destination address.

 Numeric Keypad – On MessageView 421N and 421F terminals,
keys the operator can use to input data in Numeric Entry variables.
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 P – 

 Parameter – A characteristic of a device or system that is defined
as part of its set-up. For instance, a MessageView terminal’s Remote
I/O  port must be set up as part of the Application  so it can
communicate with the specific type of Logic Controller  the system
will use.

 Paste – To copy the contents of the clipboard to a specified location.
To paste attributes or variables of a message, see the procedure in the
manual.

  Placeholder– Each type of variable has its own placeholder, which
represents it in the Edit Box and Terminal View.

 PLC – Acronym for Programmable Logic Controller , an
Allen-Bradley trademarked device.

 Pointer – The arrow-shaped cursor on the computer screen that
follows the movement of the mouse and indicates which area of the
screen will be affected when you press the mouse button. The pointer
changes shape during certain tasks. Also called mouse pointer.

 Port – The part of a device through which it communicates with
other devices. Before two devices can communicate, they must have
a hardware connector (cable) joining their ports and both ports must
have the correct software communication Parameters set. A
MessageView terminal has an RS-232 port and may also have a
Remote I/O port.

 Preset Value – A value that is loaded into a PLC or SLC controller
data table when an Application  starts up in a MessageView
terminal.

 Project – A database of Tag definitions and device information
associated with an Application . A project may be assigned to more
than one application.

 Q – 

 Queue – A memory location in the MessageView terminal where a
Value-triggered message may be stored if it cannot be displayed
immediately when it is triggered.
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 R – 

 Real Time Clock – The MessageView terminal has its own
battery-operated clock, also referred to as RTC. It provides values for
time or date variables in displayed messages. The terminal’s clock
may be set using the RTC Download command from
MessageBuilder software, or the terminal operator may set it.

 RS-232 – A serial link for transmitting data to and from the RS-232
port of a MessageView terminal. Communication with a personal
computer requires a DF1 connection, whose parameters are set up in
the terminal’s Firmware . Communication with any other device
requires that the RS-232 port Parameters are set up in the
Application . Communication with a Slave Device requires a
RS-232/Simplex connection.

 Remote I/O – A serial link for transmitting data to and from a PLC
or SLC processor/scanner and the Remote I/O port of a
MessageView terminal. Also supports Block Transfer of data that is
moved using block transfer ladder instructions.

 S – 

 Save – The process of transferring data stored in RAM memory to a
disk file.

 Scaling – Mathematically manipulating data so it may be stored in
one form in a Controller  and displayed in another form in the
MessageView terminal.

 Select – Select an action to activate a chosen (highlighted) item. In
some cases a mouse click can Choose and select an item in one step.

 Slave Device – A device that receives and displays messages from a
Master Device, but does not initiate communication. Slave Devices
include the MessageView 421D Slave Device terminal (Catalog
2706-M1D) and several of the Allen-Bradley Dataliner family.

 Slaving – A system in which a Master Device controls one or more
Slave Devices remotely. A MessageView terminal with a
daughterboard and firmware that supports Slave Port can act as a
master device for up to 127 Slave Devices.

 SLC – Allen-Bradley trademarked name for Small Logic
Controller .

 Special Messages – Messages that affect the MessageView
terminal. They are not displayed or sent to the HE Stack, but may be
triggered as part of the application.
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 Startup Message – The message displayed when the MessageView
terminal powers up.

 Status Bar – The horizontal bar at the bottom of the Message
Editor  window that tells you what MessageBuilder software is
doing at the moment.

 T – 

 Table View – A window in which Messages or Tags are created and
their attributes assigned.

 Tag – The collective name for a group of Parameters that define a
controller address and how it interacts with a MessageBuilder
variable.

 Tag Editor – A section of MessageBuilder software in which Tags
may be created, edited, and imported.

 Terminal View – A window that looks like the face of the
MessageView terminal for which the current Application  is
designed. It shows what the Message being edited will look like in
the terminal display.

 Tile – A way of arranging open windows in the workspace so that
they do not overlap. Each window occupies a horizontal segment of
the workspace. See also Cascade.

 Tool – An icon that can be used to Select frequently used
commands. Some tools complete the action immediately; others open
a Dialog for further input.

 Trigger – A unique value or bit assigned to a message, used by the
Controller  to call up the message. See also Bit Trigger ; Value
Trigger.

 U – 

 Upload – The process of transferring an Application  or a HE Stack
file from a MessageView terminal to a computer running
MessageBuilder software or the File Transfer Utility . An uploaded
application exists in both MBA  and MVA  formats. An uploaded HE
Stack file exists in CSV format.
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 V – 

 Validate – The process of checking an Application  for mistakes
that will cause problems when it is run. MessageBuilder software
notifies the application designer of any validation errors, since they
must be corrected before the application can be downloaded to a
MessageView terminal. Applications are automatically validated as
part of the Download process, and they may also be validated while
they are being created.

 Value Trigger – A message’s number. The Controller  may specify
a message number to call up the corresponding message.

 Variable – A number or an array of characters whose value in a
message displayed by the MessageView terminal is sent from data in
the Controller , or from the value input by the operator or by an
ASCII Input Device. In MessageBuilder software a variable is
represented by a Placeholder.

 Verify – The process by which a MessageView terminal checks an
Application  that has been Downloaded to make sure it is designed
for the correct type of terminal.

 W – 

 Workspace – The area of the computer display in which the
MessageBuilder Application  is created and edited.

 Z – 

 Zoom – A procedure for enlarging the Terminal View so that it is
larger than the default size.
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